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FOREWORD 

The National Education Policy (NEP) 2020 envisions an education system that 

is deeply rooted in India's cultural heritage and achievements, while also 

preparing students to effectively engage with the challenges and opportunities 

of the 21st century. This aspirational vision is built upon the National 

Curriculum Framework for School Education (NCF-SE) 2023, which outlines 

a comprehensive approach to education across various stages. In the early 

stages, the NCF-SE 2023 fosters the holistic development of students by 

focusing on the five dimensions of human existence, known as the 

pañchakoshas, creating a solid foundation for further learning. 

High-quality vocational textbooks play a vital role in bridging practical skills 

and theoretical knowledge. 

These textbooks must balance direct instruction with opportunities for 

hands-on experience, helping students to apply what they learn in real-life 

settings. The National Council of Educational Research and Training (NCERT) 

is providing such high-quality teaching-learning resources. A team of experts, 

educators, and practitioners have collaborated to develop these vocational 

textbooks to ensure students are well-prepared for the demands of their 

chosen fields. 

The textbook on MIS Data Analyst – Financial Services introduces students to 

essential concepts in the banking, financial services, and insurance sector, 

with a strong focus on data management, analysis, and reporting. It aims to 

equip students with practical skills, such as using Excel for financial data 

management, organising and validating datasets, creating MIS reports, and 

developing interactive dashboards, so that they are well prepared for the job 

role of MIS Data Analyst in the BFSI sector. The textbook also emphasises 

values such as accuracy, data privacy, ethical practices, and attention to 

detail, which are crucial in financial data handling and decision-making. 

In addition to textbooks, it is important to encourage students to explore other 

learning resources, such as financial journals, industry reports, and live data 

analysis projects. Teachers play a vital role in guiding students as they apply 

their learning to real or simulated financial datasets. 

I am grateful to all who contributed to the development of this vocational 

textbook and look forward to feedback from its users to make future 

improvements. 
 

New Delhi       Dr. Dinesh Prasad Saklani 

July, 2025                   Director National Council      
of Educational Research and Training 
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ABOUT THE TEXTBOOK 
 

The MIS Data Analyst – Financial Services course is designed to equip 

students with the essential knowledge and hands-on skills required to collect, 

analyze, and report financial and operational data using digital tools; 

primarily Microsoft Excel. In Grade 11, students are introduced to data 

fundamentals, Management Information Systems (MIS), and Excel-based 

data analysis techniques, progressing to structured reporting and basic 

automation. In Grade 12, the focus shifts to advanced financial reporting, 

budgeting, business analysis and the application of data-driven decision-

making, including forecasting, process improvement and KPI monitoring.  

The course ensures that students understand how data supports strategic 

decision-making across financial services by integrating theoretical concepts 

with practical application. Through case studies, hands-on projects, and 

report simulations, learners gain real-world insights into operational metrics, 

profitability analysis, dashboard creation, and automated MIS reporting. 

The textbook for the job role of ‘MIS Data Analyst – Financial Services’ has 

been developed to impart knowledge and skills through the hands-on learning 

experience, which forms a part of experiential learning. Experiential learning 

focuses on the learning process for an individual. Adequate care has been 

taken to align the textbook’s content with the National Occupational 

Standards (NOSs) for the job role so that the students acquire the necessary 

knowledge and skills as per the performance criteria mentioned in the 

respective NOSs of the Qualification Pack (QP). The textbook has been 

reviewed by experts to ensure that the content is not only aligned with the 

NOSs but is also of high quality.   

This textbook covers five comprehensive Module 1: Banking Sector and Role 

of MIS Data Analyst, Module 2: Excel for Financial Data Management, Module 

3: Data Organization and MIS Report, Module 4: Advanced Excel for Analysis 

and Dashboards, and Module 5: Automation and Presentation of Reports. It 

is designed to equip learners with the foundational and advanced skills 

required for data analysis and reporting in the Banking, Financial Services, 

and Insurance (BFSI) sector. Beginning with an overview of the BFSI industry, 

the textbook introduces the role of MIS (Management Information System) 

and the responsibilities of a data analyst, along with essential knowledge of 

data privacy and regulatory frameworks. Students are trained in using Excel 

for managing financial data, covering everything from basic formulas and 

charts to look up and logical functions.  
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The textbook further explores techniques for organizing data, creating MIS 

reports, and visualizing data using Pivot Tables.  

Advanced Excel tools for dynamic reporting and dashboard creation are also 

included. Finally, the textbook covers automation using Macros and VBA, 

along with techniques for presenting professional analytical reports. With a 

blend of theoretical understanding and hands-on application, this textbook 

serves as a valuable resource for students aspiring to work as MIS Data 

Analysts in the BFSI domain. 

 
Dr. Pravin Narayan Mahamuni 

Associate Professor,  
DBC – PSSCIVE. 
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MODULE 1: BANKING SECTOR AND ROLE OF MIS 

DATA ANALYST 

The Banking, Financial Services, and Insurance (BFSI) sector plays a very 

important role in a country’s economic development by ensuring the efficient 

flow of money, financial stability, and risk management. It acts as the 

backbone of modern economies by mobilizing savings, facilitating 

investments, offering credit, and providing protection against unforeseen 

events through insurance. Over the past few decades, India’s BFSI sector has 

witnessed remarkable growth, driven by reforms, digitization, and financial 

inclusion initiatives. Institutions such as the Reserve Bank of India (RBI), 

commercial banks, Non-Banking Financial Companies (NBFCs), and 

Insurance companies together form a strong and interconnected financial 

ecosystem that supports individual, corporate, and national financial needs. 

In recent years, the BFSI sector has undergone a digital transformation with 

the emergence of UPI, FinTech companies, mobile banking, and AI-driven 

financial services, making financial products more accessible, secure, and 

efficient. Alongside this transformation, the role of data in decision-making, 

customer insights, regulatory compliance, and operational efficiency has 

grown significantly. This has led to a rising demand for skilled professionals 

who can manage, interpret, and analyse data using Management Information 

Systems (MIS). 

As the BFSI sector continues to evolve with rapid digitization and data-driven 

operations, the role of MIS Data Analysts has become increasingly vital. These 

professionals support business functions by transforming raw data into 

actionable insights, generating accurate reports, monitoring Key Performance 

Indicators (KPIs), ensuring regulatory compliance, and enabling informed 

decision-making across banking, financial services, and insurance domains. 

This module is divided into four sessions.  Session 1 covers the basics of the 

BFSI sector, key financial institutions, and recent trends. Session 2 explains 

the concept and types of MIS, its role in different banking functions, and how 

it supports operations, decision-making, reporting, and information flow 

within BFSI organizations. Session 3 covers the role of an MIS Data Analyst 

in financial services and reporting KPIs to stakeholders. Session 4 focuses on 

data privacy, ethics, and regulatory compliance in BFSI. 
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SESSION 1: OVERVIEW OF THE BFSI SECTOR 

INTRODUCTION TO BFSI 

The BFSI sector encompasses Banking, Financial Services, and Insurance, 

referring to the institutions that provide a wide array of financial products. 

This includes everything from large universal banks offering a full suite of 

financial solutions to specialized companies that focus on particular areas 

like investment services, insurance, or digital payment systems.  

In simple words, this sector includes a broad array of services from opening 

personal and business bank accounts and applying for loans to investing in 

mutual funds, retirement plans, and obtaining life and health insurance. 

Ultimately, BFSI plays a vital role in enabling people to efficiently manage 

their finances, grow their assets, and protect their financial future through 

comprehensive risk management solutions. 

The BFSI sector forms a very important part of any Indian economy. It impacts 

nearly every individual and business, playing an essential role in daily 

financial activities, wealth creation, risk protection, and overall economic 

progress. Whether someone is opening a bank account, taking a loan, 

investing in a mutual fund, or securing their future through insurance, the 

BFSI sector acts as a trusted partner in helping people and businesses handle 

their finances more efficiently and responsibly. 

Over the years, the BFSI sector has evolved expressively. In the past, banking 

and insurance were seen as slow-moving, paperwork-heavy services that often 

felt bureaucratic and intimidating. But today, digital technology, regulatory 

reforms, and increased financial awareness have transformed the landscape. 

What once required standing in long queues can now be done with a few taps 

on a smartphone. More importantly, BFSI is no longer just about storing 

money—it’s about enabling growth, supporting dreams, and ensuring 

financial well-being. 

 

Fig. 1.1: The Triangle of BFSI 

1. Banking: Banking is the core of the BFSI sector. It involves accepting 

deposits, providing loans, and enabling money transfers. Banks help 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

3 
 

people save their money safely, offer credit for personal and business 

needs, and support everyday transactions through ATMs, UPI, and mobile 

banking. Public sector banks, private banks, and rural banks together 

form a strong network that supports the country's financial needs and 

economic development.  

This sector not only provides a safe place for people to keep their money 

but also fosters financial inclusion by granting access to credit for 

individuals who might not otherwise qualify.  

2. Financial Services: Financial services refer to a wide range of non-

banking services that help people manage, invest, and grow their money. 

These include mutual funds, stock broking, credit rating, insurance 

brokerage, and wealth management. Financial service providers, such as 

NBFCs and investment firms, play an important role in creating financial 

awareness and offering customized financial solutions to individuals and 

businesses. 

3. Insurance: Insurance is an essential part of the BFSI sector that provides 

financial protection against unexpected risks and losses. It helps 

individuals and businesses manage uncertainties related to life, health, 

property, vehicles, and travel.  

There are two main types of insurance: life insurance, which offers 

financial security to a person’s family after their death, and general 

insurance, which covers health, vehicles, travel, and property. Companies 

like LIC, HDFC Life, New India Assurance, and ICICI Lombard help 

individuals and businesses manage uncertainty and gain peace of mind. 

OVERVIEW OF THE INDIAN BANKING SYSTEM 

The Indian banking system is the backbone of the country’s economy. It helps 

people and businesses save money, borrow loans, transfer money, and also 

supports the growth of the nation by funding various development activities. 

All banks in India work under the rules set by the Reserve Bank of India (RBI), 

which acts as the central authority to regulate and monitor their activities. 

The Reserve Bank of India (RBI) is India's central bank and the bedrock 

of its financial system 

The Reserve Bank of India (RBI) was established in 1935 and is the central 

bank of India. It has many important roles. It issues currency notes (except 

₹1 coins and notes), controls inflation, and manages interest rates in the 

country. It also takes care of India’s foreign exchange reserves and works as 

a bank for the government and for all other banks in India. RBI makes rules 

to ensure that all banks work safely and fairly. 
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TYPES OF BANKS IN INDIA 

India has a well-structured banking system to serve the different needs of 

people in urban and rural areas. All banks in India are regulated by the 

Reserve Bank of India (RBI). Broadly, banks in India are divided into two main 

categories i.e. Scheduled Banks and Non-Scheduled Banks.  

Scheduled Banks are simply banking that are included in the Second 

Schedule of the Reserve Bank of India Act, 1934.These banks must follow the 

rules and regulations made by the Reserve Bank of India (RBI). They must 

also maintain a certain amount of money as reserves with the RBI. Scheduled 

Banks are eligible to borrow money from RBI and take part in the 

clearinghouse (a system where banks settle payments between one another). 

These banks are considered safer and more trustworthy. Scheduled Banks in 

India encompass a wide range of financial institutions, including major public 

sector banks like the State Bank of India (SBI), leading private sector banks 

such as HDFC Bank and ICICI Bank, and also Regional Rural Banks (RRBs). 

This classification signifies their inclusion in the Second Schedule of the 

Reserve Bank of India Act, 1934. 

Non-Scheduled Banks are not listed in the Second Schedule of the RBI Act. 

These banks are usually small, local banks and do not follow all the rules set 

for scheduled banks. They cannot borrow money from the RBI for regular 

banking operations and are not allowed to be part of the clearinghouse. 

Because they are smaller and less regulated, they are less secure than 

scheduled banks. They still offer basic banking services like accepting 

deposits and giving small loans, but on a much smaller scale. 

Most banks that people use fall under the Scheduled Banks category. Below 

are the major types of banks in India: 

1. Commercial Banks: Commercial banks are profit-making institutions 

that provide services like accepting deposits, giving loans, and offering 

credit and debit cards. These banks can be public, private, or foreign. 

 Public Sector Banks are owned mainly by the Government of India. 

Example: State Bank of India (SBI), Bank of Baroda. 

 Private Sector Banks are owned by private companies and individuals. 

Example: HDFC Bank, ICICI Bank. 

 Foreign Banks have their head offices outside India but operate in the 

country. Example: Citibank, HSBC. 

2. Regional Rural Banks (RRBs): RRBs were created to serve the rural 

population, especially farmers, small businesses, and poor people. These 

banks provide essential financial services, such as savings accounts and 

small loans, primarily to customers in rural and semi-urban areas. These 
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banks are jointly owned by the Central Government, State Government, 

and a sponsoring Public Sector Bank.  

Example: Maharashtra Gramin Bank, Prathama UP Gramin Bank etc. 

3. Cooperative Banks: Cooperative banks are owned and run by their 

members, who are usually small farmers, local businesses, or traders. 

These banks are based on the principle of mutual help and mostly provide 

short-term credit. Cooperative banks operate in both rural and urban 

areas. They are of two types: 

 Urban Cooperative Banks: Work in towns and cities 

 Rural Cooperative Banks: Provide services to farmers and villagers 

4. Small Finance Banks: Small finance banks are created to provide basic 

banking services to the under-served sections of society, such as small 

farmers, street vendors, and small businesses. They accept deposits and 

provide loans, just like regular banks, but focus more on financial 

inclusion.  

Example: This category specifically includes institutions like AU Small 

Finance Bank and Equites Small Finance Bank. 

5. Payments Banks: Payments banks are special banks that offer basic 

banking services like accepting deposits (up to ₹2 lakhs per customer), 

online payments, and mobile wallets, but they cannot provide loans or 

credit cards. They are meant to make banking easier for people who don’t 

have access to full-service banks.  

Example: Paytm Payments Bank, India Post Payments Bank, Airtel 

Payments Bank. 

ROLES OF RBI, COMMERCIAL BANKS, NBFCS, AND INSURANCE 

COMPANIES 

The financial ecosystem in India comprises several key players, including the 

Reserve Bank of India (RBI), Commercial Banks, Non-Banking Financial 

Companies (NBFCs), and Insurance companies. Each of these entities plays 

a distinct and crucial role in facilitating economic growth, ensuring financial 

stability, and providing various services to individuals and businesses. 

1. Reserve Bank of India (RBI)  

The RBI, set up in 1935, is the central bank of India and the highest 

authority in the financial system. It manages the supply of money, sets 

interest rates, and controls inflation to keep the economy stable. It is the 

only institution allowed to print Indian currency and also regulates the 

flow of foreign currency. 
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Apart from this, the RBI monitors and regulates all banks to ensure they 

follow rules and protect depositors’ money. It also manages the 

government’s finances by issuing bonds and maintaining accounts. In 

short, RBI acts as the “guardian” of India’s money and ensures that the 

financial system runs smoothly. 

2. Commercial Banks 

Commercial banks are the banks we commonly use, such as SBI, HDFC, 

and ICICI. Their main job is to accept deposits from people and businesses 

and provide interest on them. They also give out loans for homes, cars, 

education, or business purposes, which helps individuals achieve goals 

and supports economic growth. 

Besides lending and saving, banks provide services like online banking, 

bill payments, money transfers, credit/debit cards, and investment 

options. They are an essential part of daily life because they make saving, 

spending, and borrowing money safe and convenient. 

3. Non-Banking Financial Companies (NBFCs)  

NBFCs are financial institutions that function like banks in many ways 

but do not have a full banking license. This means they cannot accept 

normal savings deposits, but they still provide loans for vehicles, housing, 

education, and small businesses, often serving customers in areas where 

banks may not be available. 

They also offer financial products like leasing, hire purchase, mutual 

funds, and wealth management services. Because NBFCs are less strict 

than banks in their procedures, they are able to provide quicker, more 

flexible services. They play an important role in reaching more people and 

supporting economic development. 

4. Insurance Companies  

Insurance companies provide financial protection against risks like 

accidents, illness, death, or property damage. Customers pay a small 

regular amount called a premium, and in return, the insurance company 

pays compensation when an insured event occurs. This helps people avoid 

big financial losses in difficult times. 

Different types of insurance include life insurance (supporting families 

after a death), health insurance (covering medical bills), vehicle insurance 

(covering car damage/accidents), and property or business insurance. 

Some policies also combine protection with savings. In this way, insurance 

companies act as a safety net, helping people and businesses manage risks 

and feel secure. 
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RECENT TRENDS IN BFSI  

The Banking, Financial Services, and Insurance (BFSI) sector in India has 

been undergoing significant transformations, largely driven by technological 

advancements, changing consumer behaviors, and regulatory reforms. Below 

are some of the most notable trends shaping the industry: 

Digital Banking 

Digital banking has significantly streamlined and accelerated banking 

processes for everyone. Now, people can do most of their banking through 

their phones or computers. You can check your balance, transfer money, pay 

bills, or even apply for a loan without going to the bank! Some banks don’t 

even have buildings; they are called neo-banks, and they work fully online 

through apps. Banks also use technology to understand what customers want 

and give them personalized offers. This makes banking smarter and more 

helpful for each person. 

1. Unified Payments Interface (UPI) 

Unified Payments Interface (UPI) has transformed the way money is sent 

and received in India. Developed by the National Payments Corporation of 

India (NPCI), UPI enables instant money transfers through mobile phones. 

There is no need to visit banks or carry cash, and the system works 24/7, 

including holidays.  

UPI is simple to operate even on basic smartphones, making digital 

payments accessible to a wider population and strengthening financial 

inclusion. It is now widely used for payments such as groceries, mobile 

recharges, online shopping, and many other services, often by simply 

scanning a QR code. 

2. FinTech Innovations 

FinTech stands for Financial Technology, and it means using technology 

to make financial services better. New platforms now help people borrow 

money online (called lending platforms) or invest using smart computer 

programs called robo-advisors. These tools suggest where to invest money 

based on your goals and budget. There’s also something called blockchain, 

a secure way to share information, which is slowly being used in banking. 

Some individuals are also exploring cryptocurrencies like Bitcoin, although 

these remain largely unregulated in India. In the insurance world, 

InsurTech companies make it easier to buy policies online and get claims 

processed quickly. 

3. Regulatory Changes 

As new financial tools grow, the government and regulatory bodies such 

as the RBI and IRDAI ensure that systems remain safe and fair. Rules are 
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created to protect personal data and safeguard money in online 

transactions. One major development is Open Banking, which allows 

companies to build apps that connect with banks (with customer 

permission) to provide better money management options. These measures 

balance innovation with security, ensuring protection while enabling the 

benefits of digital finance. 

PRACTICAL EXERCISE 

Activity 1: Digital Banking Tool Demo. 

Materials Required: 

 Smartphones or tablets (if available) 

 Printed screenshots of banking apps (UPI, mobile wallets) 

 Mock account information 

Procedure: 

1. Begin with a discussion on what digital banking means and why it is 

important for people who can't easily access banks. 

2. Show how mobile banking or UPI works using printed examples or demo 

apps (login screen, money transfer, QR code payment, etc.). 

3. Explain how these tools help people in rural areas or without access to 

physical banks. 

4. Demonstrate what happens when people don’t have digital access, how 

they face delays, travel costs, or lack of information. 

5. Let students interact with the printed/digital examples and ask questions. 

6. End with a short recap about how these tools make banking more 

inclusive. 

7. Student will prepare report and submit it to the teacher. 

Activity 2: Chart Creation on BFSI Institutions and their Functions. 

Materials Required: 

 Chart paper or whiteboard 

 Markers or pens 

 Reference notes or textbooks on BFSI 

Procedure: 

1. Divide students into small groups. 

2. Each group lists key BFSI institutions such as RBI, Commercial Banks, 

NBFCs, and Insurance Companies. 

3. Discuss and write down the main functions of each institution (e.g., RBI 

regulates money supply, banks provide loans, NBFCs offer credit, 

insurance companies manage risk). 
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4. Groups create a visual chart organizing institutions and their roles clearly. 

5. Each group presents their chart to the class. 

6. Discuss the key points and clarify any doubts. 

7. Submit chart to the teacher to display in the class. 

Activity 3: Presentation on Recent Trends in BFSI. 

Materials Required: 

 Computer/Laptop 

 Access to internet or textbooks (for research) 

 Presentation tools (PowerPoint, chart paper, or whiteboard) 

 Markers or pens 

Procedure: 

1. Divide class into small groups of 3-4 students. 

2. Assign each group to research one or more recent trends in BFSI, such as: 

a) Digital Banking 

b) UPI and Mobile Payments 

c) FinTech Innovations 

d) Financial Inclusion 

e) Cybersecurity 

f) Regulatory Changes 

3. Each group will research their assigned topic. 

4. Each group will prepare a short presentation covering: 

 Explanation of the trend 

 Its impact on customers and the BFSI sector 

 Examples or case studies 

5. Each group will give presentation to the class. 

6. Teacher will evaluate presentation and provide feedback. 

7. After all presentations, conduct a brief Q&A session to encourage 

discussion. 

8. Summarise about how these trends are shaping the future of BFSI. 

9. Presentation will be submitted to the teacher. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. The full form of BFSI is ________, Financial Services, and Insurance. 
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2. In India, the main body that controls and regulates banks is the 

________. 

3. Banks that give services like savings accounts, loans, and credit cards 

to the public are called ________ banks. 

4. The RBI is also known as the ________ bank of India because it controls 

money flow and interest rates. 

5. Companies that offer financial services but don’t hold a banking license 

are called ________. 

B. Multiple Choice Questions 

1. What does BFSI stand for? 

a) Bank Funding and Security Institution 

b) Banking, Financial Services, and Insurance 

c) Banking for Savings and Investments 

d) Business, Finance, and Stock Insurance 

2. Which organization acts as the central bank of India? 

a) SBI 

b) HDFC 

c) RBI 

d) ICICI 

3. What is the main role of NBFCs? 

a) Printing currency 

b) Managing foreign exchange 

c) Providing financial services without being a bank 

d) Issuing government bonds 

4. UPI is an example of which trend in BFSI? 

a) Insurance regulation 

b) Foreign trade 

c) Digital banking 

d) Cash withdrawal services 

5. What is the main job of insurance companies? 

a) Take deposits 

b) Provide loans 

c) Offer protection against risk 

d) Regulate banks 

C. State whether the following statements are True or False 

1. The RBI, which stands for Reserve Bank of India, is the central 

authority responsible for controlling the country's money supply and 

regulating banks.  
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2. Commercial banks are not allowed to give loans to companies or 

businesses, and they only serve individual customers.  

3. UPI (Unified Payments Interface) is a digital system that lets people 

easily send and receive money using their mobile phones without 

needing to go to the bank.  

4. Insurance policies are only meant to provide protection for life-related 

events and cannot be used to cover health expenses or damage to 

property.  

5. NBFCs (Non-Banking Financial Companies) are allowed to take 

deposits in savings accounts from the public just like regular banks.  

D. Match the following 

Column A Column B 

1 PAN Card A Helps manage money risks 

2 UPI B 
Identity proof required for tax-related 

purposes 

3 NBFC C Central bank of India 

4 Insurance D 
Financial services without banking 

license 

5 RBI E Digital payment method 

E. Short Answer Questions 

1. What does BFSI stand for and what are its main components? 

2. Mention any two recent digital trends in the BFSI sector. 

3. What is the role of the RBI in the Indian banking system? 

4. How do the three components of BFSI (Banking, Financial Services, and 

Insurance) work together to enhance financial well-being? 

5. Name two specific types of financial services that NBFCs often provide 

to underserved sectors. 

F. Long Answer Questions 

1. Explain the functions of Commercial Banks, NBFCs, and Insurance 

Companies in the BFSI sector. Give one example for each. 

2. Describe how digital banking and platforms like UPI are helping in 

financial inclusion in India. Why are these trends important in today’s 

economy? 

3. Beyond regulating monetary policy, what other key roles does the 

Reserve Bank of India (RBI) play in the Indian banking system? 
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4. How is the Indian banking system actively promoting financial 

inclusion, and what is one notable initiative mentioned? 

G. Check Your Performance 

1. Imagine you live in a remote village with no nearby bank branch. 

Explain how digital banking tools like UPI and mobile wallets can help 

you manage your finances and why this is important for financial 

inclusion. 

2. The Reserve Bank of India (RBI) plays a crucial role in regulating the 

banking system. Describe two key functions of RBI and how they impact 

commercial banks and NBFCs in India. 
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SESSION 2: MIS IN BFSI 

In the dynamic BFSI (Banking, Financial Services, and Insurance) sector, the 

symbiotic relationship between organizational structure and Management 

Information Systems (MIS) is crucial. 

ORGANIZATIONAL STRUCTURE IN BFSI 

The organizational structure of institutions within the BFSI (Banking, 

Financial Services, and Insurance) sector is designed to support efficiency, 

compliance, and service delivery. The implementation of Management 

Information Systems (MIS) further enhances decision-making, operational 

efficiency, and strategic planning. Below is an overview of the typical 

organizational structures in BFSI, along with the role of MIS. 

The organizational structure in the Banking, Financial Services, and 

Insurance (BFSI) sector is crucial for its efficient functioning. In India, this 

structure typically includes various levels, starting from top management, like 

the CEO and board of directors, down to middle management, such as 

department heads, and then to operational staff. Each level plays a specific 

role: top management sets the strategic direction, middle management 

implements policies, and operational staff handles day-to-day tasks.  

In the BFSI (Banking, Financial Services, and Insurance) sector, organizations 

often have a hierarchical structure. This means that there are different levels 

of authority, starting from the highest-ranking officials like the CEO, down to 

various teams and employees. The following points will help elaborate and 

highlight the key aspects of each structure. 

1. Hierarchical Structure: This is the way organizations are arranged, with 

clear lines of authority. The top-level management makes important 

decisions, while lower levels follow these directives.  

2. Functional Divisions: BFSI companies are divided into different 

functional areas, each specializing in a specific aspect of the business, 

such as banking, finance, or insurance. 

 Financial Services Division: This helps to focuses on offering various 

financial products, like loans and investment options, to help 

customers manage their money.  

 Insurance Division: Enables in providing insurance products to protect 

people and businesses against potential risks, like accidents or natural 

disasters.  

3. Regional and Branch Structure: Many BFSI companies operate through 

branches across different regions. Each branch serves local customers and 

helps the company reach a wider audience.  

4. Regulatory Compliance and Risk Management: Since the BFSI sector is 

heavily regulated, organizations must follow strict rules set by the 
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government. They also have dedicated teams to manage risks and ensure 

that they operate safely and responsibly.  

MANAGEMENT INFORMATION SYSTEM (MIS)   

MIS play a crucial role in the Banking, Financial Services, and Insurance 

(BFSI) sector, where efficient decision-making is paramount. MIS 

encompasses the processes and technologies that gather, process, and 

analyze data to provide timely and relevant information to management. This 

enables organizations to streamline operations, enhance customer service, 

and improve compliance with regulatory requirements. By integrating various 

data sources, MIS helps in the identification of trends, risk assessment, and 

performance evaluation, ultimately facilitating strategic planning and 

operational efficiency. By leveraging these systems, BFSI institutions can stay 

competitive, respond swiftly to market changes, and make informed decisions 

that drive growth and sustainability. 

Components of MIS 

A Management Information System (MIS) is a comprehensive framework that 

integrates various elements to provide managers with timely and accurate 

information for effective decision-making. These components work together to 

collect, process, store, and disseminate data, ensuring that leaders have the 

necessary insights to make informed choices.  

The components of MIS: The components of MIS (Data, Information 

Processing, Information Technology, People, Procedures, and Feedback) 

collectively work to transform raw data into actionable information, 

supporting organizational decision-making and continuous improvement. 

(Fig. 1.2) 

 

 

Fig. 1.2: The Components of MIS 

 Data: Raw facts and figures from various sources, like numbers and 

text. 

 Information Processing: Organizing and analyzing data to create 

useful information. 

Data 
Information 
Technology

Information 
Technology

People Procedures Feedback
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 Information Technology: Tools and systems, like computers and 

software, used to manage data. 

 People: Users of the MIS, including managers and employees who 

interpret information. 

 Procedures: Rules and steps to ensure data is collected and processed 

correctly. 

 Feedback: Information about how well the system is performing, used 

for improvements. 

Types of MIS 

MIS are not a single; it is a monumental entity but rather a collection of 

specialized systems designed to meet distinct information needs across an 

organization. Fundamentally, they can be categorized into types such as: 

MIS types span from Transaction Processing Systems (TPS) handling daily 

operations to ERP, SCM, and CRM systems integrating core business 

functions, and MRS, DSS, and EIS providing structured, analytical, and 

strategic insights for various management levels. (Fig. 1.3) 

 

Fig. 1.3: The Types of MIS 

 Transaction Processing Systems (TPS): These systems handle daily 

transactions like sales and withdrawals, ensuring accurate records. 

 Management Reporting Systems (MRS): Compile data into reports for 

managers to understand business performance.  

 Decision Support Systems (DSS): Assist in decision-making by 

analyzing data and providing options based on forecasts.  

 Executive Information Systems (EIS): Provide top executives with 

easy access to key information through user-friendly dashboards.  

 Customer Relationship Management Systems (CRM): Manage 

customer interactions and data to improve service and sales.  
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 Supply Chain Management Systems (SCM): Oversee the flow of goods 

from suppliers to customers, managing inventory and distribution.  

 Enterprise Resource Planning (ERP) Systems: Integrate various 

business processes into one system to improve efficiency and data 

sharing. These systems help organizations operate more efficiently and 

make informed decisions! 

FUNCTIONAL AREAS 

1. Retail Banking: The domain of retail banking, alternatively termed 

consumer banking, is dedicated to furnishing banking solutions for 

individual patrons, distinguishing itself from services offered to 

businesses. Its portfolio of provisions extends to deposit accounts (savings 

and checking), personal credit facilities (loans and mortgages), payment 

instruments (credit and debit cards), and wealth management products.  

2. Corporate Banking: Corporate banking serves the financial needs of 

businesses, from small-scale enterprises to large multinational 

corporations. It provides specialized financial services such as business 

loans, credit facilities, treasury and cash management, trade finance, and 

corporate investment services.  

3. Risk Management: Risk management involves identifying, assessing, and 

mitigating financial risks that an organization may face. Banks must 

manage several types of risks that financial institutions need to manage 

carefully. Credit risk refers to the chance that a borrower might not repay 

their loan. Market risk involves the possibility of financial loss due to 

changes in market conditions like interest rates or stock prices. 

Operational risk comes from internal issues such as system failures or 

human error. Lastly, liquidity risk is the risk that a bank or company might 

not have enough readily available cash to meet its short-term financial 

commitments. 

Effective risk management practices ensure that a bank remains stable 

and can adapt to changing economic conditions while protecting its assets 

and reputation. 

4. Compliance: Compliance means following all applicable laws, regulations, 

and internal guidelines that govern how banking activities are carried out. 

This ensures financial institutions conduct their operations responsibly 

and comply with established authoritative guidelines. This functional area 

ensures that the bank operates within the frameworks defined by 

governing bodies and laws, such as anti-money laundering (AML), know 

your customer (KYC) regulations, and consumer protection laws.  

5. Investment Banking: Investment banking focuses on providing financial 

services related to capital markets and helping organizations raise funds. 

Investment banks facilitate mergers and acquisitions (M&A), underwrite 
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new debt and equity securities, and assist companies in issuing IPOs 

(initial public offerings). They also offer advisory services on financial 

restructuring, valuation, and asset management.  

6. Treasury and Cash Management: The treasury department is responsible 

for managing the bank's liquidity, funding, and investment portfolios. It 

oversees cash flow, manages currency exposure, and invests excess funds 

in safe and liquid assets. Treasury functions also involve optimizing 

interest income, managing banking relationships, and ensuring adequate 

liquidity to meet obligations. Effective cash management strategies 

enhance a bank's operational efficiency and profitability. 

7. Wealth Management: The core of wealth management involves delivering 

extensive financial solutions to high-net-worth clients and their families. 

It involves services such as investment advice, estate planning, tax-

efficient strategies, and preparing for retirement to help individuals 

manage and grow their wealth effectively, tax optimization, and retirement 

planning.  

ROLE OF MIS IN OPERATIONS, DECISION-MAKING AND REPORTING 

Role of MIS in Operations 

MIS plays an important role in the smooth functioning of an organization’s 

daily activities. It acts as the central system that collects, processes, and 

shares vital information to support better decision-making and efficient 

operations. By automating routine tasks and providing real-time insights, MIS 

helps organizations improve productivity, reduce waste, and stay organized. 

Below is some important role of MIS in day to day operations of the business: 

 Supports organizations in managing routine work effectively. 

 Collects, processes, and shares important business information. 

 Reduces manual work by automating data entry, report creation, and 

transaction tracking. 

 Tracks the use of people, machines, and materials to help minimize waste. 

 Keeps track of important numbers to assess performance and progress. 

 Allows managers to spot issues early and take corrective action promptly. 

 Makes it easier for different teams to share information and coordinate 

tasks. 

 Improves the overall speed, efficiency, and structure of business 

operations. 

Role of MIS in Decision-Making 

MIS plays a vital role in improving the decision-making process of an 

organization. It collects and analyses large amounts of data, providing timely 
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and accurate information to managers. This helps organizations make 

informed, smart, and future-ready decisions. Below is some important role of 

MIS in decision-making of the business: 

 Provides the right information at the right time. 

 Acts as a Helpful Guide for Managers i.e. collects, studies, and presents 

real-time information about business performance. 

 Identifies Patterns and Trends: Helps analyse sales trends, customer 

behaviour, and potential problem areas. 

 Supports Forecasting and Future Planning i.e. uses past data to predict 

future outcomes, helping in better preparation. 

 Assists in Operational and Strategic Decisions i.e. guides decisions such 

as stock ordering, market entry, and resource allocation. 

 Enables Faster and Better Decisions: Helps managers make quick, data-

driven decisions with confidence. 

 Supports Big-Picture Planning: Provides insights for major initiatives like 

product launches or business expansion. 

 Helps Organizations Stay Smart and Competitive i.e. ensures businesses 

adapt to changes and make informed decisions to stay ahead. 

Role of MIS in Reporting 

One of the key functions of MIS is reporting. MIS provides accurate, timely, 

and customized reports that help different levels of management, teams, and 

even external agencies to stay informed, monitor progress, and make effective 

decisions. Below is some important role played by the MIS in the reporting: 

 Provides Relevant Information for Decision-Making: Delivers accurate and 

necessary information to managers, team leaders, and stakeholders. 

 Creates reports tailored to specific needs such as financial summaries, 

progress reports, and performance dashboards. 

 Monitors Company Performance: Helps visualize how well the organization 

is performing through clear and concise reports. 

 Ensures Legal and Regulatory Compliance i.e. produces reports that meet 

industry rules and legal requirements, especially in sectors like banking 

and healthcare. 

 Tracks Key Performance Indicators (KPIs): Compares actual results with 

company goals to monitor progress and identify areas for improvement. 

 Supports Timely and Effective Communication i.e. ensures the right 

information reaches the right people at the right time. 
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 Keeps Everyone Informed and Aligned: Helps all stakeholders understand 

company performance and direction. 

 Maintains Transparency and Accountability: Provides clear reporting that 

promotes responsibility and informed decision-making across the 

organization. 

INFORMATION FLOW AND HIERARCHY IN BANKS 

INFORMATION FLOW 

In banks, information flow refers to the movement of data and information 

between different levels and departments within the organization. A clear and 

efficient information flow is crucial for operational effectiveness, timely 

decision-making, and customer service. The flow often involves several steps, 

from data collection to dissemination, involving various stakeholders 

throughout the hierarchy. 

Information flows within an organization either vertically (up and down the 

hierarchy) or horizontally (between peers and departments at the same level), 

while external flow involves communication with entities outside the 

organization, like customers or regulators. (Fig. 1.4) 

Types of Information Flow: Below are the types of information flow in the 

bank/business (Fig. 1.4): 

 

Fig. 1.4: Information Flow 

1. Vertical Flow: This refers to the flow of information between different 

hierarchical levels. For example, instructions and reports move down from 

top management to operational staff, while performance reports and data 

from operations move up to middle and top management. 

2. Horizontal Flow: Information can also flow laterally between different 

departments within the same level of hierarchy. For example, the risk 
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management department may share insights with the compliance 

department to ensure adherence to regulations and effective risk 

assessment. 

3. External Flow: Banks interact with external entities such as regulatory 

bodies, clients, and partners. Information flow to and from these entities 

is vital for compliance and service enhancement. This includes regulatory 

reporting, customer feedback, and market trends. 

HIERARCHICAL STRUCTURE IN BANKS 

The hierarchy in banks can generally be categorized into three main levels: 

top management, middle management, and operational staff. Every tier has a 

unique function in how information is disseminated. 

In a bank, there are three main levels of management (i.e. Top Management, 

Middle Management, and Operational Staff) each plays an important role in 

making the bank run smoothly.  

At the top, we have leaders like the CEO and CFO, who make big decisions 

about the bank’s future, such as expanding to new cities or changing 

important policies. They depend on summaries and reports to plan wisely.  

In the middle are the managers and department heads who oversee areas 

like customer service, loans, and risk management. They collect information 

from the staff below them, analyse it, and send important insights to the top 

leaders. They also help make sure their teams are working toward the bank’s 

goals.  

At the bottom level are the operational staff, like people working at bank 

branches, in IT, or in customer care. These employees handle the bank’s day-

to-day work by helping customers, processing transactions, and solving 

problems. They use digital systems and tools to make quick decisions and 

send beneficial information up the chain. 

All three levels work like a team to make sure the bank runs well and keeps 

improving. 

PRACTICAL EXERCISES 

Activity 1: Exploring the Components of an E-Commerce Platform. 

Materials required:  

 Internet-enabled devices (laptop/tablet/smartphone) 

 Pen and notebook or worksheet 

 Projector (optional, for demonstration) 

 component checklist (optional) 

Procedure: 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

21 
 

1. Briefly explain what an e-commerce platform is and Give a real-life 

example (e.g., Amazon or Flipkart). Describe how users interact with such 

systems. 

2. Divide students into small groups of 4-5 students. 

3. Ask each group to open an e-commerce website or app on their device and 

explore it.  

4. Provide instructions to identify and note down the main components they 

observe. These may include: 

 Home Page 

 Search Bar 

 Product Listings 

 Product Details Page 

 Add to Cart / Wish list 

 Checkout System 

 User Login/Signup 

 Payment Gateway 

 Order Tracking 

 Customer Support Chat 

 Reviews & Ratings 

5. Each group map the components to user needs (e.g., “Search Bar” → helps 

find products quickly). They can fill this on a worksheet or draw a diagram. 

6. Facilitate a discussion by asking to each group:  

 Which component is most essential for a good user experience?  

 What challenges might a user face if any component is missing? 

7. Each student writes the identified components neatly in thier notebook or 

worksheet. 

8. Submit write up to the teacher. 

Activity 2: Group Discussion on Role of MIS in Operations, Decision-Making 

and Reporting. 

Materials required:  

 Whiteboard/Flip Chart or Blackboard 

 Markers/Chalk 

 Handouts or Printed Notes on MIS Concepts (optional) 

 Notebooks and Pens 

 Projector/Screen for brief introduction (optional) 

 Timer or Stopwatch  

Procedure:  

1. Divide the class into small groups of 3–4 students per group.  

2. Assign discussion points or topics to each group such as: 
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a) How MIS supports Operations 

b) Role of MIS in Decision-Making 

c) MIS and Reporting for Management 

3. Groups discuss their assigned topic.  

4. Encourage sharing of real-life examples (e.g., e-commerce platforms, 

banks, schools, etc.). 

5. Each group presents key discussion points to the class. 

6. Teacher writes main points on the board. 

7. Ask few students to summarize the session. 

8. Teacher summarize the role of MIS in streamlining operations, improving 

decisions, and generating reports for effective management. 

Activity 3: How Banks Use MIS to Approve Loans. 

Materials required:  

 Chart papers or blank sheets for group work 

 Markers or pens for writing 

 A simple role card or case handout describing a basic loan process in a 

bank (e.g., a customer applying for a home loan) 

 A classroom projector or board  

Procedure: 

1. Start with a short explanation of what MIS is and how banks use it for 

example, to collect customer details, check credit history, approve loans, 

and monitor repayment. 

2. Divide students into small groups of 3–4 student per group. 

3. Assign each group the task of role-playing how a bank uses MIS in loan 

processing. 

4. Each group creates a mini-presentation (on chart paper or orally) showing 

how MIS helps: Collect customer data, check credit score/history, speed 

up loan approval, Generate reports for the bank manager 

5. Each group present their findings in simple language, using examples like 

a person applying for a car or education loan.  

6. Teacher will evaluate the group and each student performance. 

7. Ask few students to summarize the session. 

8. Each student writes their learning or what they understood. 

9. Submit write up to the teacher. 

Activity 4: Follow the Data – A Look Inside a Bank's Information Flow. 

Materials required:  

 Plain A4 sheets or chart paper 
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 Pencils or pens 

 Markers for labelling, and a basic scenario or flow description (e.g., a 

customer applying for a savings account or loan).  

Procedure: 

1. Briefly explain what a Data Flow Diagram (DFD) is i.e. a simple drawing 

that shows how data moves between people, systems, and departments in 

a bank. 

2. Present a simple scenario: A customer visits a bank to apply for a loan. 

The bank collects the form, sends it to the loan department, checks credit 

history, gets manager approval, and stores the data in the system. 

3. Divide the class into small groups of 4-5 students. 

4. Ask them to:  

 Identify the main entities (Customer, Bank Clerk, Loan Department, 

Manager, Database) 

 Draw arrows to show how data flows between them (e.g., loan form, 

approval request, credit report) 

 Provide the image for each arrow with what data being transferred 

5. Each group can explain the flow of data in the class.  

6. Ask few students to summarize the session. 

7. Teacher will provide concluding remarks. 

8. Each student writes their learning or what they understood. 

9. Submit write up to the teacher. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. In banks, the ___________ function of MIS supports daily tasks like 

customer transactions and account management. 

2. One key component of MIS is the __________, which stores and retrieves 

organizational data. 

3. Corporate banking focuses on serving ____________ large enterprises. 

4. Compliance ensures that banks follow all relevant __________ and 

internal policies. 

5. A ___________ report helps bank managers in making strategic 

decisions. 

B. Multiple Choice Questions 

1. What does MIS help organizations primarily with? 

a) Social media marketing 

b) Manual record-keeping 

c) Decision-making and operations 

d) Entertainment services 
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2. Which of the following is a functional area in banking? 

a) Manufacturing 

b) Retail Banking 

c) Event Planning 

d) Agriculture 

3. The component of MIS responsible for processing data into information 

is: 

a) Hardware 

b) Database 

c) Software 

d) Processing Unit 

4. Information in banks flows through a structured ___________. 

a) Entertainment system 

b) Hierarchy 

c) Website 

d) Advertisement 

5. Which of the following refers to managing the risk of borrower default? 

a) Liquidity Risk 

b) Credit Risk 

c) Market Risk 

d) Operational Risk 

C. State whether the following statements are True or False 

1. MIS systems are used only by IT departments and not by other 

departments in a bank. 

2. In retail banking, MIS helps track individual customer transactions and 

preferences. 

3. Credit risk refers to the possibility of a system failure in bank 

operations. 

4. MIS reports can assist in forecasting, budgeting, and compliance 

tracking in banks. 

5. Decision-making in banks is supported by data and reports generated 

through MIS. 

D. Match the Column 

Column A Column B 

1 MIS Report A Ensures legal and regulatory adherence 

2 Retail Banking B  Used for loans, savings, and deposits 
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3 
Corporate 

Banking 

C Supports daily operational tasks 

4 
Compliance D Data summary used for analysis and 

planning 

5 Operations E Handles business-level financial services 

E. Short Answer Questions 

1. How does MIS benefit both the top-level and operational-level 

management in a financial institution? 

2. Besides providing financial protection against unforeseen events, how 

do some insurance products also serve as an investment opportunity? 
3. In the Lending/Loans department, how does MIS assist in evaluating 

loan applications and managing risks? 

4. How does the Compliance department use MIS to ensure the BFSI 

organization follows all regulations and rules? 

5. What kind of information does MIS provide to the Marketing department 

to help them attract new customers or offer new products? 

6. How does MIS support the Finance/Accounts department in tracking 

money, managing budgets, and creating financial reports? 

F. Long Answer Questions 

1. Define Management Information System (MIS). Explain its key 

components and describe how it supports a bank's day-to-day 

operations and long-term planning. 

2. Discuss the role of MIS in various functional areas of banking such as 

Retail Banking, Corporate Banking, Risk Management, and 

Compliance. Use examples to illustrate your points. 

3. Explain how MIS enhances operations, decision-making, and reporting 

in a financial institution. Describe the flow of information within a bank 

and how it supports managers at different levels. 

G. Check Your Performance  

1. Consider a small business owner operating in a tier-2 city. Explain how 

the increased flexibility and specialized loan offerings of Non-Banking 

Financial Companies (NBFCs) might be more beneficial for their 

business growth compared to traditional public sector banks.  

2. Beyond providing risk coverage, how do insurance companies 

contribute to the overall financial stability of individuals and the 

economy, particularly through their investment-linked products and 

promotion of savings? 
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SESSION 3: MIS DATA ANALYST IN FINANCIAL SERVICES 

Data Analyst plays an important role in helping banks and financial 

companies make smart decisions by turning complex data into useful 

information. Their job is to gather and study data and turn it into clear 

insights that help improve business performance, support planning, and 

make daily operations more efficient. 

JOB DESCRIPTION AND KEY DELIVERABLES 

Job Description 

In the financial services world, an MIS Data Analyst looks at different sets of 

data to help leaders make better decisions. This job needs someone who 

understands how to manage and analyse data, knows about financial 

products, and is comfortable working with numbers and tools. (Fig. 1.5) 

 

Fig. 1.5: Job Description 

The analyst works with many teams across the BFSI sector which includes 

Banking, Financial Services, and Insurance to solve problems using data and 

make work smoother and faster.  

An MIS Data Analyst is like a behind-the-scenes superhero who helps a 

company make smart choices using numbers. First, they collect and organize 

information from both inside the company like sales and customer orders and 

from the outside world, like news about the market. They make sure 

everything is neat and accurate. Then, they study the numbers using math 

and computer tools to spot patterns, like why something sold really well last 

month or why sales suddenly dropped. To help others understand what they 
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find, they turn all that data into colourful charts and simple reports that 

managers can look at quickly. They also work with different teams, like 

finance and marketing, to explain what the numbers mean and help them 

make better decisions. These analysts are always watching important 

performance numbers, called KPIs, to see how the company is doing—and if 

something's off, they come up with ways to fix it. Best of all, they keep learning 

new tools and tricks so they can stay ahead and help the company grow 

smarter and faster. 

Key Deliverables 

An MIS (Data) Analyst in a bank or finance company is like a “data translator.” 

They take mountains of tricky numbers and turn them into clear stories that 

help bosses make smart choices about money, loans, and investments. To do 

this job well, they need three big super-skills: 

 Knowing how data is stored and moved around (so nothing gets lost or 

mixed up). 

 Being great at spotting patterns in numbers (that’s the analytical part). 

 Understanding how money products work (like savings accounts, credit 

cards, or the stock market). 

A Data Analyst in a finance company plays a key role in converting large sets 

of numbers into useful insights that support decision-making. One of the 

main responsibilities is preparing regular reports that track performance on 

a weekly or monthly basis, such as identifying whether sales and revenues 

are rising or falling. 

Data Analysts also design dashboards, which display real-time information 

through charts and graphs, allowing managers to quickly monitor business 

performance. When specific issues arise, such as a drop in profits, they 

conduct ad-hoc analysis to investigate the reasons behind the change. 

To ensure accuracy, analysts perform data quality checks and correct errors 

in datasets. They also prepare presentations and visual reports to 

communicate findings clearly to company leaders, often supported by charts 

and summaries. In addition, they maintain documentation that explains how 

the data was collected, processed, and analysed. 

Finally, Data Analysts continuously look for process improvements, 

suggesting new methods or tools that can save time, enhance accuracy, and 

improve overall efficiency. In this way, they act as an essential link between 

raw data and smart business decisions. 

ESSENTIAL TOOLS FOR FINANCE AND BANKING ANALYSIS 

To work well in finance and banking, the right tools are very important. Tools 

like Excel help in doing calculations and making financial plans. SQL is used 
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to get and manage large amounts of data. Dashboards and data visualization 

tools like Power BI or Tableau make it easy to see patterns and trends in data. 

Risk management tools and regulatory databases help banks follow rules and 

avoid losses. Also, financial news websites help professionals stay updated 

with the latest changes. All these tools help in making smart and safe financial 

decisions. (Fig. 1.7) 

Fig. 1.7: Essentials Tools for finance and Banking analysis 

The following points help us understand the concepts more clearly:  

1. Excel (Electronic X-Cellence in Computing and Easy Learning): Think 

of Excel as a smart digital notebook that helps to work with numbers. It’s 

great for organizing data in rows and columns, doing calculations, and 

even spotting future trends. 

Example: A bank can use Excel to track how much money it made from 

different types of loans. It can quickly calculate totals, compare profits, 

and create a pie chart to see which loan performed best. 

2. SQL (Structured Query Language): SQL is a language used to 

communicate with large databases. It helps in finding, organizing, and 

analysing the required data. 

In BFSI, it’s used to pull out important financial data, analyse patterns, 

and create reports. It can also combine data from different sources so that 

everything stays up to date. 

3. Dashboards: Dashboards help turn complicated data into simple visuals 

like charts and gauges. They show key information in a quick and clear 

way. 
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Tools like Tableau, Power BI, or Google Data Studio let users build 

dashboards to track performance in real time, making it easier to respond 

to changes or make fast decisions. 

4. Financial Modelling Software: These tools go beyond basic spreadsheets. 

They are designed to test different financial scenarios like what would 

happen if interest rates went up or if customer demand dropped. 

Example: A bank analyst might use this software to model how a new 

housing policy could impact the bank’s home loan business over the next 

few years, adjusting assumptions and seeing different possible outcomes. 

5. Data Visualization Tools (e.g., Tableau, Power BI): These tools are like 

artists for data – turning numbers into pictures. Instead of staring at long 

tables of data, users see graphs, charts, and maps that help them 

understand what's happening at a glance. 

Example: A bank might use Tableau to map where new credit card 

applications are coming from, showing which cities or states have higher 

or lower interest. 

6. Risk Management Software: Since banks take on many risks (like loan 

defaults or market crashes), this software helps them detect and prepare 

for potential problems. 

Example: Before giving a business loan, a bank can use risk software to 

check the company’s financial background and estimate how likely it is 

they will repay the loan, suggesting ways to reduce the risk. 

7. Financial News Platforms (e.g., Bloomberg Terminal, Reuters): These 

platforms provide real-time updates about stock markets, economic 

events, and company news. They are like specialized news channels for 

finance professionals. 

Example: A trader might use Bloomberg to track how a company’s stock 

price reacts after a news story breaks, helping them decide whether to buy 

or sell quickly. 

8. Regulatory Databases: Banks have to follow many rules and laws. These 

databases store all those regulations in one place and help ensure the bank 

stays compliant. 

Example: If there is a new rule about customer privacy, the compliance 

team checks the regulatory database to understand the rule and update 

the bank’s practices accordingly. 
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KPIS, REPORTS, AND COMMUNICATION WITH STAKEHOLDERS IN BFSI 

KEY PERFORMANCE INDICATORS (KPIs) 

Key Performance Indicators, or KPIs, are like scorecards that help banks and 

insurance companies check how well they are doing. They are used to 

measure things like profits, customer happiness, and how smoothly services 

are running. Below are the KPIs used for Banks and Insurance Companies. 

1. Net Interest Margin (NIM): Net Interest Margin shows how much profit a 

bank makes from lending money after paying interest to depositors. A 

higher NIM means the bank is using its funds smartly and earning more 

from its core business. 

2. Return on Assets (ROA): Return on Assets tells how well a bank or 

insurance company is using its resources like buildings, equipment, and 

cash to make profits. A higher ROA means the company is efficiently using 

its assets to generate income. 

3. Loan-to-Deposit Ratio (LDR): This ratio compares how much money a 

bank gives as loans to the amount it receives as deposits from customers. 

It helps check if the bank is lending responsibly while keeping enough 

funds for safety. 

4. Customer Satisfaction Score (CSAT): The Customer Satisfaction Score 

measures how happy customers are with the bank or insurance services. 

It reflects their experience with staff behaviour, problem-solving, and 

overall service quality. 

5. Claims Processing Time (for Insurance Companies): Claims Processing 

Time tracks how fast an insurance company settles claims. Quick 

processing builds trust and shows the company cares about its customers 

during emergencies. 

6. Non-Performing Assets (NPA) Ratio: The NPA Ratio shows the percentage 

of loans where borrowers have stopped making payments. A lower NPA 

ratio means the bank has healthier loans and better financial stability. 

7. Cost-to-Income Ratio: This ratio compares the bank’s expenses to the 

income it earns. A lower Cost-to-Income Ratio indicates the bank is 

running efficiently, keeping costs low while earning well. 

8. Retention Rate (Insurance): Retention Rate measures how many 

customers renew their insurance policies. A high retention rate means 

customers trust the company and are satisfied with its services. 

So, KPIs are like traffic lights for any business as they signal when things are 

going great or when something needs fixing. 

REPORTS 

In banks and insurance companies, reports are like important progress cards 

that help everyone understand how the business is doing. These reports are 
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used to share useful information with managers, workers, and sometimes 

even the government. They show what’s working well, what needs to improve, 

and how to plan for the future. There are different types of reports for different 

needs such as:  

1. Financial Statements: Financial Statements show the overall financial 

health of the company. They include details like how much the company 

owns (assets), how much it owes (liabilities), profits earned, and how 

money flows in and out of the business. 

2. Management Reports: These reports help managers track how different 

departments, such as loans, sales, or customer service, are performing. 

They support smart decision-making to improve daily operations and 

efficiency. 

3. Risk Assessment Reports: Risk Assessment Reports act like early 

warning tools. They identify potential problems such as market changes, 

bad loans, or other risks. They also ensure the company is following legal 

rules and guidelines. 

4. Market Analysis Reports: Market Analysis Reports study what 

competitors are doing and identify market trends. They help businesses 

discover new opportunities to grow, improve services, or launch new 

products. 

Reports in the BFSI sector are essential tools. They provide clear and accurate 

information to help people understand the present situation, fix problems, 

and make plans for the future. 

COMMUNICATION WITH STAKEHOLDERS 

In banks and financial companies, it is very important to communicate clearly 

with people who care about the business. These people are called 

stakeholders. In simple words, stakeholders are the people or groups who are 

affected by or interested in the company. This includes investors, customers, 

government regulators, and business partners. Following point should be 

taken care while communication with the stakeholders: 

1. Clear communication: It helps stakeholders understand what the 

company is doing. When they feel informed and included, they are more 

likely to trust and support the business. 

2. Ways to Communicate: Companies use emails, meetings, newsletters, 

and online sessions to share updates. These updates can include company 

performance, new policies, or future plans. 

3. Custom Communication for Different Groups: Different groups care 

about different things. For example, investors want to hear about profits, 

customers care about service quality, and regulators focus on rule 

compliance. So, companies prepare custom messages for each group. 
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4. Collecting Feedback: Companies also ask for feedback using surveys or 

suggestion platforms. This shows that the company listens to people’s 

opinions and wants to improve. 

5. Being Honest and Transparent: The most important part of 

communication is being honest, even when there are problems. Sharing 

challenges and risks builds trust and strong relationships with 

stakeholders. 

PRACTICAL EXERCISE 

Activity 1: Be the Data Analyst for a Day. 

Materials Required: 

 Laptop or desktop with Microsoft Excel / Google Sheet 

 Sample financial data sheet (e.g., loan details, customer satisfaction 

ratings, revenue figures) 

 Printed handouts of KPI definitions (Net Interest Margin, ROA, etc.) 

 Chart paper and markers (for group presentations) 

 Projector or screen (optional, for showcasing dashboards) 

Procedure: 

1. Begin with a discussion by explaining who an MIS Data Analyst is and 

how they support financial organizations by working with data to make 

better decisions. 

2. Distribute Sample Data Provide students with a simple Excel or Google 

Sheets file that includes fake but realistic financial data like loan 

amounts, deposit figures, customer feedback scores, etc. 

3. Provide hand out a sheet explaining basic KPIs like Net Interest Margin, 

Return on Assets, Loan-to-Deposit Ratio, and Customer Satisfaction 

Score. Explain each one with simple examples. 

4. Ask students to calculate at least 2–3 KPIs using the sample data. They 

can use basic Excel functions (like SUM, AVERAGE, etc.) to find results. 

5. Students should then write a brief report highlighting what the numbers 

show. For example, whether the bank is performing well or if there’s a 

problem area that needs improvement. 

6. Group Presentation: Divide students into small groups.  

7. Each group presents their findings and suggests one improvement based 

on their analysis. They can use chart paper or digital slides. 

8. Discuss the activity as a class. Talk about how real analysts use similar 

techniques and tools (like Excel, SQL, and dashboards) to help banks 

make important decisions. 

9. Prepare report or write up on learnings and  

10. Submit report or write to the teacher. 
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Activity 2: Presentation on Job Description and KPIs. 

Materials Required: 

 Laptop/Desktop with Presentation Software (e.g., PowerPoint) 

 Projector and Screen/Smart Board 

 Sample Job Description Templates (Printed or Digital) 

 Sample KPIs for Different Roles (Printed or Digital) 

 Whiteboard/Flipchart and Markers 

 Handouts/Notes  

 Timer/Stopwatch for Presentation Timing 

 Internet Access (optional, for examples or references) 

Procedure:  

1. Divide class into small groups of 3-5 students per group. 

2. Assign each group a specific job role (e.g., Sales Executive, Data Analyst, 

Customer Support, Teacher, etc.). 

3. Each group prepares a short presentation that includes: 

 Job Title and Department 

 Key Roles and Responsibilities (Job Description) 

 Required Qualifications and Skills 

 4-5 relevant KPIs for the role 

4. Each group presents their Job Description and KPIs. 

5. Other groups and teacher provide feedback and suggestions. 

6. Teacher summarizes key points: 

 Importance of clear job descriptions 

 How KPIs align with job expectations and organizational goals 

 Real-life examples from industries 

7. Ask students to share how clear JDs and KPIs can help improve 

productivity and accountability in their own workplace. 

8. Each student writes their learning or what they understood. 

9. Submit write up to the teacher.  

Activity 3: Preparing a sample report format for a financial metric. 

Materials Required: 

 Laptop/Desktop with MS Word or MS Excel 

 Projector/Smart Board (for demonstration) 

 Sample Financial Data (e.g., Sales Revenue, Profit Margin, Expenses) 

 Handouts with Key Financial Metrics definitions 

 Whiteboard/Flipchart and Markers 
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 Templates for Report Format (optional) 

 Calculator (optional) 

Procedure:  

1. Teacher explains what financial metrics are (e.g., Revenue, Profit Margin, 

ROI, Cost of Sales, etc.). Discuss the importance of clear, concise 

financial reporting for managers and stakeholders. 

2. Displays a sample report format, highlighting key components such as: 

 Report Title 

 Period of Reporting 

 Financial Metric(s) being reported 

 Data Table or Summary 

 Graphs/Charts (if applicable) 

 Interpretation or Comments Section 

3. Divide class into small groups of 3-5 students per group. 

4. Assign each group one financial metric (e.g., Monthly Sales Revenue, 

Profit Margin %, Cost Breakdown). 

5. Groups use provided data to create a simple, clear report format that 

includes: 

 Title of the Report 

 Time Period Covered 

 Data Table with figures 

 Visual Element (e.g., bar chart, pie chart) 

 Short Interpretation (1-2 lines) 

6. Each group present their sample reports. 

7. Teacher and other groups provide constructive feedback on format 

clarity, relevance of data, and presentation style. 

8. Summarizes best practices for financial reporting: 

 Keep it concise and visually clear 

 Highlight trends and key figures 

 Use visual tools for better understanding 

 Provide brief insights for decision-makers 

9. Each student writes their learning or what they understood. 

10. Submit write up to the teacher.  
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CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. An MIS Data Analyst helps financial institutions make decisions by 

analysing and interpreting __________. 

2. One of the key responsibilities of an MIS analyst is tracking __________ 

to measure business performance. 

3. __________ is a common tool used by MIS analysts to create 

spreadsheets, reports, and dashboards. 

4. In the BFSI sector, MIS analysts often work with departments such as 

finance, compliance, and __________. 

5. Dashboards help visualize complex data using elements like charts, 

graphs, and __________. 

B. Multiple Choice Questions 

1. What does MIS stand for? 

a)  Management Integrated Software 

b)  Management Information System 

c)  Marketing Information Structure 

d)  Monetary Insight System 

2. Which tool is commonly used by MIS Analysts for data analysis and 

reporting? 

a)  Photoshop 

b)  Excel 

c)  AutoCAD 

d)  Canva 

3. What is one of the main roles of an MIS Data Analyst? 

a)  Writing advertising scripts 

b)  Analysing market trends 

c)  Managing HR payroll 

d)  Filing legal documents 

4. Which of the following is a Key Performance Indicator (KPI) in financial 

services? 

a)  Customer birthday count 

b)  Product colour preference 

c)  Net Interest Margin 

d)  Employee shoe size 
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5. What does a dashboard help visualize in MIS reporting? 

a)  Employee birthdays 

b)  Data and performance metrics 

c)  Office seating arrangements 

d)  Social media posts 

C. State whether the following statements are True or False 

1. MIS Data Analysts work only with marketing teams in a financial 

organization.  

2. Dashboards are used to present data in a visually understandable 

format.  

3. Excel cannot be used for financial analysis. 

4. A high Return on Assets (ROA) means the company is using its assets 

efficiently. 

5. One of the responsibilities of an MIS Data Analyst is to predict future 

business trends using data. 

D. Match the following 

Column A Column B 

1 
Net Interest Margin 

(NIM) 
A Helps manage money risks 

2 Excel B Used for presenting KPIs visually 

3 
Customer Satisfaction 

Score 
C Profit from interest income 

4 Power BI D Tool for creating financial reports 

5 
Risk Assessment 

Report 
E Helps evaluate potential threats 

E. Short Answer Questions 

1. Who is an MIS Data Analyst and what do they do in the financial sector? 

2. What is the importance of KPIs in financial services? 

3. Explain any two common tools used by MIS Data Analysts. 

4. What is a dashboard, and why is it used? 

5. Name any two departments an MIS analyst might collaborate with in a 

bank. 
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F. Long Answer Questions 

1. Explain the role of an MIS Data Analyst in the financial services 

industry. What are their key responsibilities, and how do they 

contribute to organizational success?  

2. Describe the importance of using tools like Excel, Power BI, and SQL in 

the daily tasks of an MIS Data Analyst. How do these tools help in 

analysing and presenting financial data?  

3. What are Key Performance Indicators (KPIs) in financial services? 

Choose and explain any three KPIs used by MIS Data Analysts, and 

describe why tracking them is important for a bank or financial 

institution.  

4. Imagine you are an MIS Data Analyst in a bank. The management 

wants to improve customer satisfaction and reduce loan processing 

time. How would you use data to help solve this problem? Explain the 

steps and tools you would use. 

G. Check Your Performance 

1. A bank has seen a drop-in customer satisfaction scores over the last 

two months. The MIS analyst is asked to find the cause. What kind of 

data should the analyst look at, and which KPI might help solve this 

issue? 

2. A financial institution wants to know which type of loan is bringing in 

the most interest income. How can an MIS Data Analyst present this 

information, and what tool might they use to make it easy to 

understand? 
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SESSION 4: ETHICS, DATA PRIVACY AND REGULATORY 

ENVIRONMENT 

In today’s digital world, the Banking, Financial Services, and Insurance (BFSI) 

sector deals with massive amounts of sensitive customer information every 

day. This includes personal details, bank account information, income 

records, insurance data, and more. That’s why it is extremely important to 

handle this data with care, responsibility, and according to the law. 

The reasons why Data Confidentiality, Ethical Practices, Data Privacy, and 

Regulatory environment or Compliance are essential in the BFSI sector are 

outlined below: 

Ethics in BFSI: The Banking, Financial Services, and Insurance (BFSI) sector 

depends greatly on customer trust. People expect banks and financial 

institutions to act honestly and fairly. That’s why ethics play a major role. 

Ethical practices include being open about how things work, explaining 

financial products clearly, and avoiding any actions that could confuse or 

harm customers. It also means giving loans responsibly, treating customers 

with fairness, and making sure all communication is truthful. Inside the 

organization, ethics also involve strong internal rules, accountability, and 

avoiding conflicts of interest. 

Data Privacy: In BFSI, keeping customer data safe is extremely important. 

Banks and financial companies handle sensitive information, like personal 

and financial details, which makes them a common target for hackers. To 

protect this data, they must use strong security systems. There are also rules 

like the GDPR (General Data Protection Regulation) and national laws that 

say how this data should be collected, stored, and used. It is important for 

companies to ask customers for permission before using their data, be clear 

about how it's used, and keep it safe from unauthorized access. Protecting 

customer data builds trust and shows a company’s commitment to privacy. 

Regulatory Environment: The BFSI industry is closely watched by 

regulators to make sure everything runs fairly and securely. In India, the 

Reserve Bank of India (RBI) looks after the banking system, Securities and 

Exchange Board of India (SEBI) manages the stock market, and Insurance 

Regulatory and Development Authority of India (IRDAI) regulates insurance 

companies. These organizations set rules that all financial institutions must 

follow like doing audits, reporting activities, and following fair practices. 

Following these rules is important, because breaking them can lead to heavy 

fines, loss of reputation, and losing customer trust. 
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DATA GOVERNANCE PRINCIPLES 

In the BFSI sector, managing data properly is extremely important because 

the information handled is sensitive and valuable. Data governance means 

making sure data is available, accurate, secure, and used responsibly. Below 

are the key principles that help guide good data governance: 

1. Data Quality: Good decisions depend on good data. This means the 

information should be correct, complete, consistent, and reliable. 

Regular checks and cleaning of data help keep it accurate and 

trustworthy. 

2. Data Stewardship: Every important set of data should have someone 

responsible for it called as a data steward. These individuals help make 

sure the data is well-managed, safe, and follows the rules. 

3. Data Privacy and Compliance: Customer data must be handled 

carefully. BFSI organizations must follow privacy laws (like GDPR) and 

protect customer information. This includes having clear rules about how 

data is collected, stored, and used. 

4. Data Security: Protecting data from hackers or unauthorized access is a 

top priority. This means using tools like encryption, limiting who can 

access what, and conducting regular security checks to keep information 

safe. 

5. Data Accessibility: While data must be protected, it also needs to be 

available to the right people at the right time. Clear access rules help 

employees use data effectively without risking security. 

6. Data Lifecycle Management: Data has a life, from when it is created to 

when it is no longer needed. Organizations must decide how long to keep 

data and when to archive or delete it to stay organized and follow 

regulations. 

8.   Integration and Interoperability: Data should be able to move smoothly 

between systems. This means using common formats and processes so 

that different departments and software tools can easily share and use 

the same data. 

9.   Transparency and Documentation: Clear records of how data is 

handled, such as policies and procedures, help everyone understand 

their roles and responsibilities. Transparency builds trust and ensures 

everyone is on the same page. 

10. Continuous Improvement: Data governance isn’t a one-time task. It 

should evolve and improve regularly based on feedback, new technology, 

and changing laws. Regular updates help organizations stay ready for 

future challenges. 
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REGULATORY GUIDELINES IN BFSI 

Banks and financial companies must follow important rules to keep the 

system safe, protect customers, and stop crime. Three key guidelines are: 

1. KYC – Know Your Customer  

KYC means banks must verify the identity of customers before opening an 

account or giving financial services (Fig. 1.8). 

 They check documents like Aadhaar, PAN Card, or Passport to confirm 

who you are. 

 It helps stop fraud, identity theft, and misuse of banking services. 

 Banks also update KYC details regularly to keep records correct. 

Example: If you open a bank account, the bank will ask for your ID proof, 

address proof, and photo. 

 

Fig. 1.8: Know your Customer 

2. Anti-Money Laundering (AML) 

AML rules help stop criminals from using banks to hide money earned 

through illegal means. (Fig. 1.9) 

 Banks monitor large or suspicious transactions (e.g., sudden huge cash 

deposits). 

 If something looks unusual, they must report it to government agencies 

like FIU-IND (Financial Intelligence Unit – India). 

 Employees are trained to spot suspicious activities and follow the law. 

Example: If someone tries to deposit ₹50 lakhs in cash without a clear 

reason, the bank investigates and reports it. 
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Fig. 1.9: Anti-Money Laundering 

3. Data Protection 

Banks handle sensitive customer information, so they must keep it private 

and secure. (Fig. 1.10) 

 They use strong security systems to protect data from hackers and 

misuse. 

 Customers’ personal and financial details should only be used with 

permission. 

 Following laws like the Indian Data Protection Act or GDPR (for global 

companies) builds customer trust. 

Example: Your bank details or personal information cannot be shared or 

used for marketing without your approval. 

 

Fig. 1.10: Data Protection 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

42 
 

These guidelines i.e. KYC, AML, and Data Protection which help ensure that 

banking is safe, fair, and trustworthy for everyone. 

ETHICS IN FINANCIAL DATA HANDLING 

Handling financial data means dealing with sensitive information like bank 

account numbers, transaction history, income details, and personal records. 

It is very important to handle this data with honesty, care, and responsibility. 

Below are the major points of Ethics in Financial Data Handling: 

 Protect Privacy: Always keep customer information private and never 

share it without permission. 

 Be Honest: Financial data should never be changed or misused for 

personal or company benefit. 

 Follow Rules: Handle data according to laws and company policies to 

avoid mistakes or legal issues. 

 Prevent Misuse: Do not use financial data to cheat, manipulate records, 

or mislead customers. 

 Build Trust: When data is handled ethically, customers trust banks and 

financial companies more. 

Example: If you work in a bank, you cannot look at someone’s account details 

out of curiosity or share that information with anyone. You must only use the 

data for work purposes and with proper permission. 

Ethical handling of financial data keeps customer trust, protects privacy, and 

ensures fairness in the financial system. 

PRACTICAL EXERCISE 

Activity 1: Group discussion on ethics in data usage. 

Materials Required: 

 Whiteboard/Flipchart and Markers 

 Small Slips/Sheets with Discussion Questions or Scenarios (optional) 

 Notebook and Pen  

 Timer/Stopwatch 

 Chart displaying key ethics principles (optional) 

Procedure: 

1. Divide the class into small groups of 4-6 students each. 

2. Give each group a situation or question to discuss, such as: 

 Is it okay to use customer data for marketing without permission? 

 What should you do if you see a co-worker sharing private data? 

 How can misuse of data affect customers? 

3. Each group discuss the topic among themselves. 
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4. Encourage everyone to share their thoughts and examples. 

5. One member from each group notes down the key points. 

6. Each group shares their discussion highlights with the class. 

7. Teacher adds additional points or corrects misconceptions. 

8. Summarize the importance of ethics in data usage. 

9.   Each student writes their learning or what they understood. 

10. Submit write up to the teacher.  

Activity 2: Identify and present risk areas and solutions for data privacy 

breach. 

Materials Required: 

 Whiteboard/Flipchart and Markers 

 Printed Handouts or Slips with Possible Risk Examples (optional) 

 Notebook and Pen  

 Chart showing Data Privacy Principles (optional) 

 Timer/Stopwatch 

Procedure: 

1. Divide the class into small groups of 3-5 students per group. 

2. Assign each group the task to think of possible risk areas for data privacy 

breaches in banks or financial institutions. 

3. Groups discuss and list at least 3 risk areas where data privacy could be 

compromised (e.g., weak passwords, phishing emails, unauthorized 

access). For each risk area, they suggest simple solutions or preventive 

steps. 

4. Each group presents their identified risk areas and solutions to the class. 

5. Teacher provides feedback and adds additional important points. 

6. Each student writes their learning or what they understood. 

7. Submit write up to the teacher.  

Activity 3: Create a Privacy Policy Poster. 

Materials Required: 

 Chart paper or A3 sheets 

 Markers, pens, crayons 

 Sample privacy policies  

Procedure: 

1. Divide class into small groups of 3–5 students per group. 

2. Assign each group the task of creating a fictional bank or mobile app. 
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3. Ask them to design a poster for that bank/app’s privacy policy. Their 

poster should include: 

 What personal data is collected (e.g., name, email, phone number, bank 

account details)? 

 Why the data is collected and how it is used? 

 Who can access the data (e.g., staff, partners, etc.)? 

 How users can manage their data (e.g., opt-out options, data deletion)? 

4. Once the posters are ready, each group presents their privacy policy to the 

class and explains the choices they made. 

5. Facilitate a short discussion comparing the posters and highlighting good 

practices in privacy policy design. 

6. Each student writes their learning or what they understood. 

7. Submit write up to the teacher.  

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. __________ ensures that customer information is kept safe from 

unauthorized access. 

2. Informed __________ must be taken before collecting or using someone’s 

personal data. 

3. Ethical practices in BFSI promote __________ and build customer trust. 

4. The law that protects digital personal data in India is called the 

__________ Act. 

5. Using sensitive customer data to exploit them is considered __________ 

behaviour. 

B. Multiple Choice Questions 

1. What is the main purpose of data privacy laws? 

a) To increase business profits 

b) To advertise customer data 

c) To protect individuals' personal information 

d) To share data freely with partners 

2. Which of the following is an example of unethical data handling? 

a) Asking for user consent 

b) Protecting customer data with encryption 

c) Selling user data without informing them 

d) Giving users access to their data 

3. What does KYC stand for in the BFSI sector? 

a) Know Your Code 

b) Know Your Customer 

c) Keep Your Card 
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d) Keep Your Consent 

4. Why is regulatory compliance important in financial institutions? 

a) To reduce employee workload 

b) To protect the environment 

c) To follow legal rules and protect customers 

d) To avoid paying taxes 

5. What is the first step in ethical data collection? 

a) Selling the data 

b) Encrypting the data 

c) Collecting as much data as possible 

d) Gaining informed consent from the customer 

C. State whether the following statements are True or False 

1. It is ethical to sell customer data without their knowledge. (True/False) 

2. The purpose of regulatory compliance is to ensure safety and legality. 

(True/False) 

3. All customer data collected must be necessary for the service.  

(True/False) 

4. Data privacy laws do not apply to mobile banking apps. –(True/False) 

5. Regular employee training is important for ethical data handling. – 

(True/False) 

D. Match the Column 

Column A Column B 

1 Data Privacy A Following legal requirements 

2 Ethics in Finance B Asking users for permission 

3 
Regulatory 

Compliance 
C Avoiding misuse of customer data 

4 Consent D 
Right to control personal 

information 

5 Confidentiality E Keeping customer data protected 

E. Short Answer Questions 

1. What is meant by data confidentiality? Why is it important in banking? 

2. How does informed consent protect users in the digital world? 

3. List any three ethical practices a financial institution should follow. 

4. What is the role of regulatory compliance in the BFSI sector? 

5. Why is it important for financial institutions to train employees on data 

ethics? 
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F. Long Answer Questions 

1. Describe the key principles of ethical data handling in the BFSI sector. 

2. Explain the importance of regulatory compliance with reference to 

Indian laws like KYC and the Digital Personal Data Protection Act. 

3. Discuss how financial institutions can balance customer service and 

data privacy. 

4. What steps can an organization take to ensure responsible use of 

customer data? 

G. Check Your Performance 

1. A customer reported suspicious activity on their bank account, but the 

bank failed to respond for two weeks, leading to continued 

unauthorized transactions.  

 Discuss the importance of responsibility and accountability in 

handling customer complaints related to data breaches.  

 Explain what ethical actions the bank should have taken, and how 

timely communication can protect both the customer and the bank’s 

reputation. 

2. After suffering a data breach, a bank delayed informing its customers, 

which led to multiple fraud cases and public backlash.  

 Evaluate the ethical and regulatory mistakes made by the bank in 

this scenario.  

 What immediate steps should a financial institution take after 

discovering a data breach?   
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MODULE 2: EXCEL FOR FINANCIAL DATA 

MANAGEMENT 

 

Let’s say your weekly pocket money is being tracked. The amounts spent on 

various items like snacks, transportation, and other items might be written 

down. But what if the total amount spent, or the category in where most 

money has been spent, needed to be quickly seen? This is where excel can be 

used.  

Excel is a tool that can be used to perform the daily tasks easily and efficiently.  

For example, grades and total marks scored by students can easily be tracked 

and seen. When working on a school project, tasks can be organized, timelines 

can be set and progress can be tracked easily. Simple calculations can be 

done, data can be arranged, and results can be shown, making everything 

easier.  

Microsoft Excel is a popular and powerful tool used worldwide to arrange, 

store, use and interpret information. Excel is a part of Microsoft Office 

software, which is widely used by students, workers and businesses around 

the world. Information is stored in the form of rows and columns which helps 

understand, store and represent data in different types of reports.  

An excel file can store different types of data, like, numbers, texts, words or 

dates. The data can be sorted, arranged and mathematical operations can be 

performed on them to interpret the data. Excel also helps to make data 

visually attractive through charts, tables and different types of graphs.  

Using excel regularly helps save time and organize data. Instead of papers 

and notebooks, excel enables users to store information in form of worksheets 

on a single workbook which helps to make quick decisions.  

This module is divided into four sessions. Session 1 deals with the basics of 

excel. An introduction to the excel interface will be given, showing how data 

can be entered, edited and saved. Session 2 covers basic formulas and in excel 

to perform simple calculations like adding numbers, finding averages and 

percentages. Session 3 focuses on data presentation and how to create basic 

chart using excel. Finally, Session 4 covers with the important lookup and 

logical functions which helps to find and organize information more easily.  



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

48 
 

SESSION 1: EXCEL INTERFACE AND BASIC OPERATIONS 

Excel is a software which is developed by Microsoft which was first launched 

in the year 1985 for Apple Macitosh followed by a release of Windows version 

in the year 1987. Excel has gone through many updates and versions during 

the years and is one of the most used software across the world which has 

features that makes the day-to-day tasks easier. Excel is used for data 

analysis, financial calculations and creating charts and reports.  

Excel is a software that uses spreadsheets to organize data which can be in 

any form like numbers, texts, dates or logical values. These data types 

influence how excel handles and interprets data, impacting calculations, 

formatting and more. 

EXCEL USER INTERFACE 

The Excel user interface is the part of Excel that displays and provides access 

to all the tools and features of the program. Understanding the interface plays 

an important role in using the features effectively and organizing data. The 

Excel user interface is designed to provide quick access to tools, enable data 

entry, and perform calculations in a clean and simple worksheet. 

To better understand Excel, it is important to learn about the different parts 

of the interface. The interface includes elements such as cells, rows, columns, 

workbook, worksheet, ribbon, and formula bar, which facilitate interaction 

with data and the use of various tools. 

Opening a new Excel Workbook 

Opening a workbook on the excel is a simple process, and it can be done in a 

few easy steps. The steps for opening a new workbook are as follows:  

Step 1: Open Excel – The excel icon on the desktop should be clicked or the 

word “Excel” can be searched in the start menu on windows.  

Step 2: Creating a new workbook 

 

Fig. 2.1: Creating new workbook 
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Once the excel program has been loaded, the option to open a blank workbook 

will be visible on the screen. This option can be selected to open a new 

workbook. (Fig. 2.1) 

Opening an existing excel workbook 

To open an already saved excel workbook the following steps has to be 

followed:  

Step 1: Open Excel – The excel icon on the desktop should be clicked or the 

word “Excel” can be searched in the start menu on windows.  

Step 2: Click on “Open Other Workbook” – On the bottom left hand side of 

the screen an option to “Open Other Workbook” is available. Upon selecting 

this a list of available files will be displayed and the desired file can be chosen 

from this list and opened. (Fig. 2.2 and 2.3) 

 

Fig. 2.2: Opening an existing excel workbook 

 

 

Fig. 2.3: Opening an existing excel workbook 
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Workbook and Worksheet 

A workbook in Excel is a file used to store work. Inside a workbook, multiple 

worksheets can be created. Each worksheet functions like a page where data 

can be entered and stored. A workbook can be compared to a notebook that 

contains many pages, with each page representing a worksheet. 

For example, imagine tracking your pocket money for every month. You can 

start keeping a track of your spending in a workbook called “Monthly 

Spending” and inside this workbook you can have several sheets like 

“January”, “February” for tracking your expenses on a monthly basis. Refer 

to the image below for better understanding.  

 

Fig. 2.4: Workbook 

Cell: A cell is the smallest part of an Excel worksheet. It is a small box that 

holds data. Data can be entered in the form of letters, numbers, dates, or 

formulas in a cell. Each Excel cell is like a blank space, ready to store any 

kind of data. Every cell has its own name or “address,” which is a combination 

of a column letter and a row number. 

 

Fig. 2.5: Cell 
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For example, refer Fig. 2.5, the first column is labelled “A” and the first row 

is labelled “1” and where the meet is called “A1”. The combination of the 

column letter is called a cell address. In this case, “A1” is the cell address for 

the first cell on you excel worksheet. Likewise, all the cells on excel worksheet 

will have a different cell address depending on the column and row number 

you can easily identify them with the help of the name box.  

Row: A row is a horizontal line of cells on the excel worksheet. Each row is 

identified by a number, which starts with 1 and increases as you move down 

the worksheet. Like cells, rows can also hold different types of data, including 

numbers, texts, dates and formulas.  

For example, let’s take the data of weekly expenses. Rows can be used to list 

the items that money was spent on each week.  

 

Fig. 2.6: Row 

Each row holds information about one item, and more rows can be added to 

track additional items. In this way, rows are used to organize and store 

individual pieces of information. 

An Excel worksheet can hold up to 1,048,576 rows, allowing large amounts 

of data to be managed and organized easily. With rows, data can be easily 

handled and analyzed, whether for school projects, personal budgets, or other 

tasks. 

Column: A column is a vertical line of cells in an Excel worksheet. Each 

column is identified by a letter, starting from A and continuing across the 

worksheet. Columns are used to organize data from top to bottom, making it 

easier to manage and read. An Excel worksheet can have columns ranging 

from A to XFD. 

For example, weekly expenses are being tracked. Columns are used to list 

the types of expenses and the amounts spent: 
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Fig. 2.7: Column 

In this table (Fig.2.7), Column A is used for Items, and Column B is used for 

Amount. The names of the items (such as snacks, transport, and others) are 

stored in Column A, and the amounts spent are stored in Column B. 

Each column is used to store one type of information, and more columns can 

be added to track additional categories, such as dates or payment methods. 

In this way, columns are used to separate and organize different types of data. 

An Excel worksheet can hold up to 16,384 columns, allowing large amounts 

of data to be easily separated and managed. With columns, data can be 

organized, sorted, and analysed efficiently, whether for school projects, 

personal budgets, or other tasks. 

Ribbon: The ribbon in excel is the main tool used to access the various 

features and commands of the software. It is located at the top of the excel 

window and divided into several tabs. The ribbon is designed to make excel 

easy to navigate, allowing users to quickly find and use the tools needed to 

perform various tasks. (Fig. 2.8)  

 

Fig. 2.8: Ribbon 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

53 
 

The Ribbon in Excel is the primary tool for entering and formatting data. 

Before performing specific tasks, it is essential to understand how Excel 

handles various data types such as numbers, text, dates, and logical values. 

Once data is entered, Excel provides a range of tools to edit and format it 

effectively. These include adjusting alignment, applying basic text formatting, 

and organizing data to ensure clarity. The Ribbon combines all the tools 

required for these tasks, making it convenient to apply changes and format 

data. Understanding how to navigate and use the tools on the Ribbon enables 

efficient work with Excel and helps keep data organized and presentable. 

The ribbon is divided into several tabs which makes it easier to access the 

various tools available. The main tools include (Fig. 2.9): 

 Home: Most commonly used tab. It includes basic commands for 

formatting and editing. 

 Insert: Used to add objects to worksheet. 

 Page Layout: Helps adjust the appearance of the worksheet for printing. 

 Formulas: Contains tools for working with formulas and functions. 

 Data: Used for working with large amounts of data. 

 Review: Tools for checking and protecting worksheet. 

 View: Adjusts how your worksheet looks on the screen. 

 File Tab: Also called Backstage View, this is the area used to manage files 

such as opening, saving, printing, and sharing. 

 

Fig. 2.9: Ribbon Tabs 

Each of these ribbon tabs has specific purpose and includes tools for 

performing specific tasks. Each tab contains several groups with different 

commands and icons. In some groups, not all commands are visible due to 

space limitations. However, options can be accessed by clicking the small icon 

with a downward arrow in the corner of the group. This icon is called the 

“Dialog Launcher”, and when clicked, it opens a new window showing 

additional commands for that group. 

DATA TYPES IN EXCEL 

Excel data types are the different kinds of values that can be entered in 

Microsoft Excel. The four main types of data are Text, Number, Logical 

(TRUE/FALSE), and Error. Each type is used differently, making it important 

to understand their functions. Data types may also change automatically 
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when data is imported or exported, so checking the data after transferring is 

essential. 

1. Number Data: Number data includes any type of numeric value, like small 

numbers, large numbers, money amounts, percentages, dates, and times. 

Remember: Some numbers represent quantity (like price), while others 

represent time or dates. The correct format must be used so that Excel 

interprets the data properly.   

Examples of Number Data: 

 Marks or percentages (e.g., 85%) 

 Total amount (e.g., ₹5000) 

 Dates (e.g., 01/07/2025) 

 Time (e.g., 10:30 AM) 

 Phone numbers 

2. Text Data: Text data includes words, letters, numbers treated as text, or 

symbols. Text cannot be used for calculations and is often applied for 

headings, labels, or descriptions.  

Examples of Text Data: 

 Names (e.g., “Shlok Kamane”) 

 Addresses 

 Labels like “Total Sales” or “Revenue” 

 Dates or numbers typed in text format 

Note: If Excel doesn’t recognize your entry, it may automatically treat it as 

text. 

3. Logical Data (TRUE or FALSE): Logical data means the value is either 

TRUE or FALSE. It is often used to test conditions and make decisions 

inside formulas. 

Examples of Logical Tests: 

a) Check if marks are greater than 50 → Result: TRUE or FALSE 

b) Use logical functions like: 

 AND: Checks if all conditions are TRUE 

 OR: Checks if at least one condition is TRUE 

 XOR: Exactly one condition should be TRUE 

 NOT: Reverses the condition (TRUE becomes FALSE, and vice versa) 

Example: =AND(A1>50, B1>50) → Returns TRUE if both values are above 

50. 
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4. Error Data: Sometimes, Excel shows an error message when something 

goes wrong. Errors indicate mistakes in formulas or data and help in 

identifying and correcting them. Common Error Messages in Excel are as: 

Error What it Means Example 

#NAME? 
Typo or missing quotes in 

formula 

=SUMM (A1:A5) instead of 

SUM 

#DIV/0! Dividing a number by zero =A1/0 

#REF! 
Invalid cell reference 

(deleted cells) 
Referring to a deleted cell 

#NUM! 
Wrong number or result too 

large 
Large calculation beyond limit 

#N/A 
Value not available or 

missing 
Lookup fails to find a value 

#VALUE! Wrong data type in formula 
Adding text to numbers by 

mistake 

#NULL! 
Incorrect cell range or 

missing separator 
Wrong range in a formula 

BASIC FORMATTING 

Formatting in Excel means changing the appearance of data to make it look 

neat, easy to read, and professional. In simple words, it involves modifying 

the appearance of cells to improve readability and visual appeal. This includes 

changing font styles, sizes, colours, alignments, and adding borders and fill 

colours. 

 

Fig. 2.10: Basic Formatting Options 

1. Font Formatting 

Font formatting provides options to change the appearance of text within 

a worksheet. This includes altering the font type, size, colour, and applying 
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formatting such as bold, italic, or underline. In other words, it changes the 

appearance of text (words or numbers) in an Excel worksheet. Font 

formatting makes data easier to read, visually appealing, and more 

professional. Below are the basic formatting options available in Excel: 

 

Feature Description Use Example 

Font Type 

Change the style 

of the letters or 

numbers. 

From the toolbar, 

select font (e.g., 

Arial, Calibri, Times 

New Roman). 

Use Calibri for 

simple look, Times 

New Roman for 

formal reports. 

Font Size 
Make the text 

bigger or smaller. 

Choose size number 

(e.g., 10, 12, 14, 18). 

Increase size to 

make headings 

stand out. 

Font Color 
Change the color 

of the text. 

Use the font color 

option (A with color 

underline). 

Use red for 

warnings, green 

for correct 

answers. 

Bold  

(Ctrl + B) 

Makes text thicker 

and darker to 

stand out. 

Click B icon or press 

Ctrl + B. 

Make titles bold: 

Student Marks 

Sheet 

Italic  

(Ctrl + I) 

Slants the text to 

the right for 

emphasis. 

Click I icon or press 

Ctrl + I. 

Italicize comments 

or instructions. 

Underline 

(Ctrl + U) 

Adds a line under 

the text. 

Click U icon or press 

Ctrl + U. 

Underline 

important points. 

Strikethrough 

Draws a line 

through the text 

to show deletion. 

Right-click > Format 

Cells > Font > 

Strikethrough. 

Use to mark 

incorrect values: 

Old Price 

Importance:  

 Makes the worksheet look neat and organized. 

 Highlights important information such as totals, headings, or warnings. 

 Helps readers understand the data quickly. 

Exercise: Open a blank Excel sheet and type the following in A1 to A4: 

 Student Name 

 Total Marks 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

57 
 

 Grade 

 Remarks 

Now: 

 Make “Student Name’ bold. 

 Make “Total Marks” italic. 

 Underline “Grade”. 

 Change the font colour of “Remarks” to blue. 

 Increase the font size of all headings to 14. 

2. Alignment  

Alignment means how text or numbers are positioned inside a cell. Good 

alignment makes Excel sheet neat, easy to read, and professional. 

The Alignment group allows to adjust the alignment of text within cells, 

such as aligning it to the left, center, or right. It also includes tools to 

control the text orientation and wrap text within a cell. The text in a cell to 

appear centered, the Center button in the Alignment group can be used. 

This will align the text in the middle of the cell, both horizontally and 

vertically. 

a) Horizontal Alignment (Left, Center, Right): Aligns the text or 

numbers left, center, or right inside the cell. 

Select the cell → Go to the Home tab → Click on Left, Center, or 

Right align icons 

Example: If you write “Total Marks” in a cell: 

 Left Align → Text sticks to the left side. 

 Center Align → Text stays in the center. 

 Right Align → Text moves to the right side. 

 

b) Vertical Alignment (Top, Middle, Bottom): Positions the text at the 

top, middle, or bottom of the cell (especially useful if the row height is 

large). 

Select the cell → Go to Home tab → Look for Vertical Alignment 

options (Top, Middle, Bottom) 

 

c) Wrap Text: If text is too long to fit in a cell, “Wrap Text” makes it appear 

on multiple lines within the same cell, ensuring that all content is 

visible. 

Select the cell → Click Wrap Text from the toolbar 
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Example: Without Wrap Text → Only part of the sentence shows. 

With Wrap Text → Entire sentence appears, even if it takes more 

lines. 

 

d) Indent: Adds space before the text inside the cell to make it look neat. 

Select the cell → Click Increase Indent icon from the toolbar 

 

e) Merge & Center: Combines multiple cells into one big cell and centers 

the content. It is commonly used for headings. 

Select the cells to merge → Click Merge & Center from the toolbar 

Example: To create a big title across columns A, B, and C: 

 Type “Student Performance Report” in A1 

 Select A1 to C1 

 Click Merge & Center → Now your title is centered 

across all three columns. 

 

f) Orientation (Text Rotation): Rotates or tilts the text inside a cell. It is 

useful for column headers when space is tight. 

Select the cell → Go to Orientation icon in the toolbar → Choose 

options like Angle Counter clockwise, Rotate Text Up, etc. 

Example: If your headers are taking too much space, rotate them 

diagonally to save space. 

3. Number Formatting 

Number Formatting changes how numbers look in your worksheet, 

without changing their actual value. It helps make data easier to read and 

understand. Number group contains tools for formatting numbers in 

various ways, including currency, percentage, decimal places, and more. 

This is particularly useful when needed to display data in a specific 

number format. 

 General (Default): This is the default format in Excel, where numbers 

appear exactly as typed. No special symbols or formatting are applied. 

 Number: Format numbers as currency, percentages, dates, times, 

fractions, scientific notation, etc. 

Select cells → Go to Home tab → Select Number format from the 

drop-down list 
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 Currency: Display numbers with currency symbols such as ₹, $, €, etc. 

and appropriate decimal places. It is used when dealing with money-

related data like prices, earnings, or expenses. 

Example: Type 5000 → It shows as ₹5,000.00 (if Indian Rupee is 

selected) 

 Percentage: Display numbers as percentages. In short, it converts 

numbers to percent format. Multiplies by 100 and adds % symbol. It 

always enters percentages as decimals if not formatting immediately. 

Example: Type 0.75 → It shows as 75%. 

   Type 1 → It shows as 100% 

 Date/Time: Format numbers to represent dates and times in various 

ways. It changes numbers to dates or time formats. Excel stores dates 

as numbers behind the scenes, but formats them as readable 

dates/times. 

Example:  

 Date Formats: Type 01/07/2025 → Shows as 01-Jul-2025 

(01/07/2025, 1-Jul-2025, July 1, 2025, etc.) 

 Time Formats: Type 9:30 → Shows as 9:30 AM (9:30 AM, 15:45 

(24-hour clock), etc. 

Exercise: Open Excel and type the following in column A: 

 5000 

 0.85 

 7500 

 01/01/2025 

Now, apply these formats: 

 Make 5000 appear as currency. 

 Make 0.85 show as a percentage. 

 Add commas to 7500. 

 Format 01/01/2025 as a date. 

4. Other Formatting Options 

These tools help make worksheet organized, attractive, and easier to read. 

 Borders: It adds lines around cells or groups of cells and helps separate 

different sections of worksheet. 
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Example: Put borders around a table of student marks to make it neat. 

Select the cells → Go to Home tab → Click on the Borders icon → 

Choose options like: 

 All Borders 

 Outside Borders 

 Thick Box Border 

 Fill Colour (Cell Shading): It adds background colour to cells to 

highlight them and makes important information stand out. 

Example: Use yellow fill colour for headers, or green for passed 

students. 

Select the cells → Click the Fill Colour icon (paint bucket) → Choose 

your colour 

 Cell Styles: Ready-made styles that quickly apply multiple formatting 

options (font colour, fill, borders) at once. It is useful for titles, headings, 

or emphasis. 

Select the cell → Go to Home tab → Click Cell Styles → Choose styles 

like: 

 Title 

 Heading 1 

 Good, Bad, Neutral 

 Input 

 Conditional Formatting: Conditional Formatting automatically 

changes the appearance (such as colour) of cells based on their values. 

It helps highlight important data, trends, or errors, making your 

worksheet easier to understand. 

Example: Automatically highlight marks below 40 in red. 

 Format Painter: It copies formatting from one cell to another quickly 

and saves time when the same style in multiple places. 

Example: You formatted one heading (bold, blue, 14 size) → Use 

Format Painter to apply that to other headings. 

1. Select the cell with the desired formatting. 

2. Click the Format Painter (paintbrush icon) in the toolbar. 
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3. Click on the cell or range where you want to apply the same 

formatting. 

Exercise: Open excel sheet and type following data (Fig. 2.11). 

 

Fig. 2.11: Sample data set 

Task to perform: 

 Add borders around the table 

 Fill the header row with yellow colour 

 Use Cell Style: Heading 1 for the header row 

 Use Format Painter to apply the same style to another heading 

elsewhere 

SAVING AND OPENING WORKBOOKS   

In Excel, file is called a Workbook, and each workbook can have many sheets 

(like pages in a book). It is important to know how to save your work and open 

existing files. 

To Save a New Workbook 

Following steps to be followed for to save a new workbook. 

Step 1: After the work has been completed, click on the File tab (top-left 

 corner). 

Step 2: From the options that appear, Save As should be selected. 

Step 3: Choose the location where the file should be saved must be chosen    

 (e.g., Computer, Desktop, Documents or another folder). 

Step 4: A name for the file must be entered in the File Name box.  

Step 5: Select the file type (Excel Workbook (*.xlsx) → Default format 

Step 6: Excel 97-2003 Workbook (*.xls) → For older versions) 

Step 7: Click Save 
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To Save an Existing Workbook: If the workbook has already been saved 

before, clicking on the Save button/icon in the Quick Access Toolbar (at the 

top-left) will save the changes made OR Press Ctrl + S on the keyboard. 

To Save in a Different Format: 

Step 1: If the workbook needs to be saved in a different format (for example, 

 as a PDF), the File tab should be clicked, and then Save As should  

 be selected. 

Step 2: The required file format can then be chosen from the available  

 options. 

It is recommended that work is saved frequently to prevent data from being 

lost. Excel also provides an AutoSave feature for cloud-based files, which 

saves work automatically as changes are made.  

Opening an Existing Workbook 

Following steps to be followed for opining an existing workbook. 

Step 1: Click the File tab. 

Step 2: Click Open. 

Step 3: Browse computer or recent files. 

Step 4: Select the workbook want to open. 

Step 5: Click Open. 

Did you know? 

Excel’s interface might seem simple at first, but it is packed with powerful 

tools to make your work easier and faster! For example, Excel can handle 

over a million rows and more than 16,000 columns in a single worksheet. 

That’s a lot of data! The Ribbon in Excel isn’t just a navigation tool; it is 

designed to save you time by grouping similar functions together, whether it’s 

formatting, inserting charts, or performing calculations. Also, did you know 

that you can freeze panes in Excel to keep your headers visible while scrolling 

through large datasets? This feature is incredibly helpful when you’re 

working with long lists. Excel even lets you format numbers as currency with 

just one click and automatically adjust cell sizes to fit the data. With these 

tools, you’re not just organizing data; you’re setting the foundation for 

efficient data analysis and presentation. 

PRACTICAL EXERCISE 

Activity 1: Familiarize with the Excel interface and its various components. 

Materials Required: 

 Computer or Laptop with Microsoft Excel installed 
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 Printed/Displayed diagram of the Excel interface (optional) 

 Practice worksheet (blank Excel workbook) 

Procedure: 

1. Gather in the computer lab. 

2. Open a new Excel workbook. 

 Launch Microsoft Excel on computer 

 Open a new blank workbook 

3. Identify Components: Students will explore and point out the following on 

their screen 

Component Description 

Title Bar Displays the name of the workbook (e.g., Book1). 

Ribbon 
Contains Tabs with groups of tools and 

commands. 

Tabs 
Home, Insert, Page Layout, Formulas, Data, 

Review, View, etc. 

Quick Access 

Toolbar 

Located at the top-left; contains Save, Undo, 

Redo buttons. 

Name Box Shows the cell address (e.g., A1). 

Formula Bar 
Displays the contents or formula of the selected 

cell. 

Worksheet Area 
Main area where you enter data (Rows & 

Columns). 

Columns Vertical sections labelled A, B, C, etc. 

Rows Horizontal sections labelled 1, 2, 3, etc. 

Cell Intersection of a Row and Column (e.g., B2). 

Sheet Tabs 
At the bottom, shows different sheets (Sheet1, 

Sheet2, etc.). 

4. Quick Tasks 

 Click on different Tabs (Home, Insert, etc.) to see the groups of tools. 

 Click inside different cells (like A1, B2) and notice the address in the 

Name Box. 
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 Type your name in a cell and check the Formula Bar. 

 Locate the Sheet Tab, rename Sheet1 to “Practice”. 

 Use the Save icon on the Quick Access Toolbar to save your workbook. 

5. Conduct discussion with the class considering the following questions. 

 What happens when you click different Tabs? 

 How can you tell which cell is currently active? 

 Where do you type or edit data for a cell? 

6. Ask 2-3 students to summarize the discussions. 

Activity 2: Practice data entry and basic formatting in Excel. 

Materials Required: 

 Computer or laptop with Microsoft Excel installed 

 Practice worksheet (Excel file or blank sheet) 

 Instructions sheet (can be printed or shown on screen) 

Procedure: 

1. Gather in the computer lab. 

2. Open a new Excel workbook. 

3. Enter the data as below: 

 In cell A1, type: Student Name 

 In cell B1, type: Math Marks 

 In cell C1, type: Science Marks 

 In cell D1, type: Total Marks 

 Enter the following student data: 

A2 B2 C2 

Arnav 78 85 

Bharati 88 90 

Varun 67 72 

Sonali 95 98 

4.  Basic formatting as below: 

 Bold the header row (A1 to D1) 

 Apply a yellow fill colour to the header row 

 Change the font size of the header row to 14 

 Center-align all the text in columns A to D 

 Add borders to the entire table (A1 to D5) 

 Format numbers in columns B, C, D as Number with 2 decimal places 

 Use Merge & Center on cells A6 to D6 to add a title: "Student 

Performance Report" 

5. Save the workbook with the name: BasicFormattingPractice.xlsx 
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6. Show to the teacher for review and feedback. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks:  

1. A cell in Excel is identified by the combination of a column ____________ 

and row ____________. 

2. A worksheet in Excel is similar to a ____________ of a notebook. 

3. The part of the Excel interface that helps to access all tools and features 

is called the ____________. 

4. Excel allows users to store different types of data like ____________, 

____________, ____________, and ____________. 

5. The Excel worksheet can hold up to ____________ rows and ____________ 

columns. 

B. Multiple Choice Questions (MCQs): 

1. What is the function of the "Ribbon" in Excel? 

a) It stores your data 

b) It allows access to Excel's features and commands 

c) It controls the printing settings 

d) It tracks changes in the worksheet 

2. What is the default format for numbers in Excel? 

a) Currency 

b) Text 

c) General 

d) Percentage 

3. Which part of the Excel interface helps you enter data or formulas into 

a cell? 

a) Formula Bar 

b) Ribbon 

c) Status Bar 

d) Workbook 

4. How can you quickly center-align text in Excel? 

a) Use the Insert Tab 

b) Use the Center button in the Alignment group 

c) Use the Font group 

d) Use the Page Layout Tab 

5. What does the "Find & Select" option under the Editing group do? 

a) It copies data 

b) It locates and selects specific data 

c) It sorts data alphabetically 
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d) It deletes selected data 

C. State whether the following statements are True or False 

1. Excel can only store numerical data and not text or dates. 

2. The “Page Layout” tab in Excel is primarily used for formatting and 

printing. 

3. In Excel, a workbook can contain multiple worksheets, but each 

worksheet can only hold 100 rows. 

4. The “Home” tab in Excel contains frequently used commands for 

formatting and editing. 

5. Excel allows users to track changes and add comments in a shared 

worksheet. 

D. Short Answer Questions 

1. What is a workbook in Excel, and how does it differ from a worksheet? 

2. Explain the difference between a row and a column in Excel. 

3. What is the purpose of the “Insert” tab in Excel? 

4. What is the function of the “Formula Bar” in Excel? 

5. Explain the significance of the “Cell” feature in Excel and how it 

contributes to organizing data. 

E. Long Answer Questions 

1. Explain the key features of the Excel interface, including the Ribbon, 

Formula Bar, and Worksheet, and describe how they help users in 

managing data. 

2. Describe how the “Cell” feature in Excel works and explain how cell 

references are used to perform calculations. 

3. Discuss the different components of the Excel interface, including the 

Ribbon, Formula Bar, and Worksheet, and explain how they contribute 

to data management and analysis. 

4. Describe how the “Ribbon” and the tools within the “Home” tab assist 

users in formatting, editing, and organizing data in Excel. 

F. Check Your Performance 

1. You have to do data formatting. 

Enter the Data: 

 Open a new Excel workbook. 

 Enter the following data into the worksheet: 

Item Amount Date 

Snacks 50 01/02/2023 

Transport 100 02/02/2023 

Books 200 03/02/2023 

Movies 150 04/02/2023 

Clothes 75 05/02/2023 

Format the Data: 
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 Bold the headers in row 1 (Item, Amount, Date). 

 Center-align the data in columns A, B, and C (for Item, Amount, 

Date). 

 Format the Amount column to display numbers as currency (₹). 

 Format the Date column to display dates in dd/mm/yyyy format. 

 Save the file as “Weekly Expenses”. 

2. In a new worksheet, enter the following: 

A1  B1 C1 

Name  Age Date of Birth 

Then, enter this data: 

A2 B2 C2 

Rahul 24 01-07-2000 

 What data types have you entered in columns A, B, and C? 

 Edit the value in B2 to 25. 

In the same worksheet: 

 Make the headers (Row 1) bold and increase font size to 14. 

 Apply a yellow fill colour to the header row. 

 Center-align the contents in columns A to C. 

 Change the number format of B2 to show 2 decimal places. 

 Format the Date of Birth (C2) to display as “01-Jul-2005”. 

Saving and Opening Workbooks 

 Save your workbook with the name “ExcelPractice1.xlsx” on your 

desktop 

  Close Excel 

 Re-open Excel and open the saved file 
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SESSION 2: BASIC FORMULAS AND FUNCTIONS IN 

EXCEL 

In Excel, formulas and functions are tools that make it easier to perform 

calculations and manage data. A formula is a way to do simple maths 

calculations within Excel, such as adding numbers, subtracting, multiplying, 

or dividing. For example, if you want to add up a list of numbers, you can 

write a formula in Excel to automatically calculate the total.  

Functions, on the other hand, are pre-made formulas that perform more 

complex calculations, like finding the average of a group of numbers, or 

identifying the highest or lowest value in a list. These functions are built into 

Excel, so you don’t have to write them from scratch. 

Using formulas and functions helps work faster, especially when dealing with 

large amounts of data. Instead of doing calculations by hand or manually 

typing in the results, Excel can perform the calculations automatically. 

INTRODUCTION TO EXCEL FORMULAS  

In Excel, formulas are used to perform calculations automatically on data. 

Formulas start with an equal sign (=) followed by the calculation to be 

perform. Excel uses operators to carry out basic mathematical operations. 

These operators are symbols that represent different types of calculations, 

such as addition, subtraction, multiplication, and division. 

The most commonly used operators in Excel are: 

For Addition (+), Subtraction (-), Multiplication (*) and for division (/).  

Below are examples of how these operators can be used, based on a simple 

dataset. 

Consider:  

Item Quantity Price 

Apple 5 20 

Banana 7 15 

Orange 4 30 

1. Addition (+) 

This operator is used to add two or more numbers together. 

For example, to add the quantities of apples, bananas, and oranges, the 

formula would be: 

=B2 + B3 + B4 
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This adds the values in cells B2, B3, and B4, giving the total quantity of 

fruits. 

Result: 5 (Apple) + 7 (Banana) + 4 (Orange) = 16 

2. Subtraction (-) 

The subtraction (-) operator is used to subtract one number from another. 

For example, to find the difference in price between apples and bananas, 

you can subtract the price of bananas from the price of apples. 

To subtract the price of bananas from the price of apples, the formula 

would be: =C2 - C3 

This subtracts the value in C3 (Banana Price) from C2 (Apple Price). 

Result: 20 (Apple) - 15 (Banana) = 5 

3. Multiplication (*) 

The multiplication (*) operator is used to multiply two numbers.  

For example, if you want to find the total cost of apples (where the 

quantity is multiplied by the price), you can use the multiplication 

operator. 

To calculate the total cost of apples, the formula would be: =B2 * C2 

This multiplies the quantity of apples (B2) by the price of apples (C2). 

Result: 5 (Quantity of Apple) * 20 (Price of Apple) = 100 

4. Division (/) 

The division (/) operator is used to divide one number by another.  

For example, if you want to find out the average price per fruit for apples, 

the formula would divide the total price of apples by the quantity. 

To calculate the average price per apple, the formula would be: =C2 / B2 

This divides the price of apples (C2) by the quantity of apples (B2). 

Result: 20 (Price of Apple) / 5 (Quantity of Apple) = 4 

EXCEL FUNCTIONS 

In Excel, functions are pre-built formulas that allow users to perform various 

calculations without needing to manually write out the calculations. 

Functions like SUM, AVERAGE, COUNT, MIN, and MAX are particularly 

helpful for analysing and managing data quickly and accurately. These basic 

functions can be used to calculate totals, averages, counts, and other 

important values. Understanding how to use these functions is essential when 

working with data, especially when handling multiple numbers or a large 

dataset. 
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Now explore how to use basic Excel functions using an example related to 

marks. Both basic arithmetic operators and functions like SUM, AVERAGE, 

COUNT, MIN, and MAX can be used to calculate total marks, average, 

percentage, and other important values for student data.  

Student Name English Maths Science History 

Arjun 70 75 80 85 

Disha 60 65 55 70 

Maya 90 85 80 95 

Deepak 55 50 60 45 

Vidya 80 85 90 100 

Method 1: Using Basic Operators for Calculations 

To calculate the total marks for each student, the + operator can be used. For 

Arjun, the total marks are calculated as follows: 

 Formula: =B2 + C2 + D2 + E2 

 This adds the marks from all four subjects for Student A. 

The total marks for Arjun would be: 70 + 75 + 80 + 85 = 310. 

To calculate the percentage, divide the total marks by the maximum possible 

marks (in this case, 400 for 4 subjects, each out of 100): 

 Formula: =F2 / 400 * 100 

 For Student A, the percentage is: (310 / 400) * 100 = 77.5% 

Method 2: Using Functions 

SUM: The SUM function is one of the most widely used functions in Excel. It 

adds up all the numbers in a selected range of cells. This is particularly useful 

for calculating the total of a set of values, such as total sales, total expenses, 

or total marks. 

In the given data set follow the steps below to find the total marks of Arjun 

using the sum function.  

Step 1: Formula: =SUM (B2:E2) 

Step 2: This formula automatically adds up the marks in cells B2 to E2 (the  

 1marks for all 4 subjects). The total marks for Arjun will be  

 automatically calculated as 310. 

Step 3: Double click on the corner of the cell and the same function  

 will be performed for all the other students.  
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AVERAGE: The AVERAGE function is used to calculate the average value of 

a range of numbers.  

Step 1: To calculate the average marks for each student: 

   Formula: =AVERAGE (B2:E2) 

Step 2:  This formula will calculate the average of the marks for Student A 

across all 4 subjects. The result for Student A would be:  

(70  75 + 80 + 85) / 4 = 77.5 

Step 3: Double click on the corner of the cell and the same function  

 will be performed for all the other students. 

COUNT: The COUNT function is used to count the number of cells in a range 

that contain numbers.  

To count how many subjects are being considered for each student: 

Step 1: Formula: =COUNT (B2:E2) 

Step 2: This formula will count how many numbers (marks) are in the range  

B2 to E2, which will return 4 (since there are 4 subjects for each 

student). 

Step 3:  Double click on the corner of the cell and the same function  

 will be performed for all the other students. 

MIN: The MIN function is used to find the smallest value in a range of 

numbers. To find the lowest marks scored by each student in the subjects: 

Step 1: Formula: =MIN (B2:E2) 

Step 2: For Student A, this function will find the lowest marks among the  

four subjects (70, 75, 80, and 85). The result will be 70, which is the 

minimum score. 

Step 3: Double click on the corner of the cell and the same function  

 will be performed for all the other students. 

MAX: The MAX function is used to find the largest value in a range of 

numbers.  

To find the highest marks scored by each student in any subject: 

Step 1: Formula: =MAX (B2:E2) 

Step 2: For Student A, this function will find the highest marks among the  

four subjects (70, 75, 80, and 85). The result will be 85, which is the 

highest score. 

Step 3: Double click on the corner of the cell and the same function  

 will be performed for all the other students. 
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AutoSum: The AutoSum function in Excel is used to quickly add up a range 

of numbers. Instead of manually typing the SUM function, AutoSum is used 

to automatically select and sum a group of numbers. This feature is especially 

helpful when large datasets are worked with, as it saves time and minimizes 

errors. 

In the following dataset, the AutoSum function can be used to calculate the 

total sales: 

Item Quantity Sold Price per Item Total Sales 

Apple 5 20 100 

Banana 7 15 105 

Orange 4 30 120 

Mango 6 25 150 

Grapes 8 18 144 

To calculate the total sales, the following steps should be followed: 

The cell below Grapes' total sales (for example, D7) should be selected. 

The AutoSum button (∑) in the Home tab should be clicked. 

Excel will automatically highlight the cells D2 to D6 (representing the total 

sales for each item). If the selection is correct, Press Enter key. 

Result: The sum of 100 + 105 + 120 + 150 + 144 will be automatically 

calculated, and the total sales will be shown as 619 in cell D7. 

CELL REFERENCES 

In Excel, cell references are used to point to specific cells or ranges of cells, 

allowing data from one part of the worksheet to be used in formulas and 

functions. These references are crucial for performing calculations and 

organizing data, as they help Excel understand where to get the information 

from. 

There are two types of cell references in Excel: relative and absolute. Each 

type behaves differently when formulas are copied or moved within the 

worksheet. 

The following data set is used to understand the different types of cell 

references.  

Item Price (₹) Quantity Tax Rate (%) 

Apple 50 2 10 

Banana 30 3 12 

Orange 40 1 15 
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1. Relative Cell Reference: A relative reference is the most common type of 

reference. When a formula is copied or moved, the reference changes based 

on the new location of the formula. This is helpful when performing 

calculations on different rows or columns without having to manually 

adjust the references. 

Calculate the total price for each item,  

Formula: = Price * Quantity 

this can be done using relative references, which change as the formula is 

copied down. 

Formula for Cell E2 (Apple): =B2 * C2 

Where,  

B2 is the Price (₹50 for Apple) 

C2 is the Quantity (2 for Apple) 

When this formula is copied down, Excel automatically adjusts the cell 

references for each row. 

Result for Apple (Fig. 2.12): = 50 * 2 = 100 

 

Fig. 2.12: Calculation Total Price using Cell Referencing 

2. Absolute Reference: An absolute reference locks a specific cell, so the 

reference does not change when the formula is copied or moved. Absolute 

references are created by adding dollar signs ($) before the column letter 

and row number (e.g., $A$1). 

Step 1: Using an Absolute Reference for a Fixed Tax Rate 

In this example, let’s assume that the Tax Rate (10% for Apple) is the same 

for all items and is stored in cell D1. This is a scenario where absolute 

references are useful, as the Tax Rate needs to remain fixed while copying 

the formula to other rows. 

The formula to calculate the Total Price with Tax is: 

= (Price * Quantity) + ((Price * Quantity) * Tax Rate / 100) 

However, in this case, the Tax Rate will always be in cell D1, so instead of 

using a relative reference to D2 (which would change when copied), use 

absolute references to keep the tax rate fixed. 
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Formula (Fig. 2.13): = (B2 * C2) + ((B2 * C2) * $D$1 / 100) 

Where, 

B2 is the Price 

C2 is the Quantity 

$D$1 is the absolute reference to the Tax Rate (fixed at D1) 

Explanation of Absolute Reference: 

$D$1 is an absolute reference because both the column (D) and the row 

(1) are locked with dollar signs ($). This means that when the formula is 

copied to other cells, the reference to D1 will stay fixed. 

 

Fig. 2.13: Absolute references to keep the tax rate fixed 

Step 2: Applying the Formula for All Items 

Let’s now apply the formula for each item in the dataset: 

For Apple (in E2):  

= (B2 * C2) + ((B2 * C2) * $D$1 / 100) 

This formula calculates the total price with tax for Apple using the price in 

B2, quantity in C2, and the tax rate in D1. 

Result: (50 * 2) + ((50 * 2) * 10 / 100) = 100 + 10 = 110 

For Banana (in E3), the same formula is used: 

= (B3 * C3) + ((B3 * C3) * $D$1 / 100) 

The formula automatically adjusts the Price and Quantity values for 

Banana, but the Tax Rate still refers to $D$1 (which remains fixed). 

Result: (30 * 3) + ((30 * 3) * 10 / 100) = 90 + 9 = 99 

For Orange (in E4), the formula is the same: 

= (B4 * C4) + ((B4 * C4) * $D$1 / 100) 

Result: (40 * 1) + ((40 * 1) * 10 / 100) = 40 + 4 = 44 

Step 3: Apply formula for all items (Fig. 2.14) 

Now that the formula is in E2 (for Apple), it can be dragged down to apply 

to E3 (Banana) and E4 (Orange). Even though the formula is copied to 
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other rows, the Tax Rate reference ($D$1) stays fixed and does not change, 

because it is an absolute reference. 

 

Fig. 2.14: Absolute references to calculate Total Price 

Did you know? 

Excel isn’t just for storing data, it can help to analyse, calculate, and organize 

it automatically! For example, the SUM function adds up numbers in a 

selected range in seconds, and the AVERAGE function can help you quickly 

find the mean of your data. Excel’s ability to work with relative and absolute 

references means, it can copy a formula across a range of cells and adjust 

the calculations dynamically. Absolute references lock specific data points, 

such as tax rates or constants, so they don’t change when it copies formulas. 

With these tools, it can save lots of time and no more manual calculations for 

large data sets! 

PRACTICAL EXERCISES  

Activity 1: Basic Arithmetic Operations and Functions. 

Materials Required: Computer or Laptop with Microsoft Excel installed 

Procedure: 

1. Enter the following in worksheet starting from Cell A1: 

 

 
2. Calculate Total Cost for Each Item 

In Cell D2, type: =B2 * C2, Press Enter. 

Copy the formula down for Banana and Orange (D3 and D4). 

3. Calculate Total Quantity and Total Sales 

In any empty cell (for example, B6), calculate total quantity: =SUM (B2:B4) 

In another empty cell (for example, D6), calculate total sales: =SUM 

(D2:D4) 

4. Calculate Average Price 

In any empty cell (for example, C6), calculate average price per item: 

=AVERAGE (C2:C4) 
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5. Save the workbook with the name: “Fruit Sales Analysis.xlsx” 

6. Show to the teacher for review and feedback. 

Activity 2: Using Functions for Student Data. 

Material Required: Computer or Laptop with Microsoft Excel installed 

Procedure: 

1. In a new Excel worksheet, type the following starting from Cell A1: 

 
2. Calculate Total Marks for Each Student 

In Cell F1, type Total Marks. 

In Cell F2, enter the formula: =SUM (B2:E2) 

Copy the formula down for all students (F3 to F6). 

3. Calculate Average Marks for Each Student 

In Cell G1, type Average Marks. 

In Cell G2, enter the formula: =AVERAGE (B2:E2) 

Copy the formula down for all students. 

4. Find the Highest and Lowest Marks 

In Cell H1, type Highest Marks. 

In Cell H2, enter the formula: =MAX (B2:E2) 

In Cell I1, type Lowest Marks. 

In Cell I2, enter the formula: =MIN(B2:E2) 

Copy both formulas down for all students. 

5. Count the Number of Subjects 

In Cell J1, type Subjects Count. 

In Cell J2, enter the formula: =COUNT (B2:E2) 

Copy the formula down for all students. 

6. Save the workbook with the name: "Student Marks Analysis.xlsx" 

7. Show to the teacher for review and feedback. 

 

 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

77 
 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. A formula in Excel begins with the ___________ sign. 

2. The formula =B2 + C2 uses the ___________ operator to add two values. 

3. The function ___________ in Excel is used to calculate the average of a 

set of numbers. 

4. The function ___________ is used to find the highest number in a range. 

5. The formula =B2 * C2 is an example of using the ___________ operator 

in Excel. 

B. Multiple Choice Questions (MCQs) 

1. Which of the following functions is used to add a range of numbers in 

Excel? 

a) AVERAGE 

b) SUM 

c) COUNT 

d) MIN 

2. What is the result of the formula =B2*C2 if B2 is 5 and C2 is 20? 

a) 25 

b) 100 

c) 15 

d) 10 

3. Which operator is used for division in Excel? 

a) * 

b) + 

c) - 

d) / 

4. What function will return the smallest value in a range of numbers? 

a) MIN 

b) MAX 

c) SUM 

d) COUNT 

5. Which of the following functions would you use to count the number of 

numerical values in a given range of cells? 

a) COUNTIF 

b) COUNT 

c) AVERAGE 

d) SUM 

C. State whether the following statements are True or False 

1. The formula =B2 + C2 adds the values in cells B2 and C2. 

2. The AVERAGE function in Excel calculates the total of numbers in a 

range. 

3. The MAX function finds the highest value in a set of numbers. 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

78 
 

4. You must manually write out calculations for the SUM function. 

5. The formula =COUNT (B2:B6) counts the number of non-empty cells in 

the range B2 to B6, regardless of the type of data. 

D. Short Answer Questions 

1. What is the purpose of the SUM function in Excel? 

2. Explain how the COUNT function works in Excel. 

3. How does the AVERAGE function in Excel calculate the mean? 

4. What is the difference between the MIN and MAX functions in Excel? 

5. How do you use Excel to multiply two numbers? Provide an example. 

6. What is the role of absolute cell references in Excel? 

E. Long Answer Questions 

1. Describe the difference between a formula and a function in Excel. How 

can both be used together to simplify calculations? Provide examples 

for both. 

2. How would you use Excel to analyse student performance using 

functions like SUM, AVERAGE, MAX, and MIN? Explain step-by-step 

how each function can help evaluate student data. 

3. What are the benefits of using relative and absolute references in Excel 

when performing calculations? Provide examples where each type of 

reference would be useful. 

4. Explain how Excel’s AutoSum feature works and provide an example 

where it can save time when working with large data sets. 

F. Check Your Performance 

1. In a blank worksheet, enter the following marks:  

 

Perform following basic functions and cell referencing. 

 In F1, type “Total Marks” and calculate total using: 

=SUM(B2:E2) 

 In G1, type “Average Marks” and use: =AVERAGE(B2:E2) 

 In H1, type “Highest” and use: =MAX(B2:E2) 

 In I1, type “Lowest” and use: =MIN(B2:E2) 

 In J1, type “Subjects Count” and use: =COUNT(B2:E2) 
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SESSION 3: DATA PRESENTATION AND BASIC CHARTS IN 

EXCEL 

In Excel, data is often presented in tables and rows, but sometimes the 

information can be difficult to understand just by looking at numbers alone. 

This is where charts are used. Charts are powerful tools in Excel that allow 

raw data to be transformed into a visual format, making it easier to interpret, 

compare, and analyse. By using charts, trends and patterns in the data can 

be seen more clearly, which helps decisions to be made more effectively. 

ADVANCED FORMATTING OPTIONS 

Excel offers many advanced formatting techniques that help make data easier 

to understand and look more professional. These techniques are used to 

highlight important information, make the data more readable, and improve 

the overall appearance of worksheets. The three most useful advanced 

formatting techniques are Conditional Formatting, Number Formatting, and 

Cell Styles. 

1. Conditional Formatting 

Conditional formatting is one of the most powerful tools of excel that helps 

apply formatting based on the conditions that are defined. It automatically 

adjusts the formatting when the values in the cells meet specific criteria, 

making it easier to spot trends, outliers and important data points.  

Excel offers several advanced options under Conditional Formatting, 

including Highlight Cells Rules, Top/Bottom Rules, Data Bars, Color 

Scales, and Icon Sets. 

It is necessary to understand all the components of conditional formatting 

by performing certain function on the data set given below:  

Item Price (₹) Quantity Total Sales (₹) 

Apple 50 2 100 

Banana 30 3 90 

Orange 40 1 40 

Mango 60 4 240 

Grapes 45 5 225 

a) Highlight Cell Rules: The Highlight Cells Rules allow specific cells 

to be highlighted when they meet certain conditions, such as when 
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values are greater than, less than, equal to, or between certain 

numbers. 

How to apply:  

 Select the range of cells you want to format. 

 Go to the Home tab and click on Conditional Formatting. 

 Choose Highlight Cells Rules and select an option like Greater 

Than, Less Than, or Between. 

 Set the value or range and choose the formatting style (e.g., 

background color.  

To highlight the Total Sales greater than ₹200 follow the following 

steps: 

Step 1: Select the cells in the Total Sales column (D2 to D6). 

Step 2: Click on Conditional Formatting → Highlight Cells Rules → 

Greater Than. 

Step 3: In the dialog box, enter 200 and choose a format (e.g., green 

fill). 

Step 4: The Mango and Grapes rows will be highlighted in green, 

since their sales are greater than ₹200. 

Also try: Highlight the Total Sales lesser than ₹100.  

b) Top/Bottom Rules: The Top/Bottom Rules allow highlighting the 

top or bottom values in a range. This feature is useful for quickly 

identifying the best or worst performers in a data set.  

How to Apply: 

 Select the range of cells to apply the formatting. 

 Go to Conditional Formatting → Top/Bottom Rules. 

 Choose an option like Top 10 Items, Bottom 10 Items, or Above 

Average. 

 Set the number or percentage and apply formatting. 

To highlight the top 2 sales, follow the following steps: 

Step 1: Step 1: Select the Total Sales column (D2 to D6). 

Step 2: Step 2: Click on Conditional Formatting → Top/Bottom 

Rules → Top 10 Items. 

Step 3: Step 3: Set the number to 2 and choose a format (e.g., bold 

text and yellow fill). 

Step 4: Step 4: The Mango and Grapes rows will be highlighted as 

the top 2 sales. 
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c) Data Bars: Data Bars are used to display a bar within each cell, 

representing the value relative to the rest of the cells. Larger values 

are shown with longer bars, making it easy to compare values 

visually. 

How to Apply: 

 Select the range of cells to be formatted. 

 Go to Conditional Formatting → Data Bars. 

 Choose a colour for the data bars (either gradient or solid fill). 

To add data bars to the Total Sales column, follow the steps below: 

Step 1: Select the cells in the Total Sales column (D2 to D6). 

Step 2: Click on Conditional Formatting → Data Bars. 

Step 3: Choose a colour (e.g., green fill with a gradient). 

Step 4: The cells will show a bar that represents the value of total 

sales, making it easy to see which items have the highest 

and lowest sales. 

d) Colour Scales: Colour Scales apply a colour gradient to the cells 

based on their values. A colour gradient is applied from one colour 

to another, with the colours representing the lowest, middle, and 

highest values. 

How to Apply: 

 Select the range of cells to apply the formatting. 

 Go to Conditional Formatting → Colour Scales. 

 Choose a colour scale, like green to red or blue to white. 

To apply a colour scale to show the performance of sales, follow the 

steps below:  

Step 1: Select the cells in the Total Sales column (D2 to D6). 

Step 2: Click on Conditional Formatting → Colour Scales → select 

a colour scale, like green to red. 

Step 3: Cells with higher sales (e.g., Mango and Grapes) will be 

shaded green, and cells with lower sales (e.g., Orange) will 

be shaded red. 

Step 4: This helps easily identify the best and worst performing 

sales figures visually. 

e) Icon Sets: Icon Sets are used to display icons (like arrows, traffic 

lights, stars, etc.) in cells based on the value in each cell. This is 

useful for showing trends like growth, decline, or status visually. 

How to Apply: 
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 Select the range of cells to apply the formatting. 

 Go to Conditional Formatting → Icon Sets. 

 Choose the preferred icon set (e.g., 3 Arrows, 3 Traffic Lights, 

etc.). 

To apply icons based on the sales values follow the following steps:  

Step 1: Select the cells in the Total Sales column (D2 to D6). 

Step 2: Click on Conditional Formatting → Icon Sets → select 3 

Arrows. 

Step 3: Excel will automatically assign green (up arrow) for high 

sales, yellow (side arrow) for moderate sales, and red (down 

arrow) for low sales. 

 Mango and Grapes would receive a green arrow (because 

their total sales are high). 

 Orange would receive a red arrow (since its sales are 

low). 

2. Number Formatting 

Number Formatting in Excel is used to control how numbers are displayed. 

Numbers can be shown in different formats such as Currency, Percentage, 

Decimal Numbers, Date, and more. Proper number formatting ensures 

that data is presented clearly and consistently, especially when dealing 

with financial data, percentages, or large datasets. 

Let’s explore the different types of number formats that can be applied to 

data, using the following example dataset: 

Item Price (₹) Quantity Total Sales (₹) 

Apple 50.45 2 100.9 

Banana 30.99 3 92.97 

Orange 40.5 1 40.5 

Mango 60.75 4 243 

Grapes 45.25 5 226.25 

Below are the different types of number formatting:  

a) Currency Formatting: Currency Formatting is used to display 

numbers with a currency symbol (like, $, €) and two decimal places. 

This format is commonly used when working with financial data such 

as prices, salaries, or sales figures. 
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Steps to apply currency in the data set: 

Step 1: Step 1: Select the range of cells containing the numbers (e.g., 

the Price (₹) or Total Sales (₹) columns). 

Step 2: Step 2: Go to the Home tab. 

Step 3: Step 3: In the Number group, click on the Currency button 

(₹) from the dropdown menu. 

Step 4: Step 4: The numbers will now be displayed with the currency 

symbol. 

Result: The Price (₹) and Total Sales (₹) columns will display values like 

₹50, ₹30, ₹40, ₹60, and ₹45 for prices, and ₹100, ₹90, ₹40, ₹240, and 

₹225 for total sales. 

b) Percentage Formatting: Percentage Formatting is used to display 

numbers as percentages, meaning the value is multiplied by 100 and 

followed by a percent sign (%). It is commonly used for calculating profit 

margins, growth rates, and other percentage-based data. 

Steps to Apply Percentage Formatting: 

Step 1: Select the range of cells that contains the decimal numbers 

or results to be converted into percentages (e.g., Tax Rate or 

Profit Margin). 

Step 2: Go to the Home tab 

Step 3: In the Number group, click on the Percentage button (%). 

Step 4: The number will be displayed as a percentage. 

c) Decimal Formatting: Decimal Formatting allows control over the 

number of decimal places displayed for a number. This is useful for 

presenting numbers with a specific level of precision, such as in 

measurements, calculations, or any other data requiring decimal 

values. 

Steps to Apply Decimal Formatting: 

Step 1: Select the range of cells containing numbers (e.g., Price (₹) or 

Total Sales (₹)). 

Step 2: Go to the Home tab. 

Step 3: In the Number group, click on the Increase Decimal or 

Decrease Decimal buttons to adjust the number of decimal 

places shown. 

Results: If the Total Sales (₹) for Apple is calculated as 100 but displayed 

with two decimal places, it will appear as 100.00. 

d) Date and Time Formatting: Date and Time Formatting is used to 

display dates and times in a variety of formats. This is helpful when 

tracking events, deadlines, or project timelines. 

Steps to Apply Date and Time Formatting: 
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Step 1: Select the cells that contain the date or time values. 

Step 2: Go to the Home tab. 

Step 3: In the Number group, choose Short Date or Long Date from the 

dropdown. 

Step 4: Excel will display the date in your chosen format. 

 Short Date will display as 03/12/2023. 

 Long Date will display as Monday, December 3, 2023. 

3. Cell Styles in Excel 

Cell Styles (Fig. 2.15) in Excel are predefined sets of formatting options 

(such as font, size, colour, and borders) that can be applied to cells quickly 

and consistently. They eliminate the need to manually adjust individual 

formatting settings like font style, color, or alignment. Cell Styles are 

helpful in maintaining a consistent look across a worksheet, especially 

when working with large datasets or creating professional reports. 

Excel provides many built-in cell styles, and users can also create custom 

styles to meet their specific needs. 

 

Fig. 2.15: Cell Styles 

Components of Cell Styles  

A Cell Style can include a combination of the following formatting options: 

 Font Type (e.g., bold, italic, underline) 

 Font Size (e.g., large or small) 

 Font Colour (e.g., red, green, blue) 

 Fill Colour (e.g., light yellow, blue, grey) 

 Borders (e.g., no borders, thick borders, dashed borders) 
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 Text Alignment (e.g., center, left-aligned, right-aligned) 

WORKING WITH TABLES  

Tables in Excel helps to organize data efficiently. When data is converted 

into a table, Excel offers many powerful features that allow you to sort, 

filter, and perform calculations easily. Tables provide a structured way to 

store data and make worksheets more readable and manageable. 

A Table in Excel is a range of data that is formatted to make it easier to 

manage. Tables automatically include special features such as: 

 Headers for each column 

 Automatic filtering and sorting options 

 Total Row for calculating sums, averages, and other statistical 

measures 

 The ability to automatically expand when new rows are added 

Following are the steps to create a table:  

Step 1: Select Your Data Range 

Select the data range to be converted into a table (including 

headers). For example, if you have data from A1 to D6, select this 

range. 

Step 2: Insert Table 

Go to the Insert tab on the ribbon and click on the Table button 

in the Tables group. 

Step 3: Confirm Table Range 

In the Create Table dialog box, Excel will automatically detect 

your data range. Make sure the box that says My table has 

headers is checked, so the top row of the selection is used as the 

headers for the columns. 

Step 4: Click OK 

After confirming the range, click OK. Data will now be converted 

into a table, and Excel will apply a default table style. 

Filter and Sort 

Data can be sorted and filtered to organize and analyse it more effectively. 

These features are useful when working with large datasets, as they help 

data to be arranged in a specific order or allow certain data to be viewed 

based on specific conditions. 

1. Sorting Data 
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Data can be sorted in ascending or descending order to make it easier 

to analyse. Sorting can be done alphabetically, numerically, or by date, 

depending on the type of data. 

Steps to be following to apply Sorting: 

A cell in the column to be sorted should be selected (e.g., Total Sales 

(₹)). 

Step 1: The Data tab on the ribbon should be clicked. 

Step 2: Either Sort A to Z (for ascending order) or Sort Z to A (for 

descending order) should be clicked. 

If the Total Sales (₹) column needs to be sorted in descending order to 

see the highest sales first: (Fig. 2.16) 

 Any cell in the Total Sales (₹) column (e.g., D2) should be selected. 

 The Data tab should be clicked, and Sort Z to A should be 

selected. 

 The data will be sorted so that the highest sales values, such as 

Mango (₹243.00), will appear at the top. 

 

Fig. 2.16: Sorting of Data (Before and After) 

2. Filtering Data 

Filtering allows data to be hidden temporarily based on specific criteria, 

so only relevant data can be viewed at any time. 

Steps to be following to apply Filtering: 

Step 1: The table should be selected. 

Step 2: The Data tab should be clicked, and the Filter button in 

the Sort and Filter group should be selected. 

Step 3: Once filtering is applied, drop-down arrows will appear 

next to each column header. 

Step 4: The drop-down arrow in the column to be filtered should 

be clicked. 
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Criteria for filtering should be selected (e.g., “greater than”, “less than”, 

or selecting specific items). 

If the Total Sales (₹) values need to be filtered to show only values 

greater than ₹100: (Fig. 2.17) 

 The drop-down arrow in the Total Sales (₹) column (e.g., D1) should 

be clicked. 

 Number Filters → Greater Than should be selected. 

 In the dialog box, 100 should be entered, and OK should be clicked. 

 Only the rows where Total Sales (₹) are greater than ₹100, such as 

Apple, Mango, and Grapes, will be displayed. Rows for Banana and 

Orange will be hidden. 

 

 

 

Fig. 2.17: Filtering of Data 

Filtering helps in focusing on specific data without permanently altering 

the worksheet. Multiple filters can be applied on different columns to 

narrow down the data further. 

BASIC CHART CREATION 

Charts in excel is a tool that allow data to be presented visually, making it 

easier to understand and analyse. Column, Bar, and Line charts are some of 

the most commonly used types of charts in Excel. These charts allow trends 
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to be identified, comparisons to be made, and data to be displayed in an easily 

understandable format. 

1. Column Chart: Column Charts are used to represent data with vertical 

bars. Each bar in the chart represents a data point, and the height of the 

bar shows the value of that data. Column charts are often used to compare 

data across categories. 

Steps to create column chart: 

Step 1: A range of data should be selected (for example, the Item and Total 

Sales (₹) columns). 

Step 2: The Insert tab on the ribbon should be clicked. 

Step 3: In the Charts group, the Column or Bar Chart button should be 

clicked. 

Step 4: From the dropdown, Clustered Column (the most common type of 

column chart) should be selected. 

Step 5: Excel will create a Column Chart based on the selected data. 

Example: Sales data for different items are shown as below, a Column 

Chart can be used to compare the sales for each item. 

Item Total Sales (₹) 

Apple 100.9 

Banana 92.97 

Orange 40.5 

Mango 243 

Grapes 226.25 

The chart shows vertical bars representing the total sales for each item, 

making it easy to compare sales values. (Fig. 2.18) 
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Fig. 2.18: Column Chart 

2. Bar Chart: Bar Charts are similar to Column Charts but use horizontal 

bars instead of vertical ones. They are useful when category names are 

long or when comparing items with large differences in values. 

Steps to create bar chart: 

Step 1: A range of data should be selected (for example, the Item and Total 

Sales (₹) columns). 

Step 2: The Insert tab on the ribbon should be clicked. 

Step 3: In the Charts group, the Column or Bar Chart button should be 

clicked. 

Step 4: From the dropdown, Clustered Bar should be selected. 

Step 5: Excel will create a Bar Chart based on the selected data. 

Use the data set of Column chart to create the bar chart.  

The bar chart shows (Fig. 2.19) the sales for each item he sales for each 

item will be represented by horizontal bars, making it easier to read when 

dealing with long item names or if there are significant differences in sales. 
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Fig. 2.19: 3-D Clustered Bar Chart 

3. Line Chart 

Line Charts are used to display trends over time. They are especially useful 

for showing how data changes across a continuous variable like months, 

years, or any other time-related data. 

Steps to create line chart:  

Step 1: A range of data should be selected (for example, the Month and 

Sales Data columns). 

Step 2: The Insert tab on the ribbon should be clicked. 

Step 3: In the Charts group, the Line Chart button should be clicked. 

Step 4: From the dropdown, the desired type of line chart, such as Line 

with Markers, should be selected. 

Step 5: Excel will create a Line Chart based on the selected data. 
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Fig. 2.20: Line Chart 

The line chart shows (Fig. 2.20) how sales changed over the five months. 

The months are placed on the X-axis, and the sales values on the Y-axis. 

A line is drawn to connect the data points, making it easy to visualize 

trends (e.g., sales increasing from January to May). 

Did you know? 

Excel’s charts aren’t just for making data pretty. They can help you 

understand and analyse data much faster! For example, the Conditional 

Formatting tool allows you to highlight key data points based on specific 

criteria, helping trends and outliers stand out. Excel also provides Data Bars, 

Colour Scales, and Icon Sets to visualize data’s performance. These tools help 

to identify areas needing attention or improvement. And when it comes to 

presenting data, charts like bar charts, line charts, and pie charts allow you 

to compare values and spot trends easily, so decision-making process is 

quicker and more effective! 

PRACTICAL EXERCISES  

Activity 1: Conditional Formatting. 

Material Required: Computer or Laptop with Microsoft Excel installed 

Procedure: 
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1. Enter the Following Data in an Excel worksheet starting from Cell A1, 

enter: 

Item Price (₹) Quantity Total Sales (₹) 

Apple 50 2 100 

Banana 30 3 90 

Orange 40 1 40 

Mango 60 4 240 

Grapes 45 5 225 

2. Apply Conditional Formatting as below: 

a) Highlight Total Sales Greater than ₹200: 

 Select cells D2 to D6 

 Go to Home tab → Conditional Formatting → Highlight Cells Rules 

→ Greater Than 

 Enter 200 

 Choose a formatting style (e.g., green fill) 

b) Highlight Total Sales Less than ₹100: 

 Select cells D2 to D6 

 Go to Conditional Formatting → Highlight Cells Rules → Less Than 

 Enter 100 

 Choose a formatting style (e.g., red fill) 

c) Apply Data Bars for Visual Effect: 

 Select cells D2 to D6 

 Go to Conditional Formatting → Data Bars 

 Choose a colour gradient or solid fill 

3. Save the file with the name as “Conditional Formatting Exercise.xlsx” 

4. Show to the teacher for review and feedback. 

Activity 2: Creating Basic Charts. 

Material Required: Computer or Laptop with Microsoft Excel installed 

Procedure: 

1. Enter the Following Data in an Excel worksheet starting from Cell A1, 

enter: 
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Item Total Sales (₹) 

Apple 100 

Banana 90 

Orange 40 

Mango 240 

Grapes 225 

2. Create Charts 

a) Bar Chart: 

 Select the range A1:B6 

 Go to the Insert tab 

 Click on Bar Chart → Choose Clustered Bar 

b) Pie Chart: 

 Select the range A1:B6 

 Go to the Insert tab 

 Click on Pie Chart → Choose 2-D Pie 

 Add a title to the chart: "Total Sales by Item" 

c) Line Chart: 

 Select the range A1:B6 

 Go to the Insert tab 

 Click on Line Chart → Choose Line with Markers 

3. Save the workbook with the name as “Basic Charts.xlsx” 

4. Show to the teacher for review and feedback. 

 CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. Conditional Formatting in Excel allows users to apply __________ based 

on cell values. 

2. A __________ chart is best used to compare data across categories with 

vertical bars. 

3. In a pie chart, each slice represents a __________ of the whole data. 

4. To show the best-performing items visually, you can use __________ 

formatting with data bars. 
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5. The __________ function in Excel is used to highlight cells based on 

specific conditions. 

 

B. Multiple Choice Questions (MCQs) 

1. Which of the following Excel charts is best for visualizing trends over 

time? 

a) Bar Chart 

b) Line Chart 

c) Pie Chart 

d) Column Chart 

2. What does the Top/Bottom Rules in conditional formatting allow you to 

do? 

a) Sort data 

b) Highlight cells based on a fixed range 

c) Identify the highest or lowest values in a range 

d) Display data bars 

3. Which of the following conditional formatting features helps in 

comparing data values visually with coloured bars? 

a) Icon Sets 

b) Data Bars 

c) Colour Scales 

d) Highlight Cells Rules 

4. Which of the following chart types should be used to compare the sales 

of different items in a single view? 

a) Pie Chart 

b) Line Chart 

c) Column Chart 

d) Bar Chart 

5. Which of the following chart types is best suited for comparing the 

proportions of different categories in relation to the whole? 

a) Line Chart 

b) Column Chart 

c) Pie Chart 

d) Bar Chart 

C. State whether the following statements are True or False 

1. Conditional formatting can only be applied to numbers in Excel. 

2. In Excel, pie charts are useful for showing proportions and percentages 

of a whole. 

3. You cannot apply multiple conditional formatting rules to a single cell 

in Excel. 

4. A line chart is suitable for comparing data points across categories. 

5. You can apply multiple conditional formatting rules to a single cell in 

excel, and all rules will be applied simultaneously.  
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D. Short Answer Questions 

1. What is conditional formatting in Excel, and how does it enhance data 

analysis? 

2. Why would you pie chart in Excel? 

3. What type of data is best represented using bar chart? 

4. How do data bars in excel help to visualize data? 

5. What is the purpose of using data bars in excel, and how do they 

enhance the visual representation of data?  

E. Long Answer Questions 

1. Explain the process of creating a pie chart in Excel. What type of data 

would you use a pie chart for, and how can it be customized for better 

clarity? 

2. Describe the role of advanced formatting techniques like Conditional 

Formatting, Cell Styles, and Number Formatting in improving the 

presentation of data in Excel. 

3. Explain how Conditional Formatting in Excel can be used to highlight 

key data points, and give examples of how it can be applied to improve 

data analysis. 

4. Describe the process of creating and customizing a column chart in 

Excel to compare sales data for different items. What are some key 

customization options you can apply to make the chart clearer and 

more visually appealing? 

F. Check your Performance 

1. You are provided with the following sales data. Enter the data in Excel 

and perform the tasks below: 

Product Category Units Sold Unit Price (₹) Total Sales (₹) 

Laptop Electronics 5 40,000   

Headphones Electronics 10 2,500   

Chair Furniture 15 3,000   

Desk Furniture 8 5,000   

Mouse Electronics 20 500   

a) Calculate Total Sales: In the "Total Sales" column, use the formula: 

=Units Sold * Unit Price. 

b) Apply Conditional Formatting: 

 Highlight Total Sales greater than ₹30,000 with green fill. 

 Highlight Total Sales less than ₹5,000 with red fill. 
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c) Use Number Formatting: Format Total Sales and Unit Price columns to 

show currency (₹) with 2 decimal places. 

d) Apply Cell Styles: Apply a bold header style to the top row. 

e) Convert Data to Table: Select the data range and insert a Table with 

filters. 

f) Sort and Filter Data: 

 Sort the table by Category in alphabetical order. 

 Filter to show only “Electronics” items. 

g) Create a Chart: 

 Insert a Column Chart showing Product vs. Total Sales. 

 Add a chart title: “Sales by Product”. 

h) Save the File as “Sales Data Analysis.xlsx”. 
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SESSION 4: LOOKUP AND LOGICAL FUNCTIONS 

Lookup and logical functions are tools that allow tasks to be completed more 

efficiently by searching for specific values and performing calculations based 

on certain conditions. 

Lookup Functions are used to search for a particular value within a range of 

data and return a related value. Large datasets are easier to work with when 

these functions are used. For example, VLOOKUP () can be used to search for 

data vertically in a table, while HLOOKUP () searches horizontally across rows. 

With Lookup Functions, searching for information is simplified, and values 

can be retrieved automatically, reducing the need for manual effort. This 

feature is particularly useful in tables, where quick access to related data is 

often required. 

Logical Functions are used to perform actions based on specific conditions. 

The most common logical function, IF (), is used to check if a condition is true 

or false. Depending on the result, a specific value will be returned for true or 

false conditions. More complex decisions can be made by combining logical 

functions like AND (), OR (), and NOT (). 

Logical functions allow decisions to be automated based on multiple 

conditions. They help to streamline calculations and make analysis more 

efficient by handling data-driven decisions without manual intervention. 

LOOKUP FUNCTIONS  

1. VLOOKUP 

The VLOOKUP function in Excel is one of the most widely used functions 

to search for a value in a table and return a corresponding value from 

another column. The name VLOOKUP stands for Vertical Lookup, as it 

searches for the value vertically in a table, looking down a column. 

This function is very useful when working with large datasets, where 

specific data points need to be found quickly. For example, you may have 

a list of students with their names and marks, and you want to find the 

marks of a particular student without manually searching through the 

entire list. 

The syntax of the VLOOKUP function is: 

=VLOOKUP (lookup value, table array, col_index_num, [range lookup]) 

 lookup value: The value that is searched for in the first column of the 

table. 

 table array: The range of cells that contains the data (including the 

column with the lookup value and the column with the data to return). 
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 col_index_num: The column number from which the matching value 

will be returned (the first column is 1, the second is 2, and so on). 

 [range lookup]: This is optional. TRUE (default) finds an approximate 

match, and FALSE finds an exact match. 

Let us understand with the help of an example, below is the data set of 

student marks.  

Sheet 1 

S.N. A B 

1 Student Name    Marks 

2 Jay 85 

3 Manisha 92 

4 Anant 78 

5 Bhim 65 

6 Lila 90 

Sheet 2 

S.N. A B 

1 Student Name    Marks 

2 Anant  

3 Bhim  

4 Jay  

5 Lila  

6 Manisha  

Now, the marks of the students have been fetched in Sheet2 by applying the 

VLOOKUP function. 

Steps to find out the marks of Anant using VLOOKUP: 

1. Lookup Value: The lookup_value will be Student Name e.g. “Anant” as we 

want to find his marks. 

2. Table Array: The table_array will be the range that includes the Student 

Name and Marks columns. In this case, the table range is A2:B6. 

3. Column Index Number: The col_index_num will be 2 because the Marks 

column is the second column in the table. 

4. Exact Match: Use FALSE for the range_lookup argument to ensure an 

exact match for Manisha’s name. 

Formula: =VLOOKUP (“Anant”, A2:B6, 2, FALSE) 

Once the formula is entered, Excel will look for Manisha in the Student 

Name column (Column A). When it finds Anant in A3, it will return the 

value in the second column (Column B), which is 78. 

Result: The value 92 (Manisha's marks) will be returned by the formula. 
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Now if we have to match the exact value (Marks of the Students) from another 

excel file of sheet, then follow steps as below: (Fig. 2.21) 

1. Lookup Value:  A2 or A2:A6 → Student name(s) to be matched 

2. Table Array:  Sheet1! $A$2: $B$6 → The range containing the names and 

marks from Sheet1 (Select the range and press F4 to fix it with $ signs) 

3. Column Index Number:  2 → Column number from the table array that 

has the marks 

4. Exact Match:  Enter FALSE or 0 to ensure only exact matches are 

returned 

=VLOOKUP (A2, Sheet1!$A$2:$B$6,2,0)  

 

Enter VLOOKUP formula 

 

Result after dragging Fill Handle 

Fig. 2.21: VLOOKUP 

Once the VLOOKUP formula in the first cell (e.g., B2) as shown in Fig. 2.21. 

Next Step: Use the Fill Handle 

 Place the cursor at the bottom-right corner of the cell with the formula 

(you will see a small “+” sign called the fill handle). 

Click and drag the fill handle down to cover all required rows (up to the 

last student's name). 

 This copies the VLOOKUP formula to all selected cells, fetching marks 

for all students in Sheet2 automatically. 

Importance of VLOOKUP: 

The VLOOKUP function is helpful for searching through large datasets to 

find related information quickly. Instead of manually searching for data, 

VLOOKUP allows it to be automated, saving both time and effort. It is 

particularly useful in tasks like: 

 Looking up prices in a product list. 

 Finding scores in an exam results sheet. 

 Searching for specific information in large records. 
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2. HLOOKUP 

The HLOOKUP function in Excel is similar to VLOOKUP, but it is used to 

search for a value in the first row of a table and return a corresponding 

value from another row. HLOOKUP stands for Horizontal Lookup because 

it searches for data horizontally across rows, rather than vertically down 

columns. 

This function is useful when data is organized horizontally, such as in 

situations where the headings are placed in the top row and the related 

data is stored in rows below. 

The syntax of the HLOOKUP function is: 

=HLOOKUP (lookup_value, table_array, row_index_num, [range_lookup]) 

 lookup_value: The value to be searched for in the first row of the table. 

 table_array: The range of cells containing the data (including the row 

with the lookup value and the row with the data to return). 

 row_index_num: The row number from which the corresponding value 

will be returned (the first row is 1, the second row is 2, and so on). 

 [range_lookup]: This is optional. TRUE (default) will return an 

approximate match, and FALSE will return an exact match. 

Let us understand the HLOOKUP function with the help of a simple 

example. Below is the dataset showing Monthly Sales, where the months 

are listed in the first row, and the corresponding sales figures are listed in 

the second row: 

January February March April May 

1500 2000 1800 2200 2100 

1300 2500 1900 2400 2200 

Now, to find the sales for March in the first row of the data. 

Steps to find out the sales for the month of march 

1. Lookup Value: The lookup_value will be “March”, as to find the sales 

for March. 

2. Table Array: The table_array will be the range that includes all the sales 

data, i.e., A1:E2. 

3. Row Index Number: The row_index_num will be 2 because the sales 

data is in the second row. 

4. Exact Match: FALSE will be used for the range_lookup to find an exact 

match for “March”. 
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HLOOKUP Formula: =HLOOKUP(“March”, A1:E2, 2, FALSE) 

Result: The formula will return 1800, which is the sales for March. 

Importance of HLOOKUP 

 The HLOOKUP function is helpful when data is arranged in rows rather 

than columns. This can be particularly useful in situations where: 

 Data headings are in the first row (e.g., months, years, or product 

names). 

 Use to search for a value in the first row and retrieve information from 

rows below it. 

 Useful for analysing large datasets with horizontal data, where 

automated searches save time. 

LOGICAL FUNCTIONS  

Logical Functions in Excel are used to test conditions and return results 

based on whether those conditions are true or false. These functions are 

essential when it is needed to make decisions automatically based on specific 

criteria. By using logical functions, the analysis can be simplified, and data-

driven decisions can be automated. 

The most commonly used logical functions in Excel are IF (), AND (), OR (), 

and NOT (). These functions help to test one or more conditions and perform 

actions based on the results. 

1. IF () Function 

The IF () function is the most commonly used logical function. It checks if 

a condition is true or false, and depending on the result, it returns one 

value if true and another value if false. 

Syntax of the IF () function: 

=IF (logical_test, value_if_true, value_if_false) 

 logical_test: The condition to be tested (e.g., checking if a number 

is greater than 100). 

 value_if_true: The value returned if the condition is true. 

 value_if_false: The value returned if the condition is false. 

Example: Imagine a student marks dataset. You want to check if a student 

has passed or failed based on their marks. 

Student Name Marks 

Jay 85 
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Manisha 55 

Anant 45 

If the passing marks are 50, the following IF function can be used to check 

whether the student has passed or failed: 

=IF(B2 >= 50, “Pass”, “Fail”) 

This function checks if the marks in cell B2 are greater than or equal to 

50. If true, it returns “Pass”; if false, it returns “Fail” (Fig. 2.22).  

 

Enter IF Function 

 

Result after dragging of Fill handle 

Fig. 2.22: IF Function 

2. AND () Function 

The AND () function checks if multiple conditions are true. It returns TRUE 

only if all conditions are true; otherwise, it returns FALSE. 

Syntax of the AND() function: 

=AND(condition1, condition2, ...) 

 condition1, condition2, ...: The conditions to be tested (e.g., 

checking if a value is between two numbers). 

Example: Imagine you want to check if a student’s marks are greater than 

50 and if they have completed all assignments. Assume “Yes” means 

assignments are completed, and “No” means assignments are not 

completed. 
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Student Name Marks 
Assignments 

Completed 

Jay 85 Yes 

Manisha 55 No 

Anant 45 Yes 

To check if a student has both passed and completed assignments, use the 

following AND function: (Fig. 2.23) 

=AND(B2 > 50, C2 = "Yes") 

 

Fig. 2.23: AND () Function 

This checks whether the marks are greater than 50 and if the Assignments 

Completed cell is "Yes". 

3. OR () Function 

The OR () function is similar to the AND () function, but it returns TRUE if 

any of the conditions are true. If all conditions are false, it returns FALSE. 

Syntax of the OR () function: 

=OR (condition1, condition2, ...) 

condition1, condition2, ...: The conditions to be tested (e.g., checking if 

a value is either greater than or less than a certain number). 

Example: If a student has either marked greater than 60 or has completed 

all assignments, they should be considered eligible. 

Student Name Marks 
Assignments 

Completed 

Jay 85 Yes 

Manisha 55 No 

Anant 45 Yes 
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To check if a student is eligible using OR: (Fig. 2.24) 

=OR (B2 > 60, C2 = “Yes”) 

 

Fig. 2.24: OR () Function 

This formula checks if the marks are greater than 60 or if the Assignments 

Completed cell is “Yes”. 

4. NOT () Function 

The NOT () function is used to reverse the result of a logical function. If a 

condition is TRUE, NOT () will return FALSE, and if the condition is FALSE, 

it will return TRUE. 

=NOT (condition) 

condition: The condition to be tested. 

Example: If you want to check if a student has not passed (marks less 

than 50), you can use the NOT () function. 

Student Name Marks 

Jay 85 

Manisha 45 

Anant 60 

To check if a student has not passed: 

=NOT (B2 >= 50) 

This formula will return TRUE if the marks are less than 50 (indicating a 

failure) and FALSE if the marks are 50 or above (indicating a pass). 
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Enter NOT formula 

 

Result after dragging fill handle 

Fig. 2.25: NOT () Function 

COMBINING FUNCTIONS IN FORMULAS 

In Excel, functions are incredibly powerful tools for performing specific tasks, 

such as calculations or logical tests. When different functions are combined 

in a single formula, more complex calculations can be performed, enabling 

users to analyse data more effectively. 

Combining functions in formulas is useful when multiple conditions need to 

be checked or multiple operations need to be performed on the data. By 

combining functions, users can solve problems that require more than one 

task to be done in a single step. 

Combining functions allows for: 

 More complex calculations: Multiple steps can be included in a single 

formula. 

 Conditional logic: Multiple conditions can be checked at once. 

 Automated decision-making: If certain conditions are met, specific 

actions or calculations can be performed automatically. 

Functions can be combined by using one function inside another. The 

function inside the parentheses of another function is often referred to as a 

nested function. 

For example: 
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 The IF () function can be used with other functions like SUM () or AVERAGE 

() to make decisions based on the results of these functions. 

 The AND () or OR () functions can be combined with the IF () function to 

evaluate multiple conditions. 

1. Combining IF () with SUM ()  

The IF () function can be combined with SUM () to apply conditions to the 

sum of a range of numbers. 

Example: Let’s say you want to calculate the total sales of a product, but 

only if the quantity sold is greater than 10. If the condition is true, the total 

sales should be calculated; otherwise, the result should show 0. 

Product Price (₹) Quantity Sold 

Apple 50 12 

Banana 30 8 

Orange 40 15 

To calculate Total Sales (₹) only if the Quantity Sold is greater than 10, the 

following combined formula can be used: (Fig. 2.26) 

=IF (C2 > 10, SUM (B2 * C2), 0) 

This formula checks if the quantity sold is greater than 10 (in C2). If TRUE, 

it multiplies the Price (₹) (in B2) by Quantity Sold (C2). If FALSE, it returns 

0. 

 

Enter Formula 
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Result after dragging fill handle 

Fig. 2.26: Combining IF () with SUM () 

2. Combining IF () with AND () 

The AND () function can be used inside the IF () function to check multiple 

conditions. 

Example: Suppose you want to give a bonus to employees only if they have 

worked more than 100 hours and have a performance rating greater than 

4. 

Employee Name Hours Worked Performance Rating 

Jay 120 5 

Manisha 95 4 

Anant 110 3 

To check both conditions, the following combined formula can be used: 

(Fig. 2.27) 

=IF(AND(A2>100, B2>4),” Yes”, “No”) 

This formula checks if both conditions are TRUE: if the Hours Worked (in 

B2) is greater than 100, and the Performance Rating (in C2) is greater than 

4. If both conditions are met, it returns “Yes”; otherwise, it returns “No’. 

 

Enter Formula 
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Result after dragging fill handle 

Fig. 2.27: Combining IF () with AND () 

3. Combining AVERAGE () with IF () 

Sometimes, you may need to calculate the average of values based on a 

condition. This can be done by combining the AVERAGE () function with 

the IF () function. 

Example: Let’s say you want to calculate the average sales only for 

products with sales greater than ₹500. 

Product Sales (₹) 

Apple 600 

Banana 240 

Orange 600 

Mango 150 

Grapes 750 

To calculate the average sales for products with sales greater than ₹500, 

the following combined formula can be used: (Fig. 2.28) 

=AVERAGEIF (B2:B6, ">500") 

This formula calculates the average of all values in the Sales (₹) column 

that are greater than 500. 

 

Enter Formula 

 

Result 

Fig. 2.28: Combining AVERAGE () with IF () 
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Did you know? 

Excel’s VLOOKUP and HLOOKUP functions are like your personal search 

assistant! They help you quickly find a piece of data in large tables without 

scrolling or manually searching. And with logical functions like IF, AND, and 

OR, Excel can make decisions for you based on certain conditions, saving you 

time and reducing errors. Whether you are checking if a student passed or 

calculating bonuses based on hours worked, these functions can automate 

tasks and make data management much easier. 

PRACTICAL EXERCISES  

Activity 1: Perform VLOOKUP and HLOOKUP to retrieve data from tables.  

Materials Required: 

 Computer or Laptop with Microsoft Excel installed 

 Sample data for VLOOKUP and HLOOKUP exercises 

Procedure: 

Part A: VLOOKUP 

1. Enter the following Data in an Excel Sheet 1 starting from Cell A1: 

Student Marks 

Arjun 85 

Disha 78 

Maya 92 

Deepak 65 

Vidya 88 

2. Enter the following Data in an Excel Sheet 2 starting from Cell A1: 

Student Marks 

Arjun  

Disha  

Maya  

Deepak  

Vidya  
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3. Retrieve Marks of Students in Excel Sheet 2 using VLOOKUP. 

 Apply VLOOKUP Formula in B2 of Sheet 2 

 Drag the fill handle down to apply the formula for all students and fetch 

their marks 

Part B: HLOOKUP 

4. Enter the following data in the same or new sheet: 

A1 B1 C1 D1 E1 

Month Jan Feb Mar Apr 

Sales (₹) 1500 2000 1800 2200 

5. Apply HLOOKUP Formula in any empty cell to get March sales. 

5. Save the file with the name as “Lookup Function.xlsx” 

6. Show to the teacher for review and feedback. 

Activity 2: Perform Logical Functions. 

Materials Required: Computer or Laptop with Microsoft Excel installed 

Procedure: 

1. Enter the following Data in an Excel Sheet starting from Cell A1: 

Student 

Name 
Marks 

Assignment 

Completed 

Rahul 72 Yes 

Sneha 48 No 

Kunal 65 Yes 

Priya 55 No 

Isha 40 Yes 

2. Use the following logical functions: 

 IF: Check if the marks are greater than or equal to 50 to determine if 

the student has passed. 

 Formula: =IF (B2 >= 50, “Pass”, “Fail”) 

 AND: Check if the student has passed and completed the assignment. 

 Formula: =AND (B2 >= 50, C2 = “Yes” 

 OR: Check if the student has either passed or completed the 

assignment. 

 Formula: =OR (B2 >= 50, C2 = “Yes”) 

3. Save the File as “Logical Functions Example.xlsx”. 
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4. Show to the teacher for review and feedback. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. The VLOOKUP function searches for a value __________ in the first 

column of a table. 

2. The IF function returns one value if a condition is __________ and 

another value if it is __________. 

3. HLOOKUP stands for __________ Lookup, which searches for data 

__________ across rows. 

4. The AND function returns TRUE if __________ conditions are met. 

5. Logical functions in Excel can be used to perform actions based on 

__________ conditions. 

B. Multiple Choice Questions (MCQs) 

1. What is the purpose of the VLOOKUP function in Excel? 

a) To search for a value horizontally across rows 

b) To search for a value vertically in a table and return a corresponding 

value 

c) To calculate the sum of a range of numbers 

d) To check if a condition is true or false 

2. What does the IF () function do in Excel? 

a) It adds numbers 

b) It searches for data in a table 

c) It combines multiple conditions 

d) It checks if a condition is true or false and returns one value if true, 

another if false 

3. Which of the following functions checks if all given conditions are true? 

a) IF () 

b) AND () 

c) OR () 

d) NOT () 

4. In the formula =HLOOKUP ("March", A1:E2, 2, FALSE), what does the 

number 2 represent? 

a) The row index number from which the corresponding value will be 

returned 

b) The row number where "March" is located 

c) The lookup values 

d) D) The table arrays 

5. Which of the following Excel functions is used to search for a value 

horizontally across rows? 

a) IF 

b) SUM 

c) VLOOKUP 
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d) HLOOKUP 

C. State whether the following statements are true or false:  

1. The VLOOKUP function can only return values from the first column in 

the table. 

2. The HLOOKUP function is used to search data vertically across 

columns. 

3. The AND function returns TRUE if at least one condition is met. 

4. The IF function can be used to check for multiple conditions by 

combining it with AND or OR functions. 

5. The VLOOKUP function can return approximate matches by using 

TRUE for the range_lookup argument. 

D. Short Answer Questions 

1. What is the main purpose of the VLOOKUP function in Excel? 

2. Explain the difference between VLOOKUP and HLOOKUP in Excel. 

3. How does the IF function work in Excel? 

4. What is the use of the AND function in Excel? 

5. What does the NOT function do in Excel? 

E. Long Answer Questions 

1. Describe how the VLOOKUP function works, and explain how it can be 

used in large datasets. Provide an example of a situation where it would 

be beneficial. 

2. How can the HLOOKUP function be used to retrieve data from 

horizontal tables? Provide an example where this function would be 

more effective than VLOOKUP. 

3. Describe how combining logical functions like IF (), AND (), OR (), and 

NOT () can be helpful in decision-making tasks within Excel. Provide a 

scenario where multiple conditions need to be evaluated to make a 

decision. 

4. Explain how you would use the AND() and OR() functions in Excel. 

Provide a practical example of how these functions can be combined 

with the IF () function. 

F. Check your Performance 

1. You are managing student performance records. Enter the following 

data in Excel and perform the steps below: 

Student Name Marks Assignment Completed 

Riya 78 Yes 

Amit 45 No 
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Sneha 60 Yes 

Karan 52 No 

Neha 85 Yes 

Additional Data for VLOOKUP (Sheet2 or different area of same sheet): 

Student Grade 

Riya B 

Amit D 

Sneha C 

Karan C 

Neha A 

Perform the following: 

a)  Fetch the Grade for each student using VLOOKUP 

b) In a new column, check if the student has passed (Marks ≥ 50) using 

Logical IF Function 

c) Check if the student has passed and completed assignments using 

AND Function (Combined Check) 

d) In another column, display “Eligible” if the student has passed or 

completed assignments, else “Not Eligible” using OR Function with 

IF (Combined Example).  
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MODULE 3: DATA ORGANIZATION AND MIS REPORT 

In today’s data-driven world, organizing and presenting information in a clear, 

structured manner is essential for effective decision-making. Whether in 

business, education, or personal tasks, poorly managed data can lead to 

errors and confusion. Microsoft Excel offers powerful tools to help users 

organize, analyze, and present data accurately and efficiently. One key 

application is the preparation of MIS (Management Information System) 

Reports, which transform raw data into meaningful information for daily 

operations or strategic planning. 

This module focuses on building essential skills to handle data professionally. 

Learners will gain practical experience in creating structured tables, applying 

data validation, using advanced aggregate functions, and developing clear 

MIS reports supported by charts and pivot tables.  

Further this module is divided into four sessions. Session 1 deals with 

organizing raw data into structured tables, applying validation rules to ensure 

accuracy, and exploring how to import and export data between formats like 

CSV and TXT.  

Session 2 focuses on using aggregate functions such as SUMIF, COUNTIF, 

AVERAGEIF and their multiple-criteria versions to derive meaningful insights 

from data, supporting better analysis and decision-making.  

Session 3 introduces the concept and importance of MIS Reports, covering 

different report types (daily, weekly, monthly, etc.), key elements of an 

effective report, and structured report formats for clear presentation.  

Session 4 enables learners to use Pivot Tables and Charts to summarize, 

analyse, and visually present large datasets. Students will apply filters, 

slicers, and pivot visuals to develop interactive and informative MIS reports. 
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SESSION 1: DATA ORGANIZATION AND VALIDATION 

In Excel, Data Organization refers to the process of arranging and 

structuring information so that it is easy to understand, manage, and analyse. 

Data Validation is used to ensure that only correct and accurate information 

is entered into the worksheet by applying specific rules to maintain 

consistency and proper formatting. 

When dealing with large amounts of data, working with unorganized or 

inaccurate information can cause errors and confusion. Proper organization 

and the use of data validation help maintain accuracy, reduce mistakes, and 

make the information reliable for effective decision-making. 

Suppose you are recording the names of cities in India for a project. However, 

some of the city names have been entered incorrectly due to spelling mistakes. 

For example, consider the following list of cities with errors in the spelling: 

City Name 

Mumbai 

Banglore 

Delih 

Kolkatta 

Bhopal 

In this example: 

“Banglore” is a misspelling of “Bangalore”. 

“Delih” should be “Delhi”. 

“Kolkatta” should be “Kolkata”. 

These errors could cause problems when you try to search or analyse the 

data. For example, when you want to look up all the records for Delhi, the 

misspelled version Delhi will not match, leading to missing data. 

These errors can cause problems when searching or analysing data. For 

example, when looking up all records for Delhi, a misspelled version such as 

“Delih” will not match, resulting in missing data. 

With data validation, you can ensure that only the correct city names are 

entered. 

Follow the steps below to apply data validation:  

Step 1: Select the City Name column where data will be entered. 

Step 2: Go to the Data tab in Excel and click Data Validation. 

Step 3: In the Data Validation dialog box, select List under Allow. 

Step 4: In the Source box, select the range containing the valid city names 

(e.g., A2:A6). 
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Result: Now, only the names from the valid list can be entered. If someone 

tries to enter a misspelled name like “Banglore” or “Delih”, Excel will show an 

error message, asking the user to select a valid name from the list. 

PRINCIPLES OF DATA ORGANIZATION 

Data Organization refers to the process of arranging the data in an organized 

manner which can be easily understood, accessed and analysed. When raw 

data is collected, it is rarely in a format which can be understood easily. 

Organized data avoids errors, saves time and enables faster decision making.  

The following are the key principles of data organization that ensures data is 

structured accurately: 

1. Clarity: Clarity in data organization means that the data is easy to read 

and understand. Every column and row should have clear headings that 

describe the type of data it stores. This helps anyone looking at the data to 

immediately understand what information is being presented. 

For example, consider a table for tracking monthly expenses: 

Expense Amount Date Payment Method 

Rent 10000 01/05/2022 Cash 

Groceries 2000 03/05/2022 Card 

Utilities 1500 05/05/2022 Cash 

Petrol 800 06/05/2022 Debit 

The headings in this table, Expense, Amount, Date, and Payment Method 

are clear and describe exactly what data is in each column. This clarity 

makes it easier to understand the dataset. As it is easy to see how much 

was spent on Rent and how it was paid. 

2. Consistency: Consistency ensures that similar types of data are placed in 

the same column, and that each row represents a single record. It’s 

important to make sure the same format is used for all data entries. 

Consider the same table given above, the amount column has numbers 

only, the date column has consistent data follows the same format 

throughout i.e., DD/MM/YYYY. This consistency ensures that operations 

like summing totals or filtering by payment method can be done without 

issues. 

3. Structure: Structure refers to the arrangement of data into rows and 

columns. In Excel, each row should represent one record, and each column 

should represent one characteristic of that record. 

In the above table, each row represents one transaction. Each column has 

a specific characteristic i.e. Expense, Amount, Date, and Payment Method. 
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This structure makes it easy to perform operations like sorting by Date or 

calculating the total amount spent using the SUM () function. 

4. Simplicity: Data should be kept as simple as possible. Avoid adding 

unnecessary complexity or columns that aren't needed. The simpler the 

data, the easier it is to understand and work with. 

This table is simple, as it includes only necessary data like Expense, 

Amount, Date, and Payment Method. Including extra information (e.g., 

Item descriptions, Customer IDs) could complicate the data and make it 

harder to manage. Keeping only the essential columns helps maintain 

focus. 

5. No Blank Rows or Columns: Blank rows or columns within the data can 

break the continuity of the dataset, leading to incorrect calculations or 

confusion. Blank rows disrupt the flow of the data and can cause Excel to 

skip over rows when performing calculations or generating reports. Always 

make sure that there are no unnecessary blank rows or columns in your 

data. 

CREATING STRUCTURED TABLES 

Creating structured tables in Excel is an essential skill when working with 

data. A structured table allows data to be organized in a clear and manageable 

format, making it easier to read, analyse, and update. It not only organizes 

the data in rows and columns, but also helps in sorting, filtering, and 

performing calculations efficiently. Excel provides various tools to make 

working with data much simpler by converting a range of data into a table. 

Creating structured tables on excel helps in the following ways:  

1. Automatic Formatting: Excel tables are automatically formatted with 

alternating row colours for easy readability. 

2. Sorting and Filtering: It can easily sort and filter data within a table. 

3. Structured References: When working with Excel functions and 

formulas, structured references (table names and column headers) can be 

used instead of cell addresses. 

4. Dynamic Range: When new data is added to a table, the table will 

automatically expand to include the new data, without having to adjust 

the range manually. 

Steps to create Tables:  

Step 1: Select the Data Range 

Step 2: Convert the Data into a Table 

Step 3: Go to the Insert tab on the Excel Ribbon 

Step 4: Click on Table. A dialog box will appear 

Step 5: If data includes headers, make sure the table has headers 

checkbox is selected 
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Step 6: Click OK, and Excel will convert the selected range into a table. 

Example:  The following data is of monthly expenses: 

Expense Type Amount Date Payment Method 

Rent 10000 44562 Cash 

Groceries 2000 44566 Credit Card 

Utilities 1500 44571 Debit Card 

Petrol 800 44573 Cash 

Let’s convert the given data to a structured excel table.  

Step 1: Enter the data on the excel worksheet.  

Step 2: After selecting the data and clicking Insert > Table, Excel 

will automatically format the data. (Fig. 3.1) 

 

Fig. 3.1: Structured Excel Table 

Result:  

1. The data is now easier to read with alternating row colours. 

2. Filter drop-downs have been added to each column header, allowing 

for easy sorting and filtering. 

3. The table is automatically formatted to stand out. 

Advantages of Structured Tables 

 Easy Sorting and Filtering: Quickly sort or filter data based on any 

column, such as Amount or Date. 

 Automatic Expansion: Tables automatically expand when new data is 

added, keeping calculations and charts updated. 

 Table Design Options: Built-in styles, alternating row colours, bold 

headers, and borders enhance table appearance. 

 Total Row Feature: Add a Total Row to calculate sums, averages, or 

counts automatically. 
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 Rename or Remove Tables: Table names can be changed or removed 

from the Table Tools tab. 

DATA VALIDATION TECHNIQUES 

Data Validation is the process of defining rules to control the type of data 

entered into a cell. It helps ensure that only correct, consistent, and relevant 

data is entered, reducing the chances of errors. Without data validation, users 

might enter incorrect values like text in a numerical field or dates in the wrong 

format. This can lead to mistakes, incorrect calculations, and wasted time 

trying to find and fix errors. By applying data validation rules, data entered 

can be restricted to follow a specific pattern, range, or criteria. 

There are several types of data validation rules that can apply, depending on 

the nature of the data. Below are the common types: 

 Whole Number: Restricts the cell to only allow whole numbers within a 

specified range. 

 Decimal: Allows only decimal values (numbers with a decimal point) 

within a specified range. 

 Date: Ensures that only valid dates are entered within a given range. 

 Text Length: Restricts the length of the text entered (e.g., to limit a name 

to 20 characters). 

 List: Provides a dropdown list of acceptable values, so users can only select 

from a predefined set of options. 

 Custom: Allows for more complex validation rules, such as using formulas 

to define conditions. 

Example: Below is the financial transactions for a small business, and let’s 

see how certain rules can be applied to ensure that certain rules are followed 

when entering the financial data into excel:  

Expense Type Amount (₹) Payment Method Date of Transaction 

Rent 10000 Cash 01/05/2022 

Groceries 3000 Card 03/05/2022 

Utilities 1500 Debit Card 05/05/2022 

Petrol 2000 Cash 06/05/2022 

Task 1: Validating Expense Amounts Between 0 and 100,000 

Follow below steps to ensure that expense amounts are valid and don’t exceed 

a reasonable range, for example, between ₹0 and ₹100,000. 

Step 1: Select the Amount (₹) column. 

Step 2: Go to Data > Data Validation. 

Step 3: In the Settings tab, choose Whole Number from the dropdown menu. 

Step 4: In the Data section, select between, then enter 0 for the minimum and  
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100000 for the maximum. 

Step 5: Click OK. 

Result: If someone tries to enter an amount greater than ₹100,000 or less 

than ₹0, Excel will display an error message, ensuring that only valid expense 

amounts are entered. 

Task 2: Ensuring Valid Payment Methods (Dropdown List) 

Follow below steps to ensure that only valid payment methods are entered, 

such as Cash, Card, or Debit Card, you can create a dropdown list for the 

Payment Method column. 

Step 1: Select the Payment Method column. 

Step 2: Go to Data > Data Validation. 

Step 3: In the Settings tab, select List from the dropdown. 

Step 4: In the Source box, type: Cash, Card, Debit Card. 

Step 5: Click OK. 

Result: Now, when someone clicks on a cell in the Payment Method column, 

a dropdown list will appear with only the options Cash, Card, and Debit Card. 

This will prevent any errors, like entering incorrect payment methods (e.g., 

Cheque or UPI). 

Task 3: Ensuring Valid Transaction Dates 

Follow below steps to ensure that the transaction dates fall within a valid 

range (e.g., January 1, 2022, to December 31, 2022). 

Step 1: Select the Date of Transaction column. 

Step 2: Go to Data > Data Validation. 

Step 3: In the Settings tab, select Date from the dropdown. 

Step 4: In the Data section, select between, and enter 01/01/2022 for the  

   start date and 31/12/2022 for the end date. 

Step 5: Click OK. 

Result: If someone tries to enter a date outside this range (for example, 

01/01/2023), Excel will show an error message, preventing incorrect data 

from being entered. 

Task 4: Text Length for Expense Type 

Follow below steps to ensure that the Expense Type is entered with a 

reasonable text length. For example, the Expense Type should not exceed 20 

characters. 

Step 1: Select the Expense Type column. 
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Step 2: Go to Data > Data Validation. 

Step 3: In the Settings tab, choose Text Length from the dropdown. 

Step 4: In the Data section, select less than or equal to and enter 20. 

Step 5: Click OK. 

Result: Any Expense Type longer than 20 characters will trigger an error. This 

ensures that only short, clear labels are used for expense categories (like Rent, 

Groceries, Utilities, etc.). 

Custom Validation with Formulas 

Custom validation rules using formulas is used to ensure more complex 

conditions. For example, to ensure the expense amount is greater than ₹0 and 

a value is selected in the Payment Method column, formula-based validation 

can be applied. 

Example Formula: Ensure Amount > 0 and Payment Method is not empty. 

Step 1: Select the Amount (₹) column. 

Step 2: Go to Data > Data Validation. 

Step 3: In the Settings tab, select Custom from the dropdown. 

Step 4: In the Formula box, enter the following formula: 

Step 5: =AND(A2>0, NOT(ISBLANK(B2))) 

(Assuming A2 is the Amount column and B2 is the Payment Method 

column). 

Step 6: Click OK. 

Result: This formula ensures that amount is greater than ₹0 and that a 

payment method is entered in the corresponding cell. If either condition is not 

met, an error message will appear. 

Error Alerts and Input Messages 

Excel also allows to add input messages and error alerts to provide helpful 

guidance or error messages when users enter invalid data. 

 Input Message: Appears when the user selects a cell, explaining the type 

of data to be entered. 

 Error Alert: Displays a message when the entered data does not meet the 

validation rule. 

 Example: 

 Input Message: “Enter a valid payment method (Cash, Card, Debit Card)”. 

 Error Alert: “Invalid Payment Method! Please select from Cash, Card, or 

Debit Card.” 
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IMPORTING AND EXPORTING DATA 

In Excel, data can be imported and exported in various formats. Two of the 

most commonly used file formats are CSV (Comma Separated Values) and 

TXT (Text). Understanding how to work with these formats allows you to easily 

share easy sharing data between different applications and systems, and 

ensures compatibility with software that may not support Excel’s native .xlsx 

format. 

Comma Separated Values (CSV) 

CSV is a simple file format used to store tabular data, such as spreadsheets 

or databases. Each line in a CSV file corresponds to a row of data, and each 

field within the row is separated by a comma. This makes it easy to transfer 

data between different software applications. Below are some advantages of 

CSV file: 

 Compatibility: CSV files can be opened by almost any text editor or 

spreadsheet software. 

 Simplicity: CSV files are plain text, meaning they don't contain formatting 

or formulas, only raw data. 

Text (TXT) 

A TXT file is a simple text file that stores data as plain text without any special 

formatting. It can be used to store a wide range of information but doesn’t 

have the structure of a spreadsheet like Excel. A TXT file can store data in a 

simple tabular format or plain lists, and it can also be opened in any text 

editor. Below are some advantages of TXT: 

 Universal Compatibility: Can be opened by any text editor and is 

compatible with many applications. 

 Simplicity: It is ideal for storing plain data without needing complex 

formatting. 

Import Data into Excel (CSV/TXT Files) 

Follow below steps to import data in to Excel (CSV/TXT Files). 

Step 1: Importing a CSV or TXT File into Excel: 

Step 2: Open Excel and go to the File tab. 

Step 3: Select Open and then choose Browse to locate the CSV or TXT file 

on your computer. 

Step 4: Once the file is selected, click Open. 

Step 5: Excel will automatically recognize the data format and display a 

preview of how the data will be arranged in cells. 

Step 6: Follow the Text Import Wizard if needed. This wizard allows you to 

select the correct delimiters (such as commas or tabs) to ensure the 

data is correctly arranged in columns. 
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Step 7: After completing the import steps, click Finish, and the data will 

appear in your Excel worksheet. 

Exporting Data as a CSV or TXT File 

After working with data in Excel, it can be saved in CSV or TXT format to 

make it compatible with other applications. 

Step 1: Click on File > Save As. 

Step 2: Choose a location to save the file. 

Step 3: In the Save as type dropdown menu, select either CSV (Comma 

delimited) (*.csv) or Text (Tab delimited) (*.txt). 

Step 4: Enter a name for the file and click Save. 

Following points to consider before importing and exporting data (CSV/TXT):  

 Data Formatting: Only raw data is saved in CSV or TXT files. Formulas, 

charts, or colours are not included; only the final values appear. Complete 

all calculations before exporting. 

 Delimiter Issues: CSV files use commas to separate data; TXT files may 

use tabs or spaces. Wrong delimiter settings can mess up the data layout. 

Always check delimiter settings. 

 Data Compatibility: CSV and TXT files are plain text and cannot store 

advanced features like formulas or multiple sheets. Only the active sheet 

gets saved. 

 Data Integrity: Special characters may not appear correctly if file encoding 

is wrong. Choose the right encoding (like UTF-8) to keep data accurate. 

 File Size Limits: These formats work well for small to medium data. Very 

large datasets or complex files should be saved in formats like Excel (.xlsx) 

for better handling. 

PRACTICAL EXERCISE 

Activity 1: Group discussion on importing and exporting data between 

different file formats. 

Materials Required: 

 Computer or Laptop with Microsoft Excel installed 

 Sample Excel files containing data 

 Internet or textbook reference (optional) 

 Whiteboard/Notebook for noting key points 

Procedure: 

1. Divide class into small groups. 
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2. Each group opens a sample Excel file with basic data (e.g., sales records 

or student details). 

3. Discuss the purpose of importing and exporting data i.e. why it is done 

and where formats like CSV and TXT are used. 

4. Each group export the Excel file to CSV and TXT formats. 

5. Observe what happens to formulas, formatting, and layout during export. 

6. Import the CSV or TXT file back into Excel and check the data. 

7. Each group discuss: 

 What changes were noticed? 

 Advantages and limitations of each format 

 Importance of delimiter settings and data compatibility 

8. Each group shares their findings with the class. 

9. Teacher will summarise the discussions. 

CHECK YOUR PROGRESS 

A. Fill-in-the-Blank Questions 

1. Data organization ensures that information is arranged in a __________ 

way, making it easier to __________ and interpret. 

2. The __________ function in Excel ensures that only valid data, such as 

numbers, dates, or text within a range, is entered into cells. 

3. To create a table in Excel, you can select the data range and click on 

the _________ tab, then choose the Table option. 

4. In Excel, __________ refers to arranging data into rows and columns 

where each row represents one record and each column represents one 

characteristic 

5. Data __________ in Excel refers to the process of organizing and 

formatting data to ensure consistency and clarity. 

B. Multiple Choice Questions 

1. Which of the following is a key principle of data organization in Excel? 

a) Complexity 

b) Clarity 

c) Irregularity 

d) Disorganization 

2. What is the main advantage of using structured tables in Excel? 

a) Automatically formats numbers 

b) Automatically expands when new data is added 

c) Discards invalid data 

d) Limits data entries to specific columns 

3. Which of the following is NOT a type of data validation in Excel? 

a) Whole Number 

b) Date 
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c) Formula 

d) Graphic 

4. When creating a table in Excel, what does the “Total Row” feature do? 

a) Automatically calculates sums and averages 

b) Adds a new column 

c) Sorts the table alphabetically 

d) Sets headers for each column 

5. What type of data validation rule would you use to ensure a date is 

entered in a valid range, like between 01/01/2022 and 12/31/2022? 

a) Text Length 

b) Whole Number 

c) Date 

d) List 

C. State whether the following statements are True or False 

1. Data validation rules in Excel can only be applied to text-based data. 

2. Data organization is important for making data easier to read and 

analyses. 

3. Structured tables in Excel automatically add new rows when new data 

is entered. 

4. Excel tables allow you to create custom formatting for rows and 

columns, but it does not support sorting or filtering. 

5. Excel allows you to validate data entries such as the date range or the 

length of text, but it cannot prevent duplicates from being entered. 

D. Short Answer Questions 

1. What is the purpose of data validation in Excel? 

2. What are the benefits of organizing data into structured tables in Excel? 

3. How do you apply a rule in Excel to restrict the amount entered to be 

between ₹0 and ₹100,000? 

4. What is the difference between relative and absolute cell references in 

Excel? 

5. Why is clarity important in data organization? 

6. How can you prevent users from entering invalid payment methods in 

Excel? 

E. Long Answer Questions 

1. Explain the process of applying data validation in Excel to restrict the 

entries in the “Amount” column to only whole numbers between ₹0 and 

₹100,000. 

2. Describe the key principles of data organization in Excel and how they 

help in making better decisions. 

3. What are the advantages of using structured tables in Excel? Provide 

an example.  

4. Explain how you can use data validation to create a dropdown list for 

payment methods, and why this is important in data entry. 
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F. Check Your Performance 

1. Data Validation and Organization: 

a) Organize the following Monthly Expense data into a structured Excel 

table with clear headings. 

b) Apply Data Validation to ensure: 

c) Amount (₹) must be a number greater than 0. 

d) Date of Transaction must be within June 2023. 

e) Payment Method can only be one of: Cash, Credit Card, Debit Card. 

Expense 

Type 

Amount 

(₹) 

Date of 

Transaction 

Payment 

Method 

Rent 8000 01/06/2023 Cash 

Groceries 3500 02/06/2023 Credit Card 

Electricity 1500 03/06/2023 Debit Card 

Petrol 2000 04/06/2023 Cash 

Groceries 2500 05/06/2023 Debit Card 

Rent 8000 06/06/2023 Cash 

Groceries 2200 07/06/2023 Credit Card 

Rent 8000 08/06/2023 Debit Card 

Electricity 1600 09/06/2023 Cash 

Petrol 2100 10/06/2023 Credit Card 

2. Importing and Exporting Data: 

a) Import the given CSV data of an Online Store into Excel. 

b) Organize the data into a structured table with proper headings and 

formatting. 

c) Export the organized table as a CSV file for sharing purposes. 

Product 

ID 

Product 

Name 
Category 

Price 

(₹) 

Quantity 

Sold 

Total 

Sales 

(₹) 

101 T-shirt Clothing 499 25 12475 

102 Jeans Clothing 799 20 15980 

103 Headphones Electronics 1500 15 22500 

104 Phone Electronics 19999 10 199990 

105 Shoes Footwear 2999 30 89970 

106 Jacket Clothing 2999 18 53982 

107 Socks Footwear 500 40 20000 

108 Smartwatch Electronics 4999 12 59988 

109 Camera Electronics 12000 5 60000 

110 Sunglasses Accessories 1499 50 74950 
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SESSION 2: AGGREGATE ANALYSIS 

Aggregate analysis is the process of summarizing and analysing large 

amounts of data to make it easier to understand. It helps in quickly finding 

important information, such as total amounts, averages, or counts, based on 

certain conditions. In simple terms, it is like organizing and calculating data 

so we can see patterns or trends more clearly. 

In Excel, special tools called aggregate functions such as SUMIF, AVERAGEIF, 

COUNTIF, and others can be used to perform calculations. These functions 

help us quickly add up numbers, calculate averages, or count items based on 

one or more conditions. 

By using aggregate functions, patterns and trends within large datasets can 

be identified quickly and efficiently. These functions help in summarizing data 

points, performing calculations, and generating key metrics such as totals, 

averages, and counts, all of which are crucial for decision-making processes. 

In Excel, these tools are widely used to streamline the analysis of data, 

allowing users to focus on relevant information without manually sifting 

through rows of raw data. 

AGGREGATE FUNCTIONS  

Aggregate functions are special formulas in Excel that help add up, count, or 

summarize many numbers at once. Instead of looking at each number 

separately, these functions combine data to give useful results like totals, 

averages, or highest and lowest values. They make it easier to understand and 

analyse large amounts of information quickly. 

There are several types of aggregate functions in Excel, and they can be used 

to perform calculations either with a single condition or multiple conditions. 

1. SUMIF and SUMIFS 

The SUMIF and SUMIFS function allow summing values in a range that 

meet a specific condition or criteria. They are used to add numbers based 

on a given condition, such as all sales made by a particular employee or 

all expenses of a certain type. 

Syntax: =SUMIF(range, criteria, [sum_range]) 

 range: The range of cells to which the criteria will be applied. 

 criteria: The condition that must be met for the cells to be included 

in the sum (it can be a number, text, expression, or even a cell 

reference). 

 sum_range (optional): The actual cells to sum. If omitted, Excel 

will sum the range. 

Consider the following data set for example:  
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Date 
Expense 

Type 
Amount (₹) 

Payment 

Method 

01/06/2022 Rent 10000 Bank Transfer 

02/06/2022 Groceries 5000 Cash 

03/06/2022 Utilities 1500 Credit Card 

04/06/2022 Petrol 800 Debit Card 

05/06/2022 Groceries 2000 Cash 

06/06/2022 Rent 10000 Bank Transfer 

07/06/2022 Utilities 1200 Credit Card 

08/06/2022 Groceries 2500 Debit Card 

09/06/2022 Petrol 1200 Cash 

10/06/2022 Rent 10000 Bank Transfer 

Apply SUMIF with single criteria for “Groceries” 

Formula: =SUMIF (B2:B11, “Groceries”, C2:C11) 

 Range: B2:B11 (Expense Type column) 

 Criteria: “Groceries” (we are interested in all rows where the 

expense type is Groceries) 

 Sum_range: C2:C11 (Amount column) 

Result: ₹5000 (on 02/06/2022) + ₹2000 (on 05/06/2022) + ₹2500 

(on 08/06/2022) = ₹10,500 

So, the sum of all Groceries expenses is ₹10,500. 

Apply SUMIF with Multiple Criteria (SUMIFS) 

Formula: =SUMIFS (C2:C11, B2:B11, “Rent”, D2:D11, “Bank 

Transfer”) 

 Sum_range: C2:C11 (Amount column) 

 Criteria_range1: B2:B11 (Expense Type column) 

 Criteria1: “Rent” 

 Criteria_range2: D2:D11 (Payment Method column) 

 Criteria2: “Bank Transfer” 

Result: ₹10000 (on 01/06/2022) + ₹10000 (on 06/06/2022) + 

₹10000 (on 10/06/2022) = ₹30,000 

So, the total for Rent paid via Bank Transfer is ₹30,000. 
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Apply SUMIF with Different Criteria (Multiple Criteria) 

Formula: =SUMIFS (C2:C11, B2:B11, “Groceries”, D2:D11, “Cash”) 

 Sum_range: C2:C11 (Amount column) 

 Criteria_range1: B2:B11 (Expense Type column) 

 Criteria1: “Groceries” 

 Criteria_range2: D2:D11 (Payment Method column) 

 Criteria2: “Cash” 

Result: ₹5000 (on 02/06/2022) + ₹2000 (on 05/06/2022) = ₹7000 

So, the total for Groceries paid via Cash is ₹7000. 

2. AVERAGEIF and AVERAGEIFS 

The AVERAGEIF and AVERAGEIFS function in Excel is used to calculate 

the average of the values in a range that meet a specific condition or 

criteria. It is useful for finding the average of numbers that match a given 

condition, such as finding the average price of products above a certain 

amount or calculating the average sales made by a particular employee. 

Syntax: =AVERAGEIF(range, criteria, [average_range]) 

 range: The range of cells to which the criteria will be applied. 

 criteria: The condition that must be met for the cells to be included 

in the average (it can be a number, text, expression, or even a cell 

reference). 

 average_range (optional): The actual cells to average. If omitted, 

Excel will average the range. 

Apply AVERAGEIF with Single Criteria 

Formula: =AVERAGEIF (B2:B11, “Groceries”, C2:C11) 

 range: B2:B11 (Expense Type column) 

 criteria: “Groceries” (All rows where the expense type is Groceries) 

 average_range: C2:C11 (Amount column) 

Result: The formula will add up all the values in the Amount (₹) column 

where the Expense Type is Groceries, and then divide by the number of 

matching rows. 

 5000 (on 02/06/2022) 

 2000 (on 05/06/2022) 

 2500 (on 08/06/2022) 

Average: 
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The average expense for Groceries is ₹3166.67. 

Apply AVERAGEIF with Multiple Criteria (AVERAGEIFS) 

Formula: =AVERAGEIFS (C2:C11, B2:B11, “Rent”, D2:D11, “Bank 

Transfer”)  

 average_range: C2:C11 (Amount column) 

 criteria_range1: B2:B11 (Expense Type column) 

 criteria1: “Rent” 

 criteria_range2: D2:D11 (Payment Method column) 

 criteria2: “Bank Transfer” 

Result: 

10000 (on 01/06/2022) 

10000 (on 06/06/2022) 

10000 (on 10/06/2022) 

Average:  

 

The average Rent paid via Bank Transfer is ₹10,000. 

Apply AVERAGEIF with Different Criteria (Multiple Criteria) 

Formula: =AVERAGEIFS (C2:C11, B2:B11, “Groceries”, D2:D11, “Cash”) 

 average_range: C2:C11 (Amount column) 

 criteria_range1: B2:B11 (Expense Type column) 

 criteria1: “Groceries” 

 criteria_range2: D2:D11 (Payment Method column) 

 criteria2: “Cash” 

Result: 5000 (on 02/06/2022) and 2000 (on 05/06/2022) 

Average:  

 

The average expense for Groceries paid via Cash is ₹3500. 
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3. COUNTIF and COUNTIFS 

COUNTIF and COUNTIFS are Excel functions used to count the number of 

cells that meet one or more specific conditions. These functions are 

valuable for analysing data and determine how many times a certain 

condition is met. 

COUNTIF: The COUNTIF function is used to count the number of cells that 

meet a single condition. 

Syntax: =COUNTIF (range, criteria) 

 range: The range of cells to which the criteria will be applied. 

 criteria: The condition that must be met for the cells to be counted (it 

can be a number, text, expression, or even a cell reference). 

Apply COUNTIF with Single Criteria: 

Formula: =COUNTIF (B2:B11, “Rent”) 

 range: B2:B11 (Expense Type column) 

 criteria: “Rent” (Count of how many times “Rent” appears in the 

Expense Type column.) 

Result: The formula will count the number of times Rent appears in 

the Expense Type column. 

Rent appears in the list 3 times (on 01/06/2022, 06/06/2022, and 

10/06/2022). So, the count of Rent is 3. 

Apply COUNTIF with Different Criteria (Multiple Criteria) - Using 

SUMIF and COUNTIF together: 

Formula: =COUNTIF (D2:D11, “Cash”) 

 range: D2:D11 (Payment Method column) 

 criteria: “Cash” (Count of how many times Cash was used as the 

payment method) 

Result: The formula will count the number of times Cash appears in 

the Payment Method column 

Cash appears in the list 4 times (on 02/06/2022, 05/06/2022, 

09/06/2022). 

So, the count of Cash payment method is 4. 

COUNTIFS: The COUNTIFS function is used to count the number of cells 

that meet multiple conditions. 

Syntax: =COUNTIFS (range1, criteria1, range2, criteria2, ...) 
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 range1, range2, ...: The ranges of cells that you want to apply the 

criteria to. 

 criteria1, criteria2, ...: The conditions that must be met for the cells 

to be counted. 

Apply COUNTIFS with Multiple Criteria: 

Formula: =COUNTIFS (B2:B11, “Groceries”, D2:D11, “Cash”) 

 range1: B2:B11 (Expense Type column) 

 criteria1: “Groceries” (Count of how many times Groceries appears) 

 range2: D2:D11 (Payment Method column) 

 criteria2: “Cash” (Count of Cash payments specifically for Groceries) 

Result: Groceries appears twice (on 02/06/2022 and 05/06/2022). 

Cash was used for Groceries on both occasions. 

So, the count of Groceries paid via Cash is 2. 

Apply COUNTIFS with Multiple Criteria: 

Formula: =COUNTIFS (B2:B11, “Utilities”, D2:D11, “Credit Card”) 

 range1: B2:B11 (Expense Type column) 

 criteria1: “Utilities” (we are counting how many times Utilities 

appears) 

 range2: D2:D11 (Payment Method column) 

 criteria2: “Credit Card” (we are counting only Credit Card payments 

for Utilities) 

Result: Utilities appears twice (on 03/06/2022 and 07/06/2022). 

Credit Card was used to pay for Utilities on both occasions. 

So, the count of Utilities paid via Credit Card is 2. 

PRACTICAL EXERCISE  

Activity 1: Use SUMIF to calculate the total salary of all HR department 

employees. 

Employee Name Department Salary (₹) Gender 

John HR 30000 Male 

Mary Finance 45000 Female 

Mike HR 28000 Male 

Sarah Marketing 35000 Female 
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Emma Finance 42000 Female 

David Marketing 37000 Male 

Lisa HR 31000 Female 

Peter Finance 48000 Male 

Diana Marketing 36000 Female 

James HR 29000 Male 

Material Required: 

 Computer/Laptop with Microsoft Excel installed 

 Excel worksheet (students will enter the given employee data) 

 Calculator (for manual verification, optional) 

 Pen and notebook for noting down formulas (optional) 

 Projector/Screen (if teacher is demonstrating the activity) 

Procedure: 

1. Open Excel and enter the following columns: 

Employee Name, Department, Salary, Gender and fill in the data for all 10 

employees as given in the table. 

2. In a blank cell below or beside the data, type the formula.  

3. Press Enter, and Excel will show the total salary for HR employees. 

4. Verify the result by manually adding HR salaries. 

5. Teacher explains the parts of the formula and encourages questions. 

6. Teacher summarises the use of SUMIF in real-life scenarios like salary 

reports, sales analysis, etc. 

Activity 2: AVERAGEIF – Find Average Salary of Finance Department 

Employees. 

Material Required: 

 Computer/Laptop with Microsoft Excel installed 

 Excel worksheet with employee data (Data set of Activity 1) 

 Pen and notebook for noting down formulas (optional) 

Procedure: 

1. Students enter the same employee data (if not already done). 

2. In a blank cell, type the formula. 

3. Press Enter to get the average salary of Finance department employees. 

4. Teacher explains each part of the formula and answers student doubts. 

Activity 3: Apply COUNTIF and COUNTIFS formula.   
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Material Required: 

 Computer/Laptop with Microsoft Excel installed 

 Excel worksheet with employee data (Data set of Activity 1) 

 Pen and notebook for noting down formulas (optional) 

Procedure: 

1. Enter COUNTIF Formula. 

a. In a blank cell, type the formula. 

b. Press Enter to get the count of female employees. 

2. Teacher introduces COUNTIFS, which is used to count based on multiple 

conditions. Example: Count the number of male employees in the HR 

department. 

3. Enter COUNTIFS Formula. 

a. In a blank cell, type the formula. 

b. Press Enter to get the count of female employees. 

4. Teacher explains real-life uses of COUNTIF and COUNTIFS, like: 

 Counting employees by gender 

 Counting by department and gender together 

 Filtering specific groups based on multiple conditions  

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. The SUMIF function in Excel is used to sum the values in a range that 

meet a __________ condition. 

2. The AVERAGEIFS function is used to calculate the average of values in 

a range that meet __________ conditions. 

3. The COUNTIF function is useful for counting the number of cells that 

meet __________ condition. 

4. SUMIFS is used when you want to sum values based on __________ 

criteria. 

5. COUNTIFS allows you to count cells that meet __________ criteria. 

B. Multiple Choice Questions 

1. What does the SUMIF function do in Excel? 

a)  Counts the number of cells 

b)  Averages the values in a range 

c)  Sums values based on a single condition 

d)  Finds the maximum value 

2. What is the primary difference between SUMIF and SUMIFS? 

a)  SUMIF can handle multiple criteria, while SUMIFS can only handle 

one 
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b)  SUMIFS can handle multiple criteria, while SUMIF can only handle 

one 

c)  SUMIF is faster than SUMIF 

d)  SUMIF requires more memory than SUMIFS 

3. Which function would you use to calculate the average of all values in 

a range that meet a single condition? 

a)  SUMIF 

b)  AVERAGEIF 

c)  COUNTIF 

d)  MAXIFS 

4. Which of the following is true for the COUNTIFS function? 

a) It can only count cells based on one condition 

b)  It works only with numeric data 

c)  It can count cells based on multiple conditions 

d)  It calculates averages 

5. When using AVERAGEIFS, what do you need to define? 

a)  A sum_range and its criteria 

b)  An average_range and its criteria 

c)  Only a sum_range 

d)  Only a criteria range 

C. State whether the following statements are True or False 

1. SUMIF can only sum values in a range based on one condition. 

2. COUNTIF allows you to count cells that meet multiple criteria. 

3. The AVERAGEIFS function requires only one condition to be specified. 

4. SUMIFS can handle multiple criteria for summing values. 

5. The COUNTIFS function can only be used to count values in a single 

column. 

D. Short Answer Questions 

1. What is the difference between SUMIF and SUMIFS? 

2. Explain how to use the AVERAGEIF function with an example. 

3. What do you need to specify when using the COUNTIF function? 

4. How does COUNTIFS handle multiple criteria? 

5. When would you use SUMIFS over SUMIF? 

6. What will the COUNTIFS function return when used with multiple 

criteria? 
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E. Long Answer Questions 

1. Describe the steps to use SUMIF for calculating the total of a specific 

type of expense in a dataset. Include an example where you sum the 

expenses for Groceries. 

2. Explain how AVERAGEIF and AVERAGEIFS differ. Provide a real-world 

example where you calculate the average of expenses based on different 

payment methods. 

3. How does COUNTIF work? Give an example where you count the 

number of times Rent appears in an expense list. 

4. Discuss how SUMIFS and COUNTIFS are useful when analysing data 

with multiple criteria. Provide an example where you sum and count 

data based on multiple conditions such as Rent payments made via 

Bank Transfer. 

F. Check Your Performance 

1. A store sells different products in various categories. The manager 

wants to analyse the sales data using Excel aggregate functions. 

Below is part of the sales data: 

Product Category Price (₹) 
Quantity 

Sold 
Region 

Laptop Electronics 50000 15 North 

Phone Electronics 20000 25 South 

TV Electronics 30000 10 North 

Shirt Clothing 1500 50 South 

Jeans Clothing 2000 35 North 

Shoes Footwear 3000 20 South 

Jacket Clothing 2500 40 North 

Socks Footwear 500 55 South 

Headphones Electronics 2500 18 North 

Gloves Clothing 800 60 South 

Using appropriate aggregate functions, answer the following: 

i) What is the total quantity sold of Clothing products using 

SUMIF? 

ii) What is the average price of Electronics products using 

AVERAGEIF? 

iii) How many products were sold in the North region with quantity 

greater than 20, using COUNTIFS? 
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SESSION 3: CREATING MIS REPORTS 

In today's fast-paced world, businesses rely heavily on data to make informed 

decisions. The data collected from various departments needs to be analysed 

and presented in a way that helps managers understand how the organization 

is performing. This is where MIS Reports (Management Information System 

Reports) come into play. These reports summarize important information and 

help decision-makers monitor performance, track progress, and identify areas 

for improvement. 

An MIS report is typically used to present data on a regular basis, such as 

weekly, monthly, or quarterly. The information in the report could include 

sales figures, production data, customer feedback, and other key performance 

indicators (KPIs). These reports are often used by top management to make 

decisions regarding resource allocation, strategies, and business goals. 

The process of creating an MIS report involves gathering data from different 

sources, organizing it in a structured format, and presenting it in a clear and 

meaningful way. Tools like Excel are often used to organize the data, perform 

calculations, and create charts or tables that visually present the information. 

Excel makes it easy to manipulate data, summarize it, and highlight trends 

or key figures that need attention. 

IMPORTANCE OF MIS REPORTS 

MIS is designed to provide timely and relevant information to managers and 

decision-makers, enabling them to assess the performance of different 

business functions. The importance of MIS reports can be understood in 

several ways: 

Informed Decision Making: MIS reports provide managers with a snapshot 

of the organization’s performance, allowing decisions to be made based on 

real-time data. Without these reports, decisions might be based on 

assumptions or outdated information, leading to poor outcomes. 

1. Data Summarization: The data collected across different departments 

can be complex and overwhelming. MIS reports help to summarize this 

information in an easy-to-understand format. Through tables, charts, and 

graphs, the important data is presented in a way that is visually appealing 

and simple to interpret. 

2. Tracking Key Performance Indicators (KPIs): MIS reports track 

important metrics or KPIs such as sales performance, production levels, 

inventory status, and customer satisfaction. By monitoring these KPIs 

regularly, management can identify trends, successes, and areas that need 

attention. This helps in setting future goals and improving operational 

efficiency. 
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3. Identifying Problems Early: With regular MIS reporting, any issues or 

discrepancies can be detected early. For example, if sales figures are lower 

than expected, it can be identified through an MIS report, allowing 

corrective actions to be taken before the situation worsens. 

4. Resource Allocation: MIS reports provide insight into where resources 

(like finances, materials, or human resources) are being utilized most 

effectively. This helps management in allocating resources efficiently, 

ensuring that the organization is working optimally and that resources are 

being used where they are needed the most. 

5. Support for Strategic Planning: In strategic planning, MIS reports 

provide the necessary data to develop long-term goals. By analysing trends 

and patterns from the reports, organizations can plan for future growth, 

assess market conditions, and ensure that all aspects of the business are 

aligned with the overall objectives. 

6. Improved Communication: MIS reports help in improving 

communication within the organization. By providing a consistent format 

for sharing information, the reports ensure that everyone from managers 

to staff is on the same page. This promotes transparency and 

understanding across all levels of the organization. 

7. Cost Control: Through MIS reports, managers can keep track of spending 

in various areas, such as production costs, marketing expenses, and 

employee salaries. This helps in identifying areas where cost-cutting 

measures can be taken without affecting overall productivity. 

8. Performance Evaluation: Regular MIS reports make it easier to evaluate 

the performance of individuals, departments, and the organization as a 

whole. This allows managers to recognize areas of improvement, celebrate 

successes, and identify training or development needs. 

TYPES OF REPORTS 

In Management Information Systems (MIS), different types of reports are 

generated based on the needs and frequency of information required by the 

organization. These reports can vary in terms of the time period they cover 

and the purpose they serve. Each type of report has its own format and 

structure, which helps in organizing data in a way that suits the intended 

purpose. Below are the types of reports commonly used: 

1. Daily Reports 

Daily reports help track activities and operations that occur on a day-to-

day basis. These reports allow managers to identify immediate issues and 

assess the short-term performance of the business. In the case of banks 

or financial institutions, daily reports can track the number of customer 

visits, new accounts opened, loan disbursements, and cash flow on a daily 

basis. 
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A daily report for visits and cash flow will typically include: 

 Date: The date for which the report is being created. 

 Key Metrics: Specific data for the day, such as new accounts, cash 

flow, loans disbursed, etc. 

 Summary: A brief explanation of important activities or any deviations 

from the normal. 

Example:  

Date 

Number of 
New 

Accounts 
Opened 

Loan 
Disbursement 

(₹) 

Cash 
Flow In 

(₹) 

Cash 
Flow Out 

(₹) 

01/12/2022 20 1,000,000 2,500,000 2,000,000 

02/12/2022 15 500,000 1,800,000 1,200,000 

03/12/2022 25 1,500,000 3,000,000 2,500,000 

 Number of New Accounts Opened: This column tracks how many new 

customer accounts were opened on a given day. 

 Loan Disbursement: This column records the total loan amount 

disbursed by the bank on that specific day. 

 Cash Flow In: This column shows the total cash inflows for the day, 

which may include deposits, loan repayments, etc. 

 Cash Flow Out: This column records the cash outflows for the day, 

such as payments to vendors, employee salaries, or loan 

disbursements. 

Use of Daily Report in Financial Context 

 Tracking New Accounts: By monitoring the number of new accounts 

opened, managers can assess customer acquisition efforts and make 

adjustments to marketing or outreach strategies as necessary. 

 Loan Disbursement Status: The daily report on loan disbursement 

ensures that there is proper monitoring of the bank’s lending activities. 

This data helps understand the volume of loans being processed daily 

and can indicate whether there is an increase in demand for loans. 

 Cash Flow Monitoring: The cash flow in and out of the organization is 

crucial for understanding liquidity. Monitoring daily cash inflows and 

outflows ensures that the business maintains the necessary funds for 

daily operations, helping to prevent liquidity problems. 

2. Weekly Reports 

Weekly reports provide an overview of the activities and performance over 

a week. These reports are essential for assessing the short-term progress 

of the business, identifying trends, and making necessary adjustments for 

the upcoming week. In a financial context, weekly reports help track 
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customer visits, new accounts opened, loan disbursements, and cash flows 

throughout the week. 

A weekly report for visits and cash flow typically includes: 

 Week Ending Date: The end date of the week for which the report is 

generated. 

 Key Metrics: Data points like new accounts opened, loan 

disbursements, cash inflows, and cash outflows. 

 Comparison to Previous Week: A brief comparison to the previous 

week’s data to identify trends or changes. 

 Key Insights or Issues: Any important observations or issues 

encountered during the week. 

Example: 

 Number of New Accounts Opened: This column tracks the number of 

new customer accounts opened during the week. An increase or 

decrease in new accounts is a key metric for understanding customer 

acquisition efforts. 

 Loan Disbursement: This column records the total loan amount 

disbursed during the week, providing a snapshot of the loan activity 

within the organization. 

 Cash Flow In: This column shows the total cash inflows for the week, 

such as customer deposits, loan repayments, and other income. 

 Cash Flow Out: This column tracks the cash outflows for the week, 

which could include loan disbursements, expenses, and other 

payments. 

 Week-over-Week Change: This column shows the percentage change 

from the previous week in terms of sales, loan disbursements, and other 

metrics. This helps identify trends and evaluate performance 

improvements or setbacks. 

Use of Weekly Report in Financial Context 

Week 
Ending 

Number 
of New 

Accounts 
Opened 

Loan 
Disbursement 

(₹) 

Cash Flow 
In (₹) 

Cash Flow 
Out (₹) 

Week-over-Week 
Change 

05/12/2022 85 5,000,000 15,000,000 12,000,000 
+10% Sales, +5% 
Loan Disbursed 

12/12/2022 90 4,500,000 14,500,000 13,000,000 
+5% Sales, -10% 
Loan Disbursed 

19/12/2022 110 6,000,000 16,000,000 14,500,000 
+22% Sales, +20% 
Loan Disbursed 
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 Tracking New Accounts: By observing the number of new accounts 

opened each week, it becomes easier to evaluate the effectiveness of 

marketing campaigns, promotions, or customer service initiatives. 

 Loan Disbursement Status: Weekly monitoring of loan disbursements 

helps ensure that the bank or financial institution is meeting its lending 

targets. It also helps to identify any gaps or opportunities in the loan 

process. 

 Cash Flow Monitoring: The cash flow in and out of the organization is 

tracked weekly to monitor liquidity and ensure that enough funds are 

available for operations. Significant fluctuations in cash flow can help 

identify potential issues, such as unpaid loans or high operational 

costs. 

 Performance Comparison: Comparing the data to the previous week 

helps managers to assess whether the business is moving in the right 

direction or if adjustments are needed to improve performance. 

3. Monthly Reports  

Monthly reports provide a comprehensive overview of the business 

performance over the course of a month. These reports are essential for 

understanding long-term trends, evaluating the effectiveness of strategies, 

and planning for the next month. In the context of financial operations, 

monthly reports allow managers to track customer visits, new accounts 

opened, loan disbursements, and cash flow, offering insights into the 

overall performance of the business. 

A monthly report typically includes: 

 Month Ending Date: The date marking the end of the month for which 

the report is generated. 

 Key Metrics: Data for new accounts opened, loan disbursements, cash 

inflows, and cash outflows for the entire month. 

 Comparison to Previous Month: A comparison to the performance of 

the previous month, allowing managers to see trends and changes. 

 Key Insights or Issues: Any notable trends, challenges, or 

opportunities identified during the month. 

Example: 

Month 
Ending 

Number 
of New 

Accounts 
Opened 

Loan 
Disbursement 

(₹) 

Cash Flow 
In (₹) 

Cash Flow 
Out (₹) 

Month-over-
Month Change 

November 
2022 

300 20,000,000 60,000,000 55,000,000 
+5% Sales, +10% 
Loan Disbursed 

December 
2022 

350 22,500,000 65,000,000 58,000,000 
+16.6% Sales, 
+12% Loan 
Disbursed 
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January 
2023 

400 25,000,000 70,000,000 60,000,000 
+14.3% Sales, 
+11% Loan 
Disbursed 

 Number of New Accounts Opened: This column tracks the total 

number of new customer accounts opened during the month. This 

metric helps assess customer acquisition efforts and determine if 

marketing or outreach strategies are effective. 

 Loan Disbursement: This column records the total loan amount 

disbursed during the month. By comparing loan disbursements over 

several months, trends can be identified, and decisions can be made to 

adjust lending strategies if needed. 

 Cash Flow In: This column shows the total cash inflows for the month, 

such as deposits, loan repayments, and other sources of income. 

 Cash Flow Out: This column tracks the cash outflows for the month, 

which could include loan disbursements, operational expenses, vendor 

payments, and other costs. 

 Month-over-Month Change: This column compares the data from the 

current month to the previous month. For example, if the number of 

new accounts opened increases by 16.6% from November to December, 

this indicates a positive trend. This comparison helps managers 

understand the direction in which the business is moving. 

Use of Monthly Report in Financial Context 

 Tracking New Accounts: The number of new accounts opened each 

month is a key indicator of the growth and success of marketing or 

customer engagement efforts. If the number of new accounts opens 

significantly increases or decreases, it can indicate the success of 

current strategies or the need for adjustments. 

 Loan Disbursement Status: By tracking loan disbursements over the 

month, the performance of the lending department is easily monitored. 

If there is an increase in loans disbursed, it may indicate higher demand 

or effective marketing efforts. Conversely, a decrease may highlight an 

area that requires attention. 

 Cash Flow Monitoring: Monitoring cash flow for the month ensures 

that the organization remains financially stable. By analyzing the cash 

inflows and outflows, managers can ensure that sufficient funds are 

available for daily operations, loan disbursements, and other expenses. 

 Performance Comparison: Comparing the data with the previous 

month helps track business growth. Positive growth in metrics like 

sales, loan disbursements, and cash flow can show that the 

organization is on the right track. On the other hand, negative growth 

can help identify areas where corrective action is needed. 

4. Quarterly Reports 
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Quarterly reports provide a comprehensive view of a company’s 

performance over three months (a quarter). These reports help 

organizations assess the progress toward their long-term goals and identify 

any areas that need improvement. Quarterly reports are crucial for 

evaluating trends and making strategic decisions for the next quarter. In 

the context of financial institutions, these reports help track key metrics 

such as customer visits, new accounts opened, loan disbursements, and 

cash flow, offering a broader perspective on the organization's 

performance. 

A quarterly report typically includes: 

 Quarter Ending Date: The end date of the quarter, for example, 31st 

March for Q1 or 30th June for Q2. 

 Key Metrics: Data for new accounts opened, loan disbursements, cash 

inflows, and cash outflows over the entire quarter. 

 Quarter-over-Quarter Comparison: A comparison of the data from the 

current quarter to the previous quarter to understand growth or 

decline. 

 Key Insights or Issues: Highlights of significant achievements, issues, 

or opportunities observed during the quarter. 

Quarter 
Ending 

Number 
of New 

Accounts 
Opened 

Loan 
Disbursement 

(₹) 

Cash Flow 
In (₹) 

Cash Flow 
Out (₹) 

Quarter-
over-

Quarter 
Change 

Q1 - 
March 
2022 

1000 30,000,000 100,000,000 90,000,000 
+5% Sales, 
+8% Loan 
Disbursed 

Q2 - June 
2022 

1200 35,000,000 110,000,000 95,000,000 
+20% Sales, 
+16.7% Loan 
Disbursed 

Q3 - 
September 

2022 
1150 33,000,000 105,000,000 92,000,000 

-4.2% Sales, 
-5.7% Loan 
Disbursed 

 Number of New Accounts Opened: This column tracks the total 

number of new accounts opened during the quarter. An increase in new 

accounts is a good indicator of growth and the effectiveness of 

marketing or customer outreach efforts. 

 Loan Disbursement: This column records the total loan amount 

disbursed during the quarter. A rise in disbursements indicates a 

higher demand for loans, which could be due to better financial 

conditions or successful promotional efforts. 

 Cash Flow In: This column shows the total cash inflows for the quarter, 

which may include customer deposits, loan repayments, and other 

sources of income. 
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 Cash Flow Out: This column tracks the cash outflows for the quarter, 

such as loan disbursements, operational costs, and other expenses. 

 Quarter-over-Quarter Change: This column compares the data of the 

current quarter to the previous quarter. For example, an increase of 

+20% in sales from Q1 to Q2 would indicate significant improvement in 

the business performance. 

Use of Quarterly Reports in Financial Context 

 Tracking New Accounts: By tracking the number of new accounts 

opened every quarter, businesses can measure the effectiveness of their 

marketing strategies. A rise in new accounts indicates growth, while a 

decline may prompt further investigation. 

 Loan Disbursement Status: Quarterly reports help in understanding 

the lending activity of an institution. By monitoring loan 

disbursements, businesses can assess whether the demand for loans is 

increasing or decreasing and adjust their strategies accordingly. 

 Cash Flow Monitoring: Monitoring cash flow on a quarterly basis 

helps ensure that the business maintains healthy liquidity. A 

significant drop in cash inflows or a rise in cash outflows could indicate 

potential financial issues that need immediate attention. 

 Performance Comparison: Comparing the data from one quarter to 

another helps businesses evaluate the progress toward annual goals. 

This analysis helps in identifying trends and making strategic decisions 

for the upcoming quarter. 

5. Annual Reports 

An Annual Report provides a comprehensive overview of the organization's 

performance over the course of an entire year. It is a key document used 

by businesses to evaluate their annual achievements, assess financial 

performance, and plan for the future. Annual reports help decision-

makers, stakeholders, and managers understand the long-term trends, 

challenges, and successes of the organization. In a financial context, 

annual reports track customer visits, new accounts, loan disbursements, 

and cash flow over a year, providing a broader view of the organization's 

overall performance. 

An annual report typically includes: 

 Year Ending Date: The date marking the end of the year (e.g., 

December 31) 

 Key Metrics: Data for new accounts opened, loan disbursements, cash 

inflows, and cash outflows throughout the entire year. 

 Year-over-Year Comparison: A comparison of the data with the 

previous year, showing how the business has progressed. 
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 Key Insights and Achievements: Highlights of significant milestones, 

successes, or challenges faced during the year. 

 Future Goals: Goals or strategies for the coming year based on the 

performance and data from the current year. 

Year 
Ending 

Number 
of New 

Accounts 
Opened 

Loan 
Disbursement 

(₹) 

Cash Flow 
In (₹) 

Cash Flow 
Out (₹) 

Year-over-Year 
Change 

2022 5000 120,000,000 450,000,000 400,000,000 
+10% Sales, 
+12% Loan 
Disbursed 

2023 5500 135,000,000 500,000,000 420,000,000 
+10% Sales, 
+13% Loan 

Disbursed 

 Number of New Accounts Opened: This column tracks the total 

number of new customer accounts opened throughout the year. An 

increase in the number of new accounts from 2022 to 2023 indicates 

growth and effective customer acquisition strategies. 

 Loan Disbursement: This column records the total loan amount 

disbursed over the year. An increase in disbursements suggests a 

higher demand for loans and could be indicative of an effective lending 

strategy or improved market conditions. 

 Cash Flow In: This column shows the total cash inflows for the year, 

which may include customer deposits, loan repayments, and other 

income sources. A steady increase in cash inflows indicates good 

liquidity management. 

 Cash Flow Out: This column tracks the cash outflows for the year, 

such as loan disbursements, operational expenses, and other costs. 

Maintaining a balance between inflows and outflows is essential for the 

organization’s financial health. 

 Year-over-Year Change: This column compares the data from the 

current year to the previous year. For example, an increase of 10% in 

sales from 2022 to 2023 indicates positive growth, and the loan 

disbursement has also increased by 13%, showing that the organization 

is lending more and experiencing higher demand. 

Use of Annual Report in Financial Context 

 Tracking Growth: The annual report is an important tool for 

evaluating the growth of the business. By comparing key metrics such 

as new accounts opened and loan disbursements, the report helps 

measure progress and success in achieving business goals. 

 Financial Health: The cash flow data in the annual report gives a clear 

picture of the financial health of the organization. Positive cash inflows 
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and controlled cash outflows suggest that the organization is managing 

its finances well and has enough liquidity to support its operations and 

future growth. 

 Year-over-Year Comparison: By comparing the data of the current 

year with the previous year, trends can be identified, and management 

can assess how well the business has performed in different areas, such 

as sales, customer acquisition, and loan disbursements. 

 Strategic Planning: The annual report provides key insights that are 

useful for strategic planning in the coming year. It helps in setting 

future goals and objectives, planning for expansion, and adjusting 

based on the performance of the current year. 

6. Ad-hoc Reports 

Ad-hoc reports are reports that are created on demand, as needed, to 

address specific questions or problems that arise unexpectedly. Unlike 

daily, weekly, monthly, or quarterly reports, which are regularly 

scheduled, ad-hoc reports are generated to fulfil specific requirements that 

cannot be predicted in advance. These reports are flexible and can be 

tailored to include only the data necessary to answer a particular query or 

support decision-making. In many organizations, these reports are used 

for problem-solving, investigating issues, or responding to urgent requests. 

The format of an ad-hoc report is highly flexible and depends on the 

specific need or request. However, typical elements of an ad-hoc report 

include: 

 Report Request: A clear description of the issue or question that needs 

to be addressed. 

 Data Summary: Relevant data gathered and analysed to answer the 

specific query. 

 Findings/Recommendations: Insights derived from the data, along 

with possible solutions or recommendations. 

 Conclusions: Summary of the report's findings, often with action points 

or decisions. 

Example: Imagine you work at a financial institution, and there is an ad-

hoc request to understand the loan disbursements for the last month, 

specifically to see how they compare with the previous month's data. An 

ad-hoc report can be created with the following data: 

Month Loan Disbursement (₹) Month-over-Month Change 

Nov-22 25,000,000 - 

Dec-22 28,500,000 14% 
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 Report Request: The request is made to compare the loan 

disbursements of November 2022 and December 2022 to identify if 

there was an increase or decrease in loan activity. 

 Data Summary: The data for both months is gathered, showing the 

total loan disbursement for each month. 

 Findings/Recommendations: The data is analysed, and it is found 

that loan disbursements increased by 14% in December. This suggests 

a possible growth in demand or successful marketing strategies during 

the holiday season. 

Use of Ad-hoc Reports in Financial Context 

 Responding to Urgent Requests: Ad-hoc reports are generated to 

answer specific and urgent questions that arise unexpectedly. For 

example, if there is a sudden inquiry about the loan performance or 

cash flow of a particular customer, an ad-hoc report can be created to 

address this need immediately. 

 Problem Solving: These reports are often used to analyse problems or 

investigate issues. For example, if a sudden drop in sales or customer 

satisfaction is noticed, an ad-hoc report can be created to analyse the 

underlying causes and recommend solutions. 

 Data Customization: Since ad-hoc reports are flexible, the data 

included can be tailored to address a particular question or concern. 

This makes these reports valuable when specific, detailed information 

is needed, without the need for a full, structured report. 

 Actionable Insights: Ad-hoc reports help generate insights that can 

lead to immediate actions. For example, an ad-hoc report identifying 

poor loan disbursement rates for a particular branch can prompt an 

investigation into operational issues or allow management to implement 

corrective measures quickly. 

KEY ELEMENTS OF AN MIS REPORT 

An MIS (Management Information System) report provides valuable 

information that helps in the decision-making process within an organization. 

These reports are generated regularly to summarize data, track key metrics, 

and help management understand the performance of the business. To 

ensure the report is effective, certain key elements must be included. 

1. Title: The title of an MIS report clearly indicates what the report is about. 

It should be specific and descriptive to give the reader an immediate 

understanding of the report's content. For example, a report titled “Monthly 

Sales Report” immediately lets the reader know that the report will focus 

on sales data for that particular month. 

2. Executive Summary: The executive summary provides a brief overview of 

the main findings and highlights of the report. It is usually written after 
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the report is completed but placed at the beginning. This section should 

give a quick insight into the most important data and conclusions for top 

management or decision-makers, allowing them to understand the key 

points without reading the entire report. 

3. Objectives: The objectives of the report state the reason for its creation. It 

explains what the report intends to achieve, such as tracking sales 

performance, analysing customer satisfaction, or reviewing financial 

expenses. The objective sets the tone for the report and ensures that the 

data presented aligns with the purpose of the report. 

4. Data and Metrics: This section includes the raw data collected and the 

Key Performance Indicators (KPIs) being tracked. It provides the core of the 

report, often presented in tables, graphs, or charts. The data could include 

sales figures, customer feedback, financial expenses, or production 

numbers, depending on the objective of the report. This data must be 

accurate, relevant, and organized in a way that is easy to understand. 

5. Analysis and Interpretation: After the data is presented, an analysis is 

done to explain what the data means. This section discusses trends, 

patterns, and insights observed from the data. The analysis may compare 

the current data to previous periods, set goals, or highlight areas for 

improvement. The purpose of this section is to help decision-makers 

understand the significance of the data and how it can be used to make 

decisions. 

6. Conclusions: The conclusions section summarizes the main findings from 

the report. It reflects on the analysis and presents a summary of the 

results. This section helps the reader to focus on the most important 

takeaways from the report and draws attention to any significant outcomes 

or issues. 

7. Recommendations: Based on the conclusions, recommendations are 

made to improve performance or address any issues identified. 

Recommendations should be clear, actionable, and based on the data and 

analysis. For example, if the report finds that sales are lower than expected, 

a recommendation might be to improve marketing strategies or focus on 

specific customer segments. 

8. Appendices: Appendices contain supplementary information that 

supports the report but is not included in the main body. This may include 

detailed data tables, extra charts, or information on the methodology used. 

Appendices allow the main report to remain concise while still providing 

all the necessary information for those who need it. 

9. References: If external sources have been used in preparing the report, 

references should be provided. This could include books, research papers, 

or other reports that were used to gather information. Proper referencing 

is important for acknowledging the original sources and avoiding 

plagiarism. 
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PRACTICAL EXERCISE 

Activity 1: Group discussion on how to identify Types of Reports. 

Material Required: 

 Chart Paper or Whiteboard 

 Markers/Pens 

 Printed or Displayed Sample Reports (can be simple examples showing 

Daily, Weekly, Monthly, etc.) 

 Table or chairs arranged for group seating 

Procedure: 

1. Divide students into small groups of 3-4 members each. 

2. Provide each group with sample reports (can be printed or displayed). 

3. Each group observes the report's time frame, content, and structure. 

4. Groups discuss the following questions: 

 What type of report is this? (Daily, Weekly, etc.) 

 How do you know? (Based on date range, frequency, or headings) 

 Why is this type of report useful? 

5. Each group shares their observations with the class. 

6. Teacher provides feedback, clarifies doubts, and summarizes how to 

identify different types of reports. 

7. Student prepare individual write up on what they understood by 

highlighting their learnings. 

8. Submit write to the teacher. 

Activity 2: Prepare a Simple Daily or Monthly Report. 

Material Required: 

 Excel Sheet (or plain paper if computers are not available) 

 Dataset for practice (provided below) 

 Pen/Pencil 

 Chart paper (optional for handwritten reports) 

Sample Dataset: 

Date 
New 

Accounts 

Opened 

Loan 
Disbursed (₹) 

Cash 
Inflow (₹) 

Cash 
Outflow (₹) 

01-07-2025 10 5,00,000 15,00,000 10,00,000 

02-07-2025 15 7,00,000 18,00,000 12,00,000 

03-07-2025 12 6,00,000 16,00,000 11,00,000 

04-07-2025 8 4,50,000 13,00,000 9,00,000 

05-07-2025 20 8,00,000 20,00,000 14,00,000 
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Procedure: 

1. Option A (Daily Report): Students can copy the table as it is, organize it 

neatly in Excel or paper, and add a small summary below. 

2. Option B (Monthly Report): Students should: 

 Calculate the Total New Accounts, Total Loan Disbursed, Total Cash 

Inflow, and Total Cash Outflow for all days combined. 

 Present it in a Monthly Report format: 

Month 

New 

Accounts 
Opened 

Loan 
Disbursed (₹) 

Cash Inflow 
(₹) 

Cash 
Outflow (₹) 

     

3. Students present their reports (verbally or submit for checking). 

4. Discuss and correct common mistakes if any. 

5. Teacher summarises the key points and learnings. 

Activity 3: Class Discussion on Spot the Errors – Elements of an Effective 

Report. 

Material Required: 

 Sample Report with intentional errors (provided below with intentional 

errors) 

 Whiteboard/Blackboard 

 Markers or Chalk 

 Printed or projected copy of the report for students (optional) 

Sample Report with Errors: 

Daily Report – Apana Sapana Bank Branch 

Date: 5th July 2025 

New 
Accounts 

Loan 
Disbursed 

Cash Inflow 
Cash Out 

Flow 

12 750000 1800000 1700000 

Summary: Today’s performance was good. Cash inflow and out flow is 

balanced. 

Procedure: 

1. Show the sample report to the class. 

2. Ask students to observe carefully and find errors. 

3. Encourage students to raise their hands and share the errors they notice. 

4. Write the spotted errors on the board. 

5. Correct the report: 

 Correct spellings 

 Add currency symbols (₹) 
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 Format numbers properly (7,50,000) 

 Improve the summary with clear, short sentences 

6. Quick Recap – Elements of an Effective Report.  

 Accurate headings and labels 

 Correct spelling and grammar 

 Use of currency/unit symbols 

 Proper number formatting 

 Clear, short summary or conclusion 

 Neat structure and alignment 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. MIS reports help decision-makers make __________ decisions based on 

real-time data. 

2. In an MIS report, data is summarized and presented in the form of 

__________, charts, and graphs. 

3. A __________ report helps track daily activities and operations in 

businesses like banks or financial institutions. 

4. __________ reports compare the performance of the current week to the 

previous week to track progress. 

5. The __________ section of an MIS report provides a brief overview of the 

main findings and highlights. 

B. Multiple Choice Questions (MCQs) 

1. What is the primary purpose of an MIS report? 

a)  To entertain employees 

b)  To summarize data and help in decision-making 

c)  To track employee attendance 

d)  To write company policies 

2. Which of the following is NOT typically included in a daily MIS report? 

a)  Number of new accounts opened 

b)  Cash flow in and out 

c)  Sales performance 

d)  Year-over-year change 

3. What type of report helps in evaluating long-term trends and making 

strategic decisions? 

a)  Daily report 
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b)  Monthly report 

c)  Quarterly report 

d)  Annual report 

4. Which of the following is NOT a key element of an MIS report? 

a)  Title 

b)  Executive Summary 

c)  Detailed company policies 

d)  Recommendations 

5. What is the most important function of a weekly MIS report? 

a)  To evaluate employee performance 

b)  To track day-to-day activities 

c)  To assess short-term progress and trends 

d)  To compare with monthly data 

C. State whether the following statements are True or False 

1. MIS reports are generated to track historical data and provide insights 

for future planning. 

2. Monthly reports are used to evaluate short-term progress, typically 

over the last few days. 

3. Quarterly reports are mainly used for immediate operational 

adjustments and do not track long-term goals. 

4. An annual report compares performance from one year to the next 

and helps in setting long-term goals. 

5. Ad-hoc reports are created on a regular basis and follow a set 

schedule. 

D. Short Answer Questions 

1. What are the key elements that must be included in an MIS report? 

2. Why is the “Executive Summary” section important in an MIS report? 

3. What is the difference between daily and weekly MIS reports in terms 

of content? 

4. How do quarterly reports help in tracking the performance of a 

company? 

5. What is the purpose of including recommendations in an MIS report? 

6. How can ad-hoc reports benefit an organization in times of urgent 

decision-making? 

E. Long Answer Questions 

1. Explain the role of MIS reports in decision-making and how they help 

organizations in strategic planning. 
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2. Discuss the different types of MIS reports and provide examples of 

situations where each type would be used. 

3. Describe the process of creating an MIS report using Excel. What 

features of Excel make it an effective tool for MIS reporting? 

4. How can a company use data from weekly and monthly MIS reports to 

improve its business operations and performance? 

F. Check your Performance 

1. Imagine you are working at a bank. Every day, new accounts are opened, 

cash is deposited, and loans are given. Your manager needs to check this 

information every day to make quick decisions. Which type of report will 

help your manager track this daily activity, and why is it important? 

2. The bank’s head office suddenly asks your branch to submit a report 

showing loan disbursements in the last 15 days because they noticed a 

drop-in loan number. What type of report should you prepare, and what 

key element should be included to make it effective?  
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SESSION 4: DATA VISUALISATION AND PIVOT TABLES 

Data visualization is an essential skill that allows complex data to be 

presented in a way that is easy to understand and analyse. In Excel, one of 

the most powerful tools used for this purpose is the Pivot Table. A Pivot Table 

is used to summarize, organize, and analyse large datasets, making it easier 

to observe trends, patterns, and insights. 

With Pivot Tables, data can be quickly grouped, filtered, and aggregated to 

create meaningful reports. Instead of manually calculating totals, averages, 

or percentages, Pivot Tables allow these operations to be done automatically. 

This makes it possible to work with large amounts of data in a way that would 

otherwise be time-consuming and complex. 

Pivot Tables are commonly used in various fields such as business, finance, 

and education to create Management Information System (MIS) reports, 

analyse sales performance, track inventory, and much more. They can be 

used to answer key questions like “Which products have the highest sales?”, 

“What is the average score of students across subjects?”, or “How is the cash 

flow performing over different months?” 

CREATING PIVOT TABLES 

A Pivot Table in Excel is a tool that allows large amounts of data to be 

summarized and analysed easily. With just a few clicks, a dataset can be 

transformed into an interactive report, making it easier to view and 

understand the data. In this section, we will look at how to create a Pivot Table 

step by step. 

Steps to Create a Pivot Table 

1. Select the Data Range: The first step in creating a Pivot Table is to select 

the data range that needs to be analysed. The data should be organized 

into rows and columns, and each column should have a clear heading that 

describes the data it contains. For example, if the data contains 

information about sales, the columns could be labelled as “Product”, “Sales 

Amount”, “Date”, etc. 

Product 
Sales 

Amount (₹) 
Region Date 

Product A 10,000 North 01/01/2023 

Product B 5,000 South 01/01/2023 

Product C 8,000 East 02/01/2023 

2. Insert a Pivot Table: After selecting the data, the next step is to insert the 

Pivot Table. This can be done by following these steps: 

 Click on the Insert tab in Excel's ribbon. 

 In the Tables group, click on PivotTable. 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

155 
 

 A dialog box will appear asking for the range of data. The selected range 

will be automatically filled in the dialog box. The Pivot Table can be 

placed either in a new worksheet or in an existing one. 

3. Choose Pivot Table Fields: After inserting the Pivot Table, the PivotTable 

Field List will appear on the right side of the screen. The field list contains 

all the column headings from the selected data. These fields can be dragged 

and dropped into the four areas of the Pivot Table: 

 Rows: Data placed here will be shown as rows in the Pivot Table. 

 Columns: Data placed here will be shown as columns in the Pivot Table. 

 Values: Data placed here will be summarized (e.g., summed, averaged, 

counted) in the Pivot Table. 

 Filters: Filters allow users to view specific data based on certain 

criteria. 

Example: Drag Product into the Rows area to see sales by product. 

  Drag Sales Amount into the Values area to calculate total sales. 

  Drag Region into the Columns area to see the sales in each   

region. 

4. Customize the Pivot Table: Once the Pivot Table is created, it can be 

customized: 

 Summarize Data: The Values field can be changed to display data in 

different ways. For example, the default setting is to sum the data, but 

it can also be changed to show the average, count, or percentage. 

 Sort Data: The Pivot Table data can be sorted in ascending or 

descending order to help highlight the most important data. 

 Filter Data: Add filters to the Pivot Table to view only the data that 

meets certain criteria. 

CREATING AN MIS REPORT WITH PIVOT TABLES AND VISUALS 

Step 1: Set Up the Data 

Consider a dataset that contains sales data, including product 

names, sales amounts, regions, and dates. The following dataset can 

be used as an example: 

Product Sales Amount (₹) Region Date 

Product A 10,000 North 01/01/2023 

Product B 5,000 South 01/01/2023 

Product C 8,000 East 02/01/2023 

Product A 15,000 North 03/01/2023 

Product B 12,000 South 03/01/2023 

Product C 10,000 East 04/01/2023 
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Product A 20,000 West 05/01/2023 

Product B 18,000 West 06/01/2023 

Product C 25,000 North 07/01/2023 

Step 2: Create a Pivot Table 

a) Select the Data: Highlight the entire dataset, including column 

headings. 

b) Insert Pivot Table: Go to the Insert tab on the Excel ribbon and 

click on PivotTable. Select the option to create the Pivot Table in a 

new worksheet. 

c) Choose Fields for Pivot Table: 

 Rows: Drag the Product field into the Rows section to group the 

data by product. 

 Columns: Drag the Region field into the Columns section to see 

the data by region. 

 Values: Drag the Sales Amount (₹) field into the Values section to 

calculate the total sales for each product in each region. 

 

Fig. 3.2: Sample pivot table 

Step 3: Customize the Pivot Table 

 Summarize by Sum: The default setting will sum the sales 

values. If it doesn’t, right-click the Values field, select Summarize 

Values By, and choose Sum. 

 Formatting: The numbers can be formatted to display in 

currency format for better readability. 

Step 4:  Add a Pivot Chart for Visual Representation 

 Select Pivot Table: Click anywhere inside the Pivot Table. 

 Insert Pivot Chart: Go to the Insert tab, and select a Pivot Chart 

from the Charts section. Choose a Column Chart, which is 

suitable for comparing sales across regions. 

 Customize the Chart: The chart will appear next to the Pivot 

Table. You can format the chart to enhance readability: 
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 Add chart titles, such as “Sales Performance by Product and 

Region”. 

 Label the axes (e.g., “Regions” for the X-axis and “Sales (₹)” for 

the Y-axis). 

 Use different colors for each region to make the chart visually 

appealing. 

Step 5: Visualize and Interpret the Data 

The Pivot Chart will help visualize the sales data for each product 

across different regions. Based on our dataset: 

 Product A has the highest sales in North and West regions. 

 Product B has a significant presence in the West region. 

 Product C has a balanced performance between North and East. 

 The total sales for each product across all regions can also be 

analyzed in the Pivot Table, providing an overall picture of sales 

performance. 

Step 6:  Apply Filters or Slicers (Optional) 

Filters and slicers can be used to interact with the Pivot Table and 

Pivot Chart dynamically: 

 Filters: Drag the Date field into the Filters area. This allows to 

filter the data by a specific month or time period. 

 Slicers: Add Slicers by clicking on the Insert tab, selecting Slicer, 

and choosing fields like Product or Region. Slicers provide 

buttons that allow interactive filtering of the data. 

ANALYZING AND SUMMARIZING DATASETS 

Example 1: Analysing Sales Data by Region and Product 

Dataset: Let’s consider a sales data set containing sales transactions 

for different products in various regions: 

Product 
Sales 

Amount (₹) 
Region Date 

Product A 10,000 North 01/01/2023 

Product B 5,000 South 01/01/2023 

Product C 8,000 East 02/01/2023 

Product A 15,000 North 03/01/2023 

Product B 12,000 South 03/01/2023 

Product C 10,000 East 04/01/2023 

Product A 20,000 West 05/01/2023 

Product B 18,000 West 06/01/2023 

Product C 25,000 North 07/01/2023 

Insert a Pivot Table: 

 Rows: Add Product 
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 Columns: Add Region 

 Values: Add Sales Amount and set it to Sum to calculate total sales 

by region and product 

Interpretation: 

 Product A is the highest-grossing product in both the North and 

West regions. 

 Product B has low sales in the South, but higher sales in the West. 

 Product C has strong sales in the North and East, showing a 

balanced performance across these regions. 

 The Total Sales across all regions and products amounts to 

₹141,000. 

Insights: 

 Product A has the highest overall sales, but it’s particularly 

successful in the North. 

 Product C performs well in multiple regions, indicating it may have 

a broader market appeal. 

 The South region seems to be underperforming in comparison to the 

other regions, especially for Product B. 

Example 2: Analysing Student Marks by Subject and Class 

Dataset: Let’s assume a student marks dataset from a school for 

different subjects and students across two classes. 

Student 
Name 

Math 
Marks 

English 
Marks 

Science 
Marks 

Grade 

Jay 85 90 88 11A 

Mahesh 92 88 91 11B 

Ali 80 85 90 11A 

Baban 75 78 80 11B 

Karan 90 87 95 11A 

Dhavan 82 83 89 11B 

Insert a Pivot Table: 

 Rows: Add Student Name 

 Columns: Add Subject 

 Values: Add Math Marks, English Marks, and Science Marks and set 

them to Average to calculate the average marks for each student 

across the subjects 

 Filters: Add Grade to see the data by Grade 

Interpretation: 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

159 
 

 Mahesh has the highest average marks, followed by Karan 

 Baban has the lowest average marks, particularly in Math and 

English. 

 Jay and Ali have relatively balanced scores across all subjects, with 

slightly better marks in English and Science 

Insights: 

 Mahesh seems to be performing exceptionally well in all subjects, 

achieving the highest average. 

 The lowest-performing student is Baban, whose marks in Math and 

English seem to be dragging his overall average down. 

 Based on the class filter, teachers can look at overall class 

performance in each subject and identify areas of improvement. 

APPLYING FILTERS AND SLICERS IN PIVOT TABLES 

Filters and slicers are used in Pivot Tables to help make the data more 

interactive. By applying filters and slicers, users can focus on specific parts 

of the data without altering the entire dataset. This makes it easier to analyse 

certain segments of data based on different criteria. 

Filters in Pivot Tables: Filters in a Pivot Table allow users to select specific 

data to be displayed. This can help in focusing on particular details, such as 

filtering data for a specific region or time period. 

Apply Filters: 

 After creating a Pivot Table, the PivotTable Field List will appear 

 Drag a field (e.g., Region, Date, or Product) into the Filters area 

 The Filter will appear above the Pivot Table. 

 Click on the drop-down arrow in the filter box and select the data you want 

to see. 

Steps: 

 To filter the sales data by Product B, drag Product into the Filters area. 

 Click the drop-down arrow in the filter box, and select Product B. 

 The Pivot Table will now show only the sales data related to Product B. 

Slicers in Pivot Tables: Slicers provide a more visual way to filter data. 

Slicers allow users to select categories directly from a button interface, 

making it easier to filter the data interactively. Slicers are especially useful for 

filtering data by multiple categories while keeping the structure of the Pivot 

Table unchanged. They provide an interactive way to quickly narrow down 

information, making analysis faster and more intuitive. 

Apply Slicers: 

 Click anywhere inside the Pivot Table. 
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 Go to the Insert tab on the Ribbon. 

 In the Filters group, click on Slicer 

 In the Slicer dialog box, select the field (e.g., Product, Region) you want to 

create a slicer for. 

 Click OK. 

 A slicer box will appear with buttons for each category in the selected field. 

You can click these buttons to filter the data 

Example: Applying a Slicer to Filter by Region: 

 Using the previous sales data, a Region slicer can be added to the Pivot 

Table. This slicer will allow the user to quickly filter data by region. 

 A slicer will be created with buttons like North, South, East, and West. 

 Clicking on any button (e.g., North) will instantly filter the Pivot Table to 

show only the sales data for the North region. 

 Multiple regions can also be selected at the same time to compare them. 

Benefits of Using Filters and Slicers: 

 Interactivity: Filters and slicers allow users to focus on specific parts of 

the data, making the analysis more interactive. They provide a quick way 

to explore data without changing the layout. 

 Clear and Visual: Slicers provide a more visual and user-friendly way to 

filter data compared to traditional filters. They can be particularly useful 

for presentations or when sharing reports with others. 

 Enhanced Decision-Making: Filters and slicers allow managers or 

decision-makers to view specific segments of data, making it easier to 

identify trends or spot issues in a specific area. 

PRACTICAL EXCERCISE 

Activity: Develop MIS Reports with Pivot Visuals. 

Material Required: 

 Computer or Laptop with MS Excel installed 

 Sample dataset (e.g., Sales data with Product, Region, Sales Amount) 

 Projector (optional, for class demonstration) 

 Pen and notebook for taking notes 

Procedure: 

1. Provide the Dataset i.e. share a ready-made Excel sheet with data such as 

Product, Region, Sales Amount, and Date. 

2. Ask students to open the dataset in Excel. 

3. Create a Pivot Table: 

 Highlight the entire dataset. 
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 Go to the Insert tab, click on PivotTable, and select New Worksheet. 

 Drag relevant fields: 

Product → Rows 

Region → Columns 

Sales Amount → Values (to sum total sales) 

4. Insert Pivot Chart: With the Pivot Table selected, go to the Insert tab, 

choose Pivot Chart (e.g., Bar Chart or Column Chart) to visualize the data. 

5. Customize the Report: 

 Add filters like Date if needed. 

 Format the chart (add titles, labels). 

6. Ask students to observe trends in sales by product and region using the 

chart. 

7. Discuss how such visuals help in decision-making. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks Questions 

1. Pivot Tables allow users to __________ data based on multiple fields like 

rows, columns, and values. 

2. A __________ allows the data to be analyzed dynamically by grouping 

and summarizing it. 

3. __________ are used in Pivot Tables to filter data and display only 

relevant information. 

4. A __________ chart is often used in conjunction with a Pivot Table to 

visually represent the data. 

5. The __________ section in a Pivot Table is used to place the fields you 

want to summarize, like totals or averages. 

 

B. Multiple Choice Questions (MCQs) 

1. What is the main purpose of a Pivot Table in Excel? 

a)  To create formulas automatically 

b)  To summarize and analyse large datasets 

c)  To format cells and make them look visually appealing 

d)  To create custom charts and graphs 

2. Which of the following is NOT a typical feature of a Pivot Table? 

a)  Summarizing data 

b)  Creating automated reports 

c)  Filtering data by specific criteria 
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d)  Performing data entry tasks 

3. How can Pivot Tables help businesses? 

a)  By manually entering data for analysis 

b)  By summarizing key metrics and trends for decision-making 

c)  By only providing visualizations 

d)  By storing large datasets 

4. Which chart is commonly used to visualize Pivot Table data? 

a)  Line chart 

b)  Column chart 

c)  Scatter plot 

d)  Pie chart 

5. What is the first step in creating a Pivot Table? 

a)  Inserting a Pivot Chart 

b)  Selecting the data range 

c)  Filtering the data 

d)  Grouping the data 

C. State whether the following statements are True or False 

1. Pivot Tables automatically update when new data is added to the 

dataset. 

2. You can only summarize data in Pivot Tables by summing the values. 

3. Filters and slicers allow you to view only specific parts of the data in a 

Pivot Table. 

4. Pivot Tables can only be used for numerical data and cannot be used 

for text-based fields. 

5. Once a Pivot Table is created, you cannot change the layout or 

add/remove fields. 

D. Short Answer Questions 

1. How do Pivot Tables help in summarizing large datasets? 

2. What is the difference between a row and column in a Pivot Table? 

3. What are the key steps involved in creating a Pivot Table in Excel? 

4. How do you apply filters to a Pivot Table, and why is it useful? 

5. How can a Pivot Chart enhance the visual representation of data in a 

Pivot Table? 

6. What is the use of slicers in Pivot Tables, and how do they improve user 

experience? 

E. Long Answer Questions 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

163 
 

1. Explain the process of creating a Pivot Table in Excel and how you can 

use it to analyze sales data by product and region. 

2. Discuss the advantages of using Pivot Tables over traditional manual 

data analysis techniques in business decision-making. 

3. How can Pivot Tables be used in a school setting to analyze student 

performance across different subjects and classes? Provide an example 

of how this would be set up. 

4. Describe the steps to create a comprehensive MIS report using Pivot 

Tables and Pivot Charts. Include how filters and slicers enhance the 

report’s interactivity. 

F. Check Your Performance 

1. You are given a sales dataset of different products sold across various 

regions with the following columns: 

Product Region 
Sales 

Amount (₹) 
Quantity 

Sold 

Laptop North 75,000 5 

Phone South 40,000 10 

TV East 55,000 4 

Laptop West 80,000 6 

Phone North 42,000 9 

TV South 60,000 5 

a) You need to create a Pivot Table to: Summarize the total Sales 

Amount for each Product by Region. 

 Apply a Filter to display only the “North” and “South” regions. 

 Add a Slicer to filter data by Product. 

b) How can the Pivot Table and Slicer help you quickly analyse sales 

trends for specific regions and products?  
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MODULE 4: ADVANCED EXCEL FOR ANALYSIS AND 

DASHBOARDS 

Excel is one of the most widely used tools for working with data, from simple 

calculations to complex data analysis. While basic Excel skills can help 

manage and manipulate data, advanced Excel features are crucial for 

analysing complex data sets and creating professional reports. As students 

begin working with more data in school projects or real-life scenarios, they 

may encounter large volumes of data that need to be analysed and presented 

effectively. This is where advanced Excel techniques become essential. 

Advanced Excel for Analysis and Dashboards helps users take their Excel 

skills to the next level by introducing more powerful tools for data analysis 

and visualization. This module will focus on advanced Excel functions and 

tools that allow users to gain insights from their data, summarize complex 

information, and present it in visually appealing dashboards. Dashboards are 

a combination of charts, tables, and data that are used to track key 

performance indicators (KPIs) and make decision-making easier for managers, 

analysts, and businesses. 

In today’s world, data is collected in vast amounts every day. Businesses, 

governments, and other organizations are constantly gathering data to make 

informed decisions. With Excel’s advanced features, users can quickly 

summarize large amounts of data and transform it into useful insights. For 

example, financial data, sales performance, student grades, and market 

trends can all be organized and analysed using advanced tools in Excel. This 

allows businesses and organizations to make data-driven decisions that are 

based on facts, rather than guesses or assumptions. 

This module is divided into four session viz; Session 1 deals with advanced 

lookup functions such as VLOOKUP, HLOOKUP, INDEX, and MATCH to 

perform comprehensive data searches and analysis. Session 2 focuses on the 

development of daily and weekly MIS reports using Excel functions, 

formatting tools, and visual representation techniques. Session 3 introduces 

advanced pivot table functionalities and the foundational concepts of 

dashboard design. Lastly, Session 4 culminates in the preparation of monthly 

MIS reports and the creation of basic interactive dashboards using charts, 

tables, and slicers in Excel. 
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SESSION 1: ADVANCED LOOKUP AND DYNAMIC FUNCTIONS 

In Excel, Lookup functions are essential tools used to search for specific data 

within large datasets. While basic lookup functions like VLOOKUP are 

commonly used, advanced functions provide more flexibility and accuracy, 

helping users retrieve data from multiple tables or ranges. These functions 

are especially useful in complex data analysis tasks, where quick and reliable 

data retrieval is needed. 

The functions (VLOOKUP, HLOOKUP, INDEX, and MATCH) allow users to 

search for information across rows and columns and return corresponding 

data. For example, VLOOKUP is used to search for a value in the vertical 

column of a dataset, while HLOOKUP is used for horizontal searches. On the 

other hand, INDEX and MATCH can be combined for more flexibility, allowing 

for lookups in both rows and columns and even handling more complex 

scenarios. 

ADVANCED VLOOKUP AND HLOOKUP  

In Excel, VLOOKUP and HLOOKUP are commonly used functions to search 

for a specific value in a range and return related information. These functions 

can perform an exact match or an approximate match. When performing an 

approximate match, Excel finds the closest value that is less than or equal to 

the lookup value. This type of match is useful when working with ranges, such 

as tax brackets, grading systems, or commission tables. 

A. Advanced VLOOKUP 

The VLOOKUP function in Excel is a versatile tool used to search for a 

specific value in the first column of a dataset and return corresponding 

data from another column in the same row. While the basic usage of 

VLOOKUP is effective for straightforward lookups, several advanced 

techniques can enhance its flexibility and performance. These advanced 

features allow for dynamic column references, error handling, approximate 

matching, and integration with forms and data validation tools.  

Let’s explore these advanced features of VLOOKUP with step-by-step 

examples. Consider the dataset given below: 

Student Name Math Score Grade 

Jay 85 B 

Era 92 A 

Vijay 76 C 

Lila 88 B 

Manu 95 A 

Raju 80 B 
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1. Approximate Match (TRUE):  By default, VLOOKUP searches for an exact 

match. However, it can also be used to find an approximate match when 

the values in the first column are sorted. This approach is useful in 

scenarios such as grading scales or tax brackets, where data is organized 

into defined ranges. 

Example: Find the grade of a student with a Math Score of 80, using the 

approximate match to find the closest lower score. 

Formula: =VLOOKUP (80, B2:C7, 2, TRUE) 

 80: The score that needs to be searched. 

 B2:C7: The range of data (Math Score and Grade columns). 

 2: The column number (Grade column) from which the result will be 

returned. 

 TRUE: This tells Excel to find the closest match that is less than or 

equal to 80. 

In a table with student scores, this formula would return B for Raju since 

80 is closest to his score, and he has a grade B. 

2. Dynamic Column Index Using MATCH: When the column from which 

data must be retrieved changes frequently, the MATCH function can be 

used to determine the column number dynamically. This approach 

eliminates the need to manually update the column index in the VLOOKUP 

function, ensuring greater flexibility and accuracy in data retrieval. 

Example: Find the Grade of a student using a dynamic column index (if 

the column header changes). 

Formula: =VLOOKUP (“Era”, A2:C7, MATCH ("Grade”, A1:C1,0), FALSE) 

 “Era”: The student’s name that needs to be searched. 

 A2:C7: The range to search through. 

 MATCH (“Grade”, A1:C1, 0): This function finds the column index of the 

“Grade” column by matching the header name. 

 FALSE: Exact match for the student name. 

This formula will return A because it looks up Era’s grade in the Grade 

column. 

3. Error Handling with IFERROR / IFNA: When using VLOOKUP, an error 

such as #N/A may appear if the lookup value is not found. This can be 

avoided by wrapping the formula with IFERROR or IFNA to return a custom 

message (like “Not Found”) instead of showing the error. 

Example: If a student named Ravi is not found, display “Student Not 

Found” instead of an error. 
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Formula: = IFERROR (VLOOKUP (“Ravi”, A2:C7,2, FALSE), “Student Not 

Found”) 

 VLOOKUP (“Ravi”, A2:C7,2, FALSE): The basic VLOOKUP to search for 

David’s grade. 

 IFERROR: If the VLOOKUP returns an error (because Ravi isn’t found), 

it will display “Student Not Found”. 

This formula will return “Student Not Found” if Ravi is not in the dataset. 

4. Using Named Ranges for Flexibility: Named ranges make formulas 

easier to understand and manage by assigning a meaningful name to a 

group of cells.  

Example: Use Named Ranges to make your VLOOKUP formula simpler. 

Create a Named Range: (Fig. 4.1) 

 Select the range of cells (e.g., A2:B6). 

 Go to the Formulas tab → click Define Name. 

 Type a name (e.g., Student Data) and click OK. 

 

Fig. 4.1: Create a Named Range 

Formula: =VLOOKUP (“Lila”, StudentData,2, FALSE) 

 Student Data: This is the name of the range assigned to the table A2:C7. 

 “Lila”: The student’s name being searched. 

 3: The column number where the grade is located. 

 FALSE: Exact match for Lila’s name. 

This formula will return B, which is Lila’s grade. 

5. Embedding VLOOKUP in Data Validation / Forms: VLOOKUP can be 

combined with Data Validation to create drop-down lists that change 
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dynamically based on another cell’s value. This is helpful when building 

interactive forms or dashboards where choices depend on earlier 

selections. 

Example: Use VLOOKUP in Data Validation to create a dynamic drop-

down list for students based on the selected category. 

Create a Drop-Down List (Data Validation): (Fig. 4.2) 

 Select a cell (e.g., D2) for student selection. 

 Go to Data → Data Validation → List. 

 In the source box, enter: =A2:A6. 

 

Fig. 4.2: Create a Drop-Down List (Data Validation) 

Formula: =VLOOKUP (D2, A2:C7,3, FALSE)  

 D2: The cell used to select the category (e.g., a student’s name). 

 A2:C7: The range containing data (Student Names and Grades). 

 3: The column index to return the grade. 

This formula helps to create a drop-down list where you select a student, 

and the corresponding grade is automatically filled in. 

6. VLOOKUP with Wildcards: Wildcards allow VLOOKUP to perform partial 

matches. The asterisk (*) represents any number of characters, and the 

question mark (?) represents a single character. 

    Example: Find a student whose name contains the letter L. 

Formula: =VLOOKUP (“*L*”, A2:C7, 3, FALSE) 
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 “*L*”: The asterisk * allows any number of characters before and after 

the letter L, so it will match any name with “L” in it. 

 A2:C7: The range to search. 

 3: The column index for Grade. 

 FALSE: Exact match for the letter "L". 

This formula will return B for Lily, since her name contains the letter L. 

B. Advanced HLOOKUP in Excel 

The HLOOKUP function in Excel works similarly to VLOOKUP, with the 

key difference being the direction of the search. While VLOOKUP searches 

down columns, HLOOKUP searches across rows to locate a specific value 

and return data from a specified row. 

Beyond basic lookups, HLOOKUP offers several advanced features that 

improve its flexibility and functionality. These include approximate 

matches, dynamic row references using formulas like MATCH, error 

handling with IFERROR, and integration with named ranges for easier 

management. These techniques are particularly useful when working with 

horizontal data layouts. 

Let’s consider the following dataset: 

Student Name Jay Era Vijay Lila Manu Raju 

Math Score 85 92 76 88 95 80 

Grade B A C B A B 

1. Approximate Match in Graded Scenarios: The HLOOKUP function can 

be used for approximate matches, especially when working with graded 

data like score bands, tax brackets, or rating systems organized 

horizontally across rows. When the data is sorted in ascending order, 

HLOOKUP can return the best fit based on the closest lower value. 

Example: Find the grade for a score of 80, using the approximate match 

to find the closest lower score, but applied across rows. 

Formula: =HLOOKUP (80, B2:G3,2, TRUE) 

 80: The score that needs to be searched. 

 B2:G3: The range of data (with scores in the first row and corresponding 

grades in the second row). 

 2: The row number (Grade row) from which the result will be returned. 

 TRUE: This tells Excel to find the closest match that is less than or 

equal to 80. 

If you have a table where the first row contains different scores and the 

second row contains corresponding grades, this formula will return B for 

a score of 80. 
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2. Dynamic Row Index Using MATCH: The MATCH function can be 

combined with HLOOKUP to dynamically identify the row number from 

which to retrieve data. This is especially helpful when working with large 

datasets or when the structure changes frequently. Using MATCH avoids 

hardcoding the row index in the HLOOKUP formula. 

Example: Find the Grade of a student using a dynamic row index (if the 

row header changes). 

Formula: =HLOOKUP (“Era”, B1:G3, MATCH (“Grade”, A1:A3,0), FALSE) 

 “Era”: The student’s name that needs to be searched in the row. 

 B1:G3: The range to search through. 

 MATCH (“Grade”, A1:A3,0): This function dynamically finds the row 

index where the “Grade” is located by matching the header name. 

 FALSE: Exact match for the student name. 

This formula will return the grade for Era by searching across rows and 

matching her name to the Grade row. 

3. IFERROR with HLOOKUP:  The HLOOKUP function can return errors like 

#N/A when the lookup value is not found. To manage these situations 

more effectively and avoid confusing error messages in a report or 

dashboard, the IFERROR function can be used. 

IFERROR allows defining a fall-back message or value if the lookup fails. 

Example: If a student named Ravi is not found, display “Student Not 

Found” instead of an error. 

Formula: =IFERROR (HLOOKUP (“Ravi”, B1:G3,3, FALSE), “Student Not 

Found”) 

 HLOOKUP (“Ravi” A1:G3,3, FALSE): The basic HLOOKUP function to 

search for Ravi’s grade across rows. 

 IFERROR: If the HLOOKUP returns an error (because David isn’t 

found), it will display “Student Not Found”. 

This formula will return “Student Not Found” if Ravi is not found in the 

dataset. 

INTRODUCTION TO INDEX AND MATCH FUNCTIONS 

In Excel, the INDEX and MATCH functions are powerful tools used for data 

lookup and retrieval. While VLOOKUP and HLOOKUP are commonly used to 

search for values in rows and columns, INDEX and MATCH offer greater 

flexibility and versatility. These two functions are often used together, but 

they can also be used separately to perform complex lookups and data 

retrieval. 

INDEX Function 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

171 
 

The INDEX function returns the value of a cell in a specific row and column 

within a range. Unlike VLOOKUP or HLOOKUP, the INDEX function does not 

require the lookup value to be in the first row or column, making it more 

flexible in dealing with large datasets. 

Syntax: = INDEX (array, row num, [column num]) 

 array: The range of cells containing the data. 

 row_num: The row number from which to retrieve the value. 

 [column_num]: (optional) The column number from which to retrieve the 

value. This is required if the array contains multiple columns. 

The MATCH Function 

The MATCH function searches for a specified value in a range and returns the 

relative position of that value within the range. It can be used to find the row 

number or column number of a value within a range, which can then be used 

in combination with the INDEX function. 

Syntax: =MATCH (lookup value, lookup array, [match type]) 

 lookup_value: The value to search for. 

 lookup array: The range of cells to search within. 

 [match type]: This can be set to 1 for an approximate match (largest 

value less than or equal to the lookup value), 0 for an exact match, or -1 

for the smallest value greater than or equal to the lookup value. 

Advantages of INDEX and MATCH Functions 

 Flexibility: Unlike VLOOKUP or HLOOKUP, INDEX and MATCH can 

search for values in any column or row, even when the lookup value is not 

in the first column or row of the dataset. 

 Efficiency: INDEX and MATCH are often faster and more efficient, 

especially when working with large datasets. This is because they do not 

need to search the entire range from left to right (or top to bottom). 

 More Control: With INDEX and MATCH, users can specify exactly which 

row and column to retrieve data from, giving them more control over the 

lookup process. 

 Avoiding Limitations: VLOOKUP is limited in that it can only search for 

values in the leftmost column of the table. INDEX and MATCH do not have 

this limitation, which makes them more versatile for complex data analysis 

tasks. 

Using INDEX Function (Without MATCH) 

Let’s start by using the INDEX function alone to retrieve a value from a specific 

cell in a dataset. 
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Product Price (₹) Quantity 

Product A 50 100 

Product B 30 200 

Product C 40 150 

To retrieve the Price of Product B using INDEX, apply the following formula: 

=INDEX (B2:B4, 2) 

 B2:B4 is the array containing the price values. 

 2 is the row_num where Product B's price is located (the second row in 

the range). 

 Result: The formula will return 30, which is the price of Product B. 

Using MATCH Function (Without INDEX) 

The MATCH function can be used to find the position of a value within a range. 

For example, to find the position of Product C in the Product column, apply 

the following formula: 

=MATCH (“Product C”, A2:A4, 0) 

 “Product C” is the lookup_value. 

 A2:A4 is the lookup array where the product names are listed. 

 0 indicates that we are looking for an exact match. 

 Result: The formula will return 3, which means Product C is in the third 

position in the range. 

Combining INDEX and MATCH Functions 

While the INDEX and MATCH functions can be used separately, they are often 

combined for more flexible lookups. The MATCH function can return the row 

number (or column number) that is then used by the INDEX function to 

retrieve the value. 

Let’s use the INDEX and MATCH functions together to retrieve the Price of 

Product C from the table: 

=INDEX (B2:B4, MATCH ("Product C", A2:A4, 0)) 

 MATCH (“Product C”, A2:A4, 0) will return 3, which is the row number 

where Product C is located. 

 INDEX (B2:B4, 3) will then retrieve the value from the third row of the 

Price column, which is 40. 

 Result: The formula will return 40, which is the price of Product C. 

PRACTICAL EXERCISE 

Activity 1: Perform advanced applications of VLOOKUP and HLOOKUP in 

Excel. 
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Material Required: 

 Computer or Laptop with Microsoft Excel installed 

 Pen and notebook (for noting formulas if required) 

 Excel Worksheet containing the following two datasets: 

Dataset 1: Student Scores and Grades  

Student Name Math Score English Score Science Score Grade 
 

Jayesh 85 78 92 B  

Era 92 89 94 A  

Sanjay 76 81 70 C  

Lily 88 85 90 B  

Mahesh 95 94 98 A  

Vinay 80 82 88 B  

 

Dataset 2: Monthly Region-Wise Performance 

Month North South East West Central 

January 75 82 68 90 85 

February 78 85 72 88 87 

March 80 90 75 92 89 

April 85 88 80 95 90 

Procedure: 

1. Open Excel and type the Student Scores and Grades (Dataset 1) in the cells 

from A1 to E7. 

2. Click on any empty cell and enter the VLOOKUP formula to find Vinay’s 

Math Score. 

3. Type Monthly Region-Wise Performance (Dataset 2) in the cells from A9 to 

F13. 

4. Click on an empty cell and enter the HLOOKUP formula to find the 

performance for East Region in March. 

5. Create a drop-down for Student Names in cell G1. 

6. Display Math Score of selected students: Enter the formula in G2. 

7. Display performance in March for that student’s row index. Enter the 

formula in G3. 

8. Show it to the teacher. 

Activity 2: Find the Price of a Product using INDEX and MATCH. 

Material Required: 

 Computer or laptop with MS Excel installed 
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 Pen and notebook for rough work (optional) 

 Excel worksheet with the following table: 

Product Name Price (₹) 

Product A 150 

Product B 200 

Product C 300 

Product D 250 

Procedure: 

1. Open Excel and enter the data in two columns: 

 Column A: Product Name (A2 to A5) 

 Column B: Price (B2 to B5) 

2. In any empty cell (e.g., D2), type the formula using MATCH to find the row 

number of Product C. 

3. In the next cell (e.g., D3), use INDEX to find the price using the row 

number. 

4. Now, combine INDEX and MATCH in a single formula to make it dynamic. 

5. Press Enter. 

6. Try changing “Product C” to another product name in the formula to test 

different results. 

7. Show it to the teacher. 

Activity 3: Find the Department of an Employee using INDEX and MATCH. 

Material Required: 

 Computer or laptop with MS Excel installed 

 Pen and notebook for rough work (optional) 

 Excel worksheet with the following table: 

Employee Name Department Salary (₹) 

Aman HR 50,000 

Baban IT 60,000 

Charan Finance 70,000 

Dhavan Marketing 55,000 

Procedure: 

1. Open Excel and enter the data into three columns: 

 Column A: Employee Name (A2 to A5) 
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 Column B: Department (B2 to B5) 

 Column C: Salary (C2 to C5) 

2. To find the department of Baban, we will use MATCH to find the row 

number of his name. 

3. In an empty cell (e.g., E2), type the formula. 

4. Now use the INDEX function to retrieve the department from Column B. 

5. Now, combine the two functions in a single formula. 

6. Press Enter. 

7. Try changing “Baban” to another employee's name in the formula to test 

different results. 

8. Show it to the teacher. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks Questions 

1. The function __________ is used to search for a value in the first column 

of a table and return a corresponding value from a different column. 

2. In the INDEX function, the __________ argument refers to the row 

number from which to retrieve the value. 

3. The __________ function searches for a value in the first row of a table 

and returns a corresponding value from a different row. 

4. The __________ function can be combined with INDEX to provide a more 

flexible way to perform lookups in Excel. 

5. The VLOOKUP function with an approximate match requires the 

__________ argument to be set to TRUE. 

B. Multiple Choice Questions 

1. Which function can be used to find the position of a value within a 

range? 

a)  VLOOKUP 

b)  INDEX 

c)  MATCH 

d)  HLOOKUP 

2. What does the range lookup argument in VLOOKUP do when set to 

TRUE? 

a)  Performs an exact match 

b)  Performs an approximate match 

c)  Returns an error 

d)  Ignores the match 
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3. Which function would you use to retrieve a value based on a specific 

row and column from a range? 

a)  INDEX 

b)  MATCH 

c)  VLOOKUP 

d)  HLOOKUP 

4. Which function allows you to perform a lookup in a horizontal table? 

a)  VLOOKUP 

b)  HLOOKUP 

c)  INDEX 

d)  MATCH 

5. What is the advantage of using INDEX and MATCH together? 

a)  They only work with vertical data 

b)  They allow more flexibility than VLOOKUP or HLOOKUP 

c)  They are slower than VLOOKUP and HLOOKUP 

d)  They require fewer arguments than VLOOKUP and HLOOKUP 

C. State whether the following statements are True or False 

1. VLOOKUP can only perform lookups in vertical columns, not horizontal 

rows. 

2. HLOOKUP is used to find a value in the first column of a table. 

3. INDEX and MATCH can be used together to perform more complex 

lookups than VLOOKUP. 

4. The MATCH function returns the actual value of the matched item, not 

its position. 

5. VLOOKUP with approximate match can return values that are greater 

than the lookup value. 

D. Short Answer Questions 

1. What is the difference between VLOOKUP and HLOOKUP in Excel? 

2. How can you use the MATCH function to find the row number of a 

specific item? 

3. What are the advantages of combining INDEX and MATCH over using 

VLOOKUP? 

4. What does the range lookup argument in VLOOKUP do, and when 

should it be set to TRUE? 

5. How can INDEX and MATCH functions be used together to perform a 

lookup across both rows and columns? 

E. Long Answer Questions 
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1. Discuss the steps to perform an approximate match lookup using 

VLOOKUP and HLOOKUP with examples. Include a scenario where this 

feature would be helpful. 

2. Compare and contrast the VLOOKUP and HLOOKUP functions. Discuss 

their limitations and how INDEX and MATCH can be used to overcome 

these limitations. 

3. Explain how the INDEX and MATCH functions can be used together to 

look up data from non-adjacent columns. Provide an example scenario 

where this would be beneficial. 

4. Describe a business scenario where you would use VLOOKUP with 

approximate match, and how it could simplify your data analysis. 

Explain the formula used in this case. 

F. Check Your Performance 

1. You are working with the following dataset of employees and their 

monthly bonuses. Use your knowledge of Advanced 

VLOOKUP/HLOOKUP, INDEX and MATCH, and their combination to 

answer the question. 

Employee ID Name Department Bonus (₹) 

E101 Arya HR 5,000 

E102 Bharat IT 6,000 

E103 Charu Finance 7,000 

E104 Dinesh Marketing 5,500 

Using Excel, retrieve the Bonus amount for the employee named Charu 

using: 

a) Advanced VLOOKUP (with dynamic column index) 

b) INDEX and MATCH combination 
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SESSION 2: MIS REPORTS USING EXCEL 

Management Information Systems (MIS) reports are essential tools used by 

businesses and organizations to collect, organize, and analyse data. These 

reports help decision-makers by presenting key metrics and performance 

indicators in a clear and structured format. In today’s data-driven world, MIS 

reports are vital for monitoring business performance, making informed 

decisions, and planning future strategies. 

KEY PERFORMANCE INDICATORS FOR DAILY AND WEEKLY REPORTS 

Key Performance Indicators (KPIs) are metrics used to measure the 

performance of a specific activity, process, or goal. They help track progress, 

identify trends, and make data-driven decisions. In an MIS report, KPIs 

provide a quick snapshot of how well a business, department, or team is 

performing. 

Daily Reports - Key Performance Indicators 

For daily reports, KPIs help track activities that need to be measured every 

day, providing a snapshot of how things are progressing. Daily reports are 

often used to track short-term goals and monitor day-to-day operations. 

Common KPIs for Daily Sales Reports might include: 

 Total Sales: The total revenue generated from all sales on that specific 

day. 

 Number of Transactions: The total number of sales made during the day. 

 Average Sale Value: The average amount spent per customer transaction. 

 Sales by Product or Category: The sales performance of individual 

products or categories on that day. 

 New Customers Acquired: The number of new customers added or signed 

up. 

Part 1: Creating the Daily Sales Report 

Step 1: Open Excel 

Open Microsoft Excel and start with a new worksheet. 

Name the worksheet as “Daily Sales Report”. 

Step 2: Enter the Sample Data 

In cells A1 to D1, enter the headers for the dataset: Product, 

Quantity Sold, Unit Price (₹), and Total Sales (₹). 

Fill in the data below the headers (rows 2 to 5) based on the 

following sample data: 

Product Quantity Sold Unit Price (₹) Total Sales (₹) 

Product A 10 100 1000 
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Product B 15 150 2250 

Product C 5 200 1000 

Product D 12 120 1440 

  Calculate Total Sales per Product 

In Column D (Total Sales), the formula should multiply the 

Quantity Sold by the Unit Price. 

For Product A, enter the formula in D2: 

=B2*C2 

Drag the formula down to fill the Total Sales for the other 

products. 

Step 3: Create a Pivot Table to Summarize Data 

Select the entire data range (A1 to D5). 

Go to the Insert tab in the Ribbon and click on PivotTable. 

In the Create PivotTable dialog box, select New Worksheet and 

click OK 

In the PivotTable Field List, drag the following: 

Product to the Rows area. 

Total Sales to the Values area. This will automatically sum the 

sales for each product. 

Step 4: Create a Bar Chart to Visualize Sales 

Select the Pivot Table. 

Go to the Insert tab and click on Bar Chart. 

Choose a Clustered Bar Chart. 

Format the chart by adding a Chart Title like “Total Sales by 

Product”. 

Step 5: Final Touches 

Make sure all the data and charts are neatly aligned. 

Review the Pivot Table and ensure that it is summarizing the total 

sales per product correctly. 

Part 2: Creating the Weekly Performance Report 

A. Open a New Worksheet 

Open a new worksheet and name it “Weekly Performance Report”. 

B. Enter the Sample Data 
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In Cells A1 to E1, enter the following headers: Week, Sales (₹), 

Customers Acquired, Expenses (₹), and Employee Rating. 

Fill in the data from the following sample dataset: 

Week Sales (₹) 
Customers 

Acquired 

Expenses 

(₹) 

Employee 

Rating 

Week 1 50,000 200 20,000 4.5 

Week 2 55,000 220 22,000 4.7 

Week 3 45,000 180 18,000 4.6 

Week 4 60,000 250 25,000 4.8 

C. Calculate Weekly Sales Growth 

In column F (Weekly Sales Growth), calculate the growth in sales 

compared to the previous week. The formula for Week 2 would 

be: 

= (B3-B2)/B2 

Format the result as a percentage. Copy the formula for the other 

weeks. 

D. Calculate Customer Retention Rate (Optional) 

In column G (Customer Retention), you can calculate the 

retention rate by comparing the current week’s customers with 

the previous weeks. The formula could be: 

=C3/C2 

This will give the percentage of customers retained compared to 

the previous week. 

E. Create a Pivot Table to Summarize Data 

Select the data range (A1 to E5). 

Insert a Pivot Table to summarize sales, customers, and 

expenses. 

In the PivotTable Field List: 

Drag Week to the Rows area. 

Drag Sales (₹), Customers Acquired, and Expenses (₹) to the 

Values area. 

This will give you the totals for each metric for each week. 

F. Create a Line Chart to Show Sales Growth 

Select the data range for Sales (₹) and Weekly Sales Growth. 

Go to the Insert tab and select Line Chart. 
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Format the chart by adding a Chart Title, such as “Weekly Sales 

Growth” or “Sales and Growth Overview”. 

EXCEL FORMULAS AND FUNCTIONS TO CALCULATE KPIS 

Microsoft Excel is a powerful tool for calculating and analysing Key 

Performance Indicators (KPIs) in both daily and weekly reports. By using built-

in formulas and functions, businesses can turn raw data into meaningful 

insights. Excel helps in automating calculations, summarizing large datasets, 

and presenting performance metrics clearly. Whether it's tracking sales, 

monitoring employee attendance, or measuring productivity, Excel functions 

like SUM, AVERAGE, COUNTIF, IF, and VLOOKUP make it easier to calculate 

and display KPIs efficiently. These tools support data-driven decisions and 

improve overall operational performance. Below is the example to understand: 

Product 
Quantity 

Sold 

Unit 

Price (₹) 

Total 

Sales (₹) 

Week 1 

Sales (₹) 

Week 2 

Sales (₹) 

Product A 10 100 1000 20,000 22,000 

Product B 15 150 2250 25,000 27,000 

Product C 5 200 1000 10,000 12,000 

1. Total Sales: Total Sales is a KPI that shows the total revenue generated 

from all products. It is calculated by multiplying the Quantity Sold by the 

Unit Price for each product. 

Formula: = Quantity Sold * Unit Price 

For Product A: 

= B2 * C2 

= 10 * 100 = 1000 

The Total Sales for Product A is calculated by multiplying the Quantity 

Sold (10) with the Unit Price (₹100), resulting in ₹1000. 

For the rest of the products, follow the same process. 

2. Sales Growth Rate: Sales Growth Rate measures the percentage change 

in sales between Week 1 and Week 2. It tells you how much sales have 

increased or decreased over a specific period. 

Formula: = (Week 2 Sales - Week 1 Sales) / Week 1 Sales * 100 

For Product A: = (E2 - D2) / D2 * 100 

= (22,000 - 20,000) / 20,000 * 100 

= 10% 
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The formula calculates the difference between Week 2 Sales and Week 1 

Sales, divides that by Week 1 Sales, and multiplies by 100 to get the 

percentage growth. 

For other products, the same formula can be used to calculate the Sales 

Growth Rate. 

Average Sales: The Average Sales KPI helps measure the mean of the Total 

Sales over a given period. This is useful to understand how sales are 

performing on average for each product. 

Formula: =AVERAGE (Sales Data Range) 

For all products: =AVERAGE (D2:D4) 

   = (1000 + 2250 + 1000) / 3 

   = 1,083.33 

The AVERAGE function calculates the average of Total Sales values for 

Product A, Product B, and Product C. 

3. Customer Retention Rate: Customer Retention Rate is used to track how 

many new customers continue to buy from you in the following period. 

This KPI is often used in businesses to understand customer loyalty. 

Formula: = (Retained Customers / Total Customers) * 100 

For Product A: = (C2 / D2) * 100 

= (150 / 350) * 100 

= 42.86% 

The Customer Retention Rate is calculated by dividing the number of 

retained customers (150) by the total number of customers (350), then 

multiplying by 100 to get a percentage. 

4. Profit Margin: Profit Margin is a KPI that indicates the percentage of profit 

generated from sales. It is calculated by dividing the Net Profit by the 

Revenue and multiplying by 100. 

Formula: = (Net Profit / Revenue) * 100 

For Product A: = (5000 / 25000) * 100 

= 20% 

The Profit Margin for Product A is calculated by dividing Net Profit (₹5000) 

by Revenue (₹25000) and multiplying by 100 to get the percentage. 

5. Employee Performance: This KPI measures how well an employee or team 

has performed against their targets. It is calculated by dividing Completed 

Tasks by Total Tasks. 
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Formula: = (Tasks Completed / Total Tasks) * 100 

For Employee A: = (B2 / C2) * 100 

   = (18 / 20) * 100 

   = 90% 

The Employee Performance is calculated by dividing the completed tasks 

(18) by the total tasks assigned (20), then multiplying by 100 to get a 

percentage of performance. 

6. Count of Transactions: This KPI counts how many transactions or sales 

have occurred, helping businesses track the number of purchases or sales 

made. We can use the COUNT function for this. 

Formula: =COUNT (Sales Data Range) 

For Total Transactions: =COUNT (D2:D4) 

The COUNT function counts the number of numeric values in the Total 

Sales column to get the number of transactions. 

Developing a Weekly Performance report for a department:  

Week 
Sales 

(₹) 

New 

Customers 

Returning 

Customers 

Total 

Customers 

Employee 

Rating 

(Out of 5) 

Expenses 

(₹) 

Weekly 

Growth 

(%) 

Week 1 50,000 100 50 150 4.2 10,000 - 

Week 2 55,000 120 60 180 4.5 12,000 10% 

Week 3 45,000 90 70 160 4 11,000 -18% 

Week 4 60,000 130 80 210 4.7 14,000 33% 

Step 1: Enter the Data in Excel 

Open Excel and create a new worksheet. 

Label the columns as shown in the sample dataset: Week, Sales 

(₹), New Customers, Returning Customers, Total Customers, 

Employee Rating, Expenses (₹), and Weekly Growth (%). 

Enter the weekly data for each column. 

Step 2: Calculate Weekly Growth Rate 

The Weekly Growth Rate KPI tracks the change in sales from one 

week to the next. It is calculated as: 

Formula: = (Current Week Sales - Previous Week Sales) / 

Previous Week Sales * 100 

For Week 2: = (B3 - B2) / B2 * 100 

= (55,000 - 50,000) / 50,000 * 100 

= 10% 
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Repeat this calculation for the subsequent weeks (Week 3, Week  

4). 

Step 3: Calculate Total Customers 

The Total Customers KPI shows the sum of New Customers and 

Returning Customers each week. 

Formula: = New Customers + Returning Customers 

For Week 1: = C2 + D2 

= 100 + 50 = 150 

Repeat this calculation for all other weeks. 

Step 4: Calculate Employee Performance (Average Rating) 

The Employee Rating KPI evaluates the performance of sales 

employees based on the weekly rating. For each week, input the 

Employee Rating on a scale from 1 to 5 

No formula is needed here, but ensure the ratings reflect the 

performance. 

Step 5: Create the Pivot Table for Summary 

Select the entire data range (A1:H5). 

Go to the Insert tab and click on Pivot Table. 

In the PivotTable Field List, add: 

Week to the Rows section. 

Sales (₹), Total Customers, Weekly Growth (%), and Employee 

Rating to the Values section. 

This will summarize the key data for each week and allow you to 

quickly compare performance. 

Step 6: Create a Chart to Visualize Data 

Highlight the Sales (₹) and Weekly Growth (%) data. 

Go to the Insert tab and select a Line Chart or Column Chart. 

Add a Chart Title such as "Weekly Sales Performance and 

Growth" to give context to the chart. 

Summary of Weekly Performance Report: 

 Sales Growth: The Weekly Growth Rate KPI shows how sales increased 

(or decreased) compared to the previous week. For example, Week 2 had a 

10% increase, while Week 3 experienced an 18% decrease. 
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 Customer Metrics: The Total Customers KPI shows the growth in 

customers over the weeks. The sales team is acquiring more customers, 

but Week 3 had fewer new customers compared to Week 2. 

 Employee Rating: The Employee Rating KPI reflects the performance of 

sales employees based on their ratings. A high rating of 4.7 in Week 4 

shows that employee performance is improving. 

 Expenses: The Expenses data helps monitor how much the department is 

spending each week. Expenses in Week 4 were the highest, so it’s 

important to check if they align with sales growth. 

FORMATTING AND PRESENTATION OF DATA 

When preparing reports in Excel, clarity and organization are key to ensuring 

the information is easily understood and useful for decision-making. Properly 

formatted reports help users quickly extract meaningful insights, identify 

trends, and make informed decisions.   

Formatting Reports for Clarity 

Formatting Excel reports properly makes the data more readable and helps 

highlight key information. Clear formatting also prevents confusion and 

makes it easier for the reader to understand the data. Following points should 

have considered at the time of formatting. 

 Use Proper Headings: Always include clear headers for each column and 

row. The headings should be brief but descriptive enough for users to 

understand what data is in each section. 

Example: Instead of “Product 1”, use “Product Name”. 

 Bold Headers: Bold the headers so they stand out and make it easier for 

users to identify the sections. 

 Align Text Properly: Align numeric data to the right and text to the left. 

This is the standard format in Excel, making it easier to read. 

 Use Borders: Add borders around the data to distinguish between different 

sections and improve readability. 

 Apply Cell Shading: Use shading to highlight important data or 

differentiate between different sections. For example, use light grey to 

highlight totals or subtotals. 

 Font Size and Colour: Use a readable font size (usually 10 or 12) and 

avoid using too many different font styles. Use colour sparingly to highlight 

key data. 

For example: 

Product Units Sold Price (₹) Total Sales (₹) 

Product A 10 100 1000 

Product B 15 150 2250 
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Product C 20 200 4000 

Total 45  7250 

In the above sample table: 

The headers are bold. 

The Total Sales row is highlighted with a bold font and shaded 

background for clarity. 

The total units sold is placed in the last row to summarize the data. 

Presenting Data in Tables 

Tables are one of the best ways to organize data because they help to structure 

it neatly and clearly. Excel allows users to create structured tables, which 

provide built-in functionalities like sorting, filtering, and better organization. 

Creating a Table in Excel: 

 Select the data range to be converted into a table. 

 Go to the Insert tab in the ribbon and click on Table. 

 Ensure that the “My table has headers” box is checked. 

 Excel will automatically apply a table format making the data easier to 

manage and analyse. 

Benefits of Using Tables: 

 Easier Data Management: Tables help manage large datasets and 

perform calculations more easily using structured data. 

 Automatic Formatting: Excel automatically applies alternating row 

colours (banded rows), making it easier to read. 

 Sorting and Filtering: Data within a table can be easily sorted and 

filtered, allowing quick analysis of specific data points. 

Using Appropriate Charts:  

Charts are powerful tools for presenting data visually, helping to identify 

trends, patterns, and comparisons easily. Choosing the right chart is 

important, as it directly affects how well the data is communicated. Below are 

the types of charts and their appropriate uses: 

a) Column or Bar Charts: Use to compare categories, such as sales across 

different products or performance metrics. 

Example: A Column Chart to compare the total sales of different products. 

b) Line Charts: Best for showing trends over time (e.g., sales growth over 

several months). 

Example: A Line Chart to show the monthly sales trend. 

c) Pie Charts: Great for showing the proportion of each category in relation 

to the whole (e.g., market share of different products). 
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Example: A Pie Chart to show the distribution of sales among different 

products. 

d) Scatter Charts: Use when comparing two sets of data to find relationships 

or correlations. 

Example: A Scatter Chart to show the relationship between units sold and 

total sales. 

Example: Using a Column Chart to Show Sales by Product. 

 Select the data to be used for the chart. (for example, Product Name 

and Total Sales).  

 Go to the Insert tab, and under Charts, select Column Chart. 

 A Column Chart will appear, showing the total sales for each product. 

 Customize the chart by adding a title, adjusting axis labels, or changing 

the colours for better presentation. 

Final Formatting Touches 

 To ensure your report is professional and easy to understand: 

 Adjust column widths to make sure all data is visible. 

 Align text properly (e.g., numbers to the right, text to the left). 

 Add borders to distinguish different sections of the report. 

 Use bold font for key figures like totals and averages. 

 Use clear chart titles that describe what the chart represents. 

 Ensure that all axes are labelled clearly for better readability. 

PRACTICAL EXERCISE 

Activity 1: Group Discussion on Creating a Sample Daily Sales Report in 

Excel. 

Material Required: 

 Computers/laptops with MS Excel installed 

 Sample sales data (e.g., product names, units sold, sales amount, date) 

 Pen and notebook for notes (optional) 

 Projector or whiteboard (for group sharing and presentation) 

Procedure: 

1. Divide class into small groups of 3–5 students. 

2. Distribute or display sample sales data, including: 

 Date 

 Product Name 

 Quantity Sold 

 Unit Price 
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 Total Sales 

3. Discuss within the group how to create a daily sales report that includes: 

 Total sales for the day 

 Best-selling product 

 Total quantity sold 

 Use of basic formulas like SUM, MAX, and IF 

 Creating a summary table and chart (bar or column chart) 

4. Use Excel to create the report layout with: 

 A summary section for KPIs 

 A table for raw data 

 A chart to visualize performance 

5. Each group will present their approach, formulas used, and design of their 

daily sales report. 

6. Save excel file and show it to the teacher. 

7. Teacher summarises a class discussion on the different formats and 

features used. 

Activity 2: Develop a weekly performance report for a specific department.  

Material Required: 

 Computer or laptop with MS Excel installed 

 Sample dataset for a department (e.g., Sales, HR, IT, etc.) including: 

a) Employee names 

b) Tasks completed 

c) Targets achieved 

d) Working hours 

e) Sales or output figures (if applicable) 

 Pen and notebook (optional) 

 Internet or reference materials (for chart ideas or formatting) 

Procedure: 

1. Assign a department (e.g., Sales Department). 

2. Open Excel and enter sample weekly data such as: 

 Employee Name 

 Days of the week (Mon to Sat) 

 Tasks Completed / Sales / Attendance 

 KPIs like Total Sales, Productivity Score, etc. 
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3. Use Excel formulas to calculate: 

 Total output or sales per employee 

 Weekly average performance 

 Highest and lowest performers 

 Achievement against weekly targets 

4. Create a summary section with KPIs like: 

 Total Department Output 

 Average Productivity 

 Best Performer of the Week 

5. Insert charts (bar/column/pie) to visualize: 

 Daily performance trends 

 Individual contribution 

 Task completion rates 

6. Format the report for clarity using: 

 Bold headings 

 Borders 

 Conditional formatting (e.g., highlight underperformers) 

7. Save and share the report as a print-ready or email-ready Excel file. 

Activity 3: Present Report Data Using Appropriate Charts in Excel. 

Material Required: 

 Computer or laptop with MS Excel installed 

 A completed daily or weekly report (containing summarized data such as 

totals, averages, comparisons, etc.) 

 Sample dataset (sales, productivity, attendance, etc.) 

 Pen and notebook for rough sketching (optional) 

Procedure: 

1. Open your Excel file containing the completed daily or weekly report. 

2. Review the key data that needs to be visualized, such as: 

 Total sales per day 

 Performance per employee 

 Task completion or attendance over time 

3. Select the data range that you want to convert into a chart. 

4. Go to the Insert tab in Excel and choose an appropriate chart type: 
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 Column Chart for comparing totals (e.g., sales by product or 

employee) 

 Line Chart for trends over time (e.g., sales across the week) 

 Pie Chart for showing parts of a whole (e.g., percentage of sales per 

product) 

 Bar Chart for horizontal comparisons 

 Combo Chart to show two types of data together (e.g., sales and 

target) 

5. Insert the chart and place it near the data or on a new sheet. 

6. Customize the chart: 

 Add chart title, axis labels, and data labels 

 Change colours or styles for better visibility 

 Use legends to explain categories clearly 

7. Review the chart to ensure it matches the data and communicates 

clearly. 

8. Save the file and prepare to explain how the chart supports the report 

during a presentation. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. __________ are metrics used to measure the performance of a specific 

activity, process, or goal within an organization 

2. The __________ function in Excel is used to summarize data by creating 

an interactive report with rows and columns. 

3. The formula used to calculate weekly sales growth is __________. 

4. In Excel, you can create a __________ chart to visually compare sales 

across different categories like products or regions. 

5. The __________ report is typically used to track short-term goals and 

monitor day-to-day operations. 

B. Multiple Choice Questions  

1. Which of the following is a Key Performance Indicator (KPI) used in daily 

sales reports? 

a)  Total Sales 

b)  Employee Rating 

c)  Weekly Growth Rate 

d)  None of the above 

2. In Excel, which chart type is best used to show trends over time? 

a)  Column Chart 
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b)  Line Chart 

c)  Pie Chart 

d)  Scatter Chart 

3. What does a Pivot Table in Excel allow you to do? 

a)  Summarize and analyse large datasets 

b)  Perform calculations 

c)  Create charts 

d)  All of the above 

4. When formatting an Excel report, what is the recommended way to 

highlight totals or subtotals? 

a)  Use italics 

b)  Use bold font and shaded background 

c)  Use a smaller font size 

d)  Use underlining 

5. Which of the following functions is used to calculate the Average Sales 

in Excel? 

a)  AVERAGE 

b)  SUM 

c)  COUNT 

d)  MAX 

C. State whether the following statements are True or False 

1. Sales Growth Rate is calculated by dividing the sales difference between 

two weeks by the sales of the previous week. 

2. In Excel, the COUNT function is used to calculate the total sales 

amount. 

3. The Employee Rating KPI reflects the performance of sales employees 

based on their ratings, and is calculated by dividing completed tasks by 

total tasks. 

4. A Pie Chart is best used for showing proportions, such as the share of 

total sales per product. 

5. Weekly performance reports are used to track short-term goals and 

immediate business activities. 

D. Short Answer Questions 

1. What is the importance of KPIs in MIS reports? 

2. How do you calculate Weekly Sales Growth in Excel? 
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3. What is the purpose of using a Pivot Table in Excel when creating MIS 

reports? 

4. Why is it recommended to use a Line Chart to visualize sales data over 

time? 

5. What is the formula used to calculate Customer Retention Rate in 

Excel? 

6. How can you format a report in Excel to ensure clarity and 

professionalism? 

E. Long Answer Questions 

1. Explain the steps involved in creating a Daily Sales Report in Excel. 

Discuss how Pivot Tables, formulas, and charts are used to generate 

and visualize KPIs in this report. 

2. Describe the process of calculating Weekly Sales Growth, Customer 

Retention Rate, and Employee Performance for a Weekly Performance 

Report. Explain how each of these KPIs is useful for business analysis. 

3. Compare the different types of charts in Excel. When would you use a 

Column Chart, Line Chart, Pie Chart, and Scatter Chart to present 

business data? Provide examples of each. 

4. Discuss the importance of formatting in Excel when preparing MIS 

reports. What is some formatting best practices to make reports clearer 

and more professional for decision-makers? 

F. Check Your Performance 

1. You are working as a trainee analyst in a retail company. Your manager 

has asked you to prepare a weekly sales performance report. The report 

must include Key Performance Indicators (KPIs) such as total sales, 

average daily sales, and best-selling product. You are also expected to 

use Excel formulas to calculate these KPIs, format the report for clarity, 

and present the data using appropriate tables and charts. 

Explain the steps you would take to: 

a) Identify and calculate the required KPIs using Excel formulas. 

b) Format the report so it is easy to read and understand. 

c) Present the key data visually using tables and charts. 
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SESSION 3: PIVOT TABLES AND DASHBOARDS 

Let us start with a simple example. Imagine your local kirana store (Grocery 

Shop) owner who writes every sale in a notebook. If someone asks, “How much 

was spent on soaps last month?”, the shopkeeper has to check each page and 

add up the amounts. This is time-consuming. Now think of a computer that 

can read all these records and give the answer in seconds. This is what tools 

like Pivot Tables and Dashboards help us do, they make it easy to understand 

big amounts of data. 

In banks, insurance companies, and financial services, a lot of data is 

collected every day. Without the right tools, it is difficult to make use of this 

data. Pivot Tables and Dashboards tools help us to summarize, organize, and 

show data in a form that is easy to understand.   

PIVOT TABLE 

A Pivot Table is a data summarization tool in Excel that helps to organize, 

calculate, and analyse data in a clear and flexible way. It allows rearranging 

(or “pivoting”) rows and columns to view data from different perspectives 

without altering the original dataset. It is commonly used to generate quick 

summaries, totals, averages, and comparisons from large tables of 

information. 

Let’s take a real-life example. Imagine your mother runs a small home tiffin 

service. She keeps a notebook of who ordered what and how much they paid. 

At the end of the month, she wants to know how much she earned from each 

customer. If she uses a Pivot Table, she can find this out in seconds! 

The word “pivot” means to turn or rotate. A Pivot Table allows data to be 

viewed from different angles. For example, spending can be analysed by 

category, by date, or by payment method all within the same table. 

The original data remains unchanged. A Pivot Table simply provides a 

different view of the same information. It is similar to looking into different 

mirrors, the person stays the same, but the reflection changes. 

Pivot Tables are among the most powerful tools in Microsoft Excel, widely used 

in fields like finance, banking, marketing, and small business management. 

Even with basic Excel knowledge, Pivot Tables are easy to use due to their 

drag-and-drop interface. No formulas are required. 

In short, a Pivot Table serves as a data summarizer, report generator, and 

decision-making aid i.e. all in one. 

Functions of a Pivot Table 

A Pivot Table offers several useful functions that help in analysing large 

amounts of data easily.  
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1. Summarization: The primary function is summarization, which allows 

quick calculation of totals, counts, or averages from extensive datasets. 

For example, from a list of 500 sales records, a Pivot Table can display 

the number of sales in each city or the count of payments made through 

UPI. 

2. Filtering: Another key function is filtering, which displays only specific 

portions of the data such as sales made in March or transactions 

completed via cash. This is helpful when working with large datasets. 

3. Grouping: This function organizes data into defined blocks or ranges. For 

example, age data can be grouped into ranges like 18–25 or 26–35, and 

dates can be grouped by months or years. 

4. Sorting: It is also supported, allowing data to be arranged in order from 

smallest to largest, or alphabetically. This helps in quickly identifying top-

performing items or the lowest values. 

5. Calculated Fields: Pivot Tables also allow the creation of calculated fields, 

which are custom fields that perform calculations like tax, discount, or 

profit, based on the available data. 

6. Multiple Data Views: Another important function is the ability to create 

multiple views from the same dataset. One Pivot Table can show expenses 

by category, while another can show totals by month without duplicating 

the data. 

7. Non-Destructive Analysis: Pivot Tables perform analysis and 

summarization without changing the original data, ensuring data integrity 

while enabling flexible reporting. 

All of these actions are performed without altering the original data. Pivot 

Tables generate summaries for analysis without changing the underlying 

dataset. Due to these powerful functions, Pivot Tables are widely used in 

workplaces, educational institutions, banks, and retail environments. Even 

with thousands of rows, Excel efficiently manages data through Pivot Tables, 

making data analysis fast and effective. 

Uses of Pivot Tables  

Pivot Tables are used to summarize, analyse, and explore large sets of data 

quickly and efficiently. They are widely applied in real-life scenarios for better 

decision-making. Here are key uses: 

1. Data Summarization: Quickly calculate totals, counts, averages, or 

percentages from large datasets.  

Example: Summing up total sales by product or region. 

2. Comparing Data: Compare values across categories such as 

departments, dates, or customer groups. 

Example: Comparing sales in January vs. February. 
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3. Filtering and Sorting: Focus on specific data using filters (e.g., a 

particular date range, product, or location). 

Example: Viewing only sales from the "Electronics" category. 

4. Grouping Data: Organize data into ranges (like age or price bands) or 

group by time (months, quarters). 

Example: Grouping dates into months to show monthly revenue. 

5. Creating Reports: Build professional reports that highlight key metrics 

for presentations or management. 

Example: Weekly performance reports for a department. 

6. Trend Analysis: Track changes over time using date fields and line charts 

from Pivot Tables. 

Example: Analysing monthly growth in website traffic. 

7. Creating Dashboards: Combine Pivot Tables with charts and slicers to 

make interactive dashboards. 

Example: Sales dashboard showing revenue by product and region with 

filters. 

8. Custom Calculations: Use calculated fields to add new metrics like profit 

margin or discount. 

Example: Creating a column that shows Sales – Cost = Profit. 

Advantages of Pivot Tables 

Pivot Tables are one of the most valuable tools in Excel for efficient, flexible, 

and error-free data analysis. Pivot Tables offer many advantages, especially 

when working with large datasets. Below are the key benefits: 

1. Speed: Complex calculations that may take an hour manually can be 

completed by a Pivot Table in just seconds. 

2. Ease of Use: Fields can be dragged and dropped to create reports, no 

need to write formulas unless advanced customization is required. 

3. Clear Summary: Thousands of rows of data can be converted into a 

clean and readable report that highlights only the most important 

information. 

4. Multiple Views: Data can be analysed from different perspectives, such 

as by product, region, date, or payment method without modifying the 

source. 

5. Flexibility: Pivot Tables can be adjusted anytime. New columns can be 

added, data can be removed or rearranged, and sorting options can be 

applied easily. 

6. Pattern and Trend Identification: Trends or patterns like seasonal 

sales spikes or increased costs can be easily spotted using Pivot Table 

summaries. 

7. Better Decision-Making: Quick insights from Pivot Tables support 

faster and smarter decisions in businesses, banks, schools, and other 

fields. 
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8. Scalability: Pivot Tables work efficiently even as data grows from a few 

rows to tens of thousands without slowing down. 

9. No Extra Software Needed: Pivot Tables are built into Microsoft Excel, 

so no additional tools or costs are required. 

10. Reduced Errors: Since calculations are automatic, the risk of manual 

errors is minimized, leading to more accurate reports. 

Advanced Features of Pivot Tables 

Advanced Pivot Table features in Excel enhance data analysis by allowing 

more customization and deeper insights beyond basic summarization. These 

tools help in organizing, calculating, and visualizing data more effectively. 

Below are some important features of Pivot Tables: 

1. Filter: Filters allow only specific data to be displayed from a larger dataset.  

Example: If your Pivot Table shows sales in all states, but you only want 

to see Maharashtra and Gujarat, you can apply a filter to show only those 

states. 

2. Slicer: A slicer is a visual filter consisting of clickable buttons that simplify 

data filtering. Selecting a slicer option automatically updates the Pivot 

Table to show the filtered data. 

Example: If you have data on sales by category such as clothes, 

electronics, and groceries, you can add a slicer. Then click on “Electronics,” 

and only electronics data will be shown. 

3. Grouping: combines data into ranges for easier analysis. Dates can be 

grouped by months or years, while numbers can be grouped into ranges 

such as 1–10, 11–20, and so forth. 

Example: If your data has dates of transactions, grouping them by months 

will let you see monthly totals. 

Steps: 

 Right-click on the date column in Pivot Table. 

 Choose “Group”. 

 Select how you want to group: by months, quarters, or years. 

4. Calculated Fields: Sometimes, custom formulas need to be created within 

the Pivot Table. A calculated field makes this possible by allowing new 

calculations based on existing data. 

Example: If you have “Total Sales” and “Cost”, and you want to find 

“Profit”, you can create a calculated field: Profit = Total Sales – Cost. 

Steps: 

 Go to Pivot Table Analyse tab. 

 Click on “Fields, Items & Sets”. 
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 Choose “Calculated Field”. 

 Enter the formula and click OK. 

5. Nested Report: A Nested Report in a Pivot Table means showing more than 

one level of information inside rows or columns. It’s like adding sub-

categories under main categories. Nesting fields places one category inside 

another, providing a deeper understanding of the data.   

Example: Suppose you are a school principal, and you have a list of 

students along with their class, subject, and marks. You want to know: 

 What are the average marks of each class? 

 Inside each class, how are students performing in each subject? 

You can use a nested report in a Pivot Table to find this out. You can first 

add Class to the row area, and then add Subject below it. Now, the Pivot 

Table will show the class-wise report, and under each class, it will show 

subject-wise data. This is called nesting fields you are creating layers of 

data. 

Create a Pivot Table  

Let’s take a small example: 

Date Category Amount (INR) Payment Mode 

01-Jan-25 Groceries 1,200 UPI 

01-Jan-25 Travel 3,500 Credit Card 

02-Jan-25 Rent 8,000 Bank Transfer 

03-Jan-25 Groceries 900 UPI 

This is a list of expenses. Now to know how much was spent on each category. 

To create a Pivot Table in Microsoft Excel (Fig. 4.3): 

1. Select all the data along with the headers. That means selecting the 

columns for Date, Category, Amount, and Payment Mode. 

2. Click on the “Insert” tab at the top menu. 

3. Click on “PivotTable”. A small box will appear. 

4. Choose “New Worksheet” so that the Pivot Table appears in a new sheet. 

5. Now the Pivot Table on the left and a list of column names on the right. 

6. Drag the “Category” field to the Rows section. 

7. Drag the “Amount” field to the Values section. 

That’s it. Excel will automatically show the total amount spent in each 

category. No need to use any formula. 
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Fig. 4.3: Pivot Table 

DASHBOARDS 

Imagine you are the principal of a school. Every day, you want to know: 

 How many students are absent today? 

 How many students scored above 80% in the last test? 

 How much money was collected as fees this month? 

Now, you can look at 10 different reports to find this information. But what if 

all this information was shown together clearly, simply, and visually on one 

screen? 

That’s exactly what a dashboard does. 

A dashboard is like a smart board that shows important information using 

charts, tables, and numbers all in one place. Long reports are not needed; a 

single glance at the dashboard provides a clear understanding of key data and 

trends.  

Just like the dashboard in a car shows you your speed, fuel level, and warning 

lights, an Excel dashboard shows you your data like sales, attendance, 

performance, or profits clearly and quickly. 

In simple words, a Dashboard in Excel is a visual summary that displays 

important data and performance indicators on a single screen. It is used to 

track, monitor, and analyse data efficiently. Dashboards combine charts, 

tables, and filters to present clear and actionable insights, making it easier to 

understand trends and make decisions. 

Dashboards are used everywhere: 

 In schools, to track student attendance and marks 

 In hospitals, to track patient admissions, medicines, and recovery rate 

 In banks, to see how many new accounts are opened, or how many loans 

are given 
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 In businesses, to track sales, expenses, and customer feedback 

 In government offices, to monitor schemes, benefits, or surveys 

Dashboards help managers, teachers, and even government officers make 

decisions faster because all important information is on one screen. 

Key Elements of a Dashboard 

A dashboard is used to track and display important data clearly and 

effectively. Below are key elements commonly included in a well-designed 

dashboard: 

1. Charts and Graphs: These show data in a visual form like bar, line, or 

pie charts. They make it easy to compare values and see patterns or trends 

at a glance. 

2. Summary Tables: Tables show key numbers such as totals, averages, or 

rankings. They are useful when exact figures are needed alongside visuals. 

3. Key Performance Indicators (KPIs): These are the most important 

numbers to track performance. Examples include sales growth, total 

students, or number of late deliveries. 

4. Slicers and Filters: These allow viewing specific parts of the data. For 

example, selecting only a certain month or department updates the whole 

dashboard accordingly. 

5. Conditional Formatting: Highlights important data using colours or 

icons. For example, green for high performance and red for low, or arrows 

to show increase/decrease. 

6. Titles and Labels: Every chart or table needs a clear title and label so the 

viewer understands what the data represents. 

Dashboard Layout 

Layout means how the dashboard is arranged on the screen or page. A good 

dashboard layout ensures clarity and quick understanding. It usually 

includes: 

 Header Section: Title, date range, and filters 

 Summary Section: Key KPIs in bold or coloured boxes 

 Visual Section: Charts and graphs placed in an organized grid 

 Details Section (Optional): Data tables or additional analysis 

A well-designed dashboard should be easy to read, focused on the objective, 

and limited to the most important data points. 

Planning a Dashboard Layout 

Before opening Excel and creating a dashboard, it is important to plan the 

layout and content. A simple approach is as follows: 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

200 
 

1. Know What You Want to Show: Think about the problem or question. 

Example: “I want to see the monthly attendance of each class.” 

2. Understand Your Audience: Who will use this dashboard? 

 If it is a teacher, show individual student performance. 

 If it is a principal, show class-wise summary. 

3. Collect the Right Data: Only use data that is useful. Don’t add 

everything. 

Example: For attendance dashboard, you don’t need test marks. 

4. Make a Rough Sketch: Use a notebook to sketch the placement of charts, 

KPIs, and tables. This helps save time during dashboard creation. 

5. Start with Simple Charts: Make a bar chart or pie chart. Add one 

element at a time. Don’t try to do everything at once. 

6. Test Your Dashboard: Check if the data is correct. Does it change when 

using a slicer? Can others understand it easily? 

7. Make It Interactive: Add slicers so users can choose what they want to 

see (e.g., Class 9, Class 10, Boys only, Girls only). 

PRACTICAL EXERCISE 

Activity 1: Create Pivot Tables with Calculated Fields and Grouping. 

Materials Required: 

 A computer/laptop with Microsoft Excel 

 Sample dataset (e.g., Sales or Employee data) with columns like: Date, 

Product, Quantity Sold, Unit Price, Region 

 Basic Excel knowledge 

Procedure: 

1. Prepare the Dataset. 

Create a table in Excel with the following columns: 

Date Product 
Quantity 

Sold 

Unit 

Price 
Region 

01-Jan-25 Product A 10 50 North 

05-Jan-25 Product B 15 30 South 

10-Jan-25 Product A 8 50 North 

15-Jan-25 Product C 12 40 East 

2. Insert a Pivot Table 

 Select the data range 

 Go to Insert > Pivot Table 
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 Choose New Worksheet → Click OK 

3. Add Fields to the Pivot Table 

 Drag Product to the Rows area 

 Drag Quantity Sold to the Values area 

 Drag Unit Price to the Values area 

4. Add a Calculated Field (e.g., Total Sales) 

 Click anywhere inside the Pivot Table 

 Go to PivotTable Analyse > Fields, Items, & Sets > Calculated Field 

 In the dialog box: 

Name: Total Sales 

Formula: =Quantity Sold * Unit Price 

 Click Add → OK 

This will add a new field "Total Sales" in the Pivot Table. 

5. Group Data (e.g., by Date or Range) 

1. If grouping by Date: 

 Drag Date to the Rows area 

 Right-click any date value → Select Group 

 Choose to group by Months, Quarters, or Years 

2. If grouping numeric values: 

 Right-click on a numeric value in the Pivot Table 

 Click Group 

 Set starting and ending values with desired interval (e.g., 0–50, 51–

100) 

6. After completion save the file. 

7. Explain the process to the teacher. 

Activity 2: Building a Basic Dashboard in Excel to Visualize Monthly KPIs. 

Materials Required: 

 A computer/laptop with Microsoft Excel 

 Sample dataset (e.g., sales or attendance) with columns such as: Month, 

Department/Product, Sales/Output, Target, Region 

Procedure: 

1. Prepare the Dataset 

Create a table with the following sample structure: 
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Month Product Sales (₹) Target (₹) Region 

January Product A 45,000 50,000 North 

January Product B 60,000 55,000 East 

February Product A 50,000 50,000 North 

February Product B 48,000 55,000 East 

2. Insert Pivot Tables 

a) Select the dataset 

b) Go to Insert > Pivot Table → choose New Worksheet 

c) Create multiple Pivot Tables for KPIs like: 

 Total Sales per Month 

 Target vs. Actual Comparison 

 Region-wise Sales 

3. Insert KPI Charts 

a) From each Pivot Table, insert charts: 

 Column chart for monthly sales 

 Bar chart for product-wise performance 

 Line chart for comparing target vs. actual 

b) Go to Insert > Chart, then choose the suitable type 

c) Customize with titles, axis labels, and data labels 

4. Add Slicers for Interactivity 

 Click a Pivot Table 

 Go to Insert > Slicer 

 Add slicers for Month, Region, or Product 

 Align the slicers to control all charts simultaneously 

5. Design the Dashboard Layout 

 Place all charts and slicers neatly in one worksheet 

 Add titles like “Monthly Sales Summary”, “Target Achievement” 

 Use consistent colour themes and fonts 

 Add shapes or boxes for better sectioning if needed 

6. After completion save the file. 

7. Explain the process to the teacher. 

Activity 3: Add Slicers to the Dashboard for Interactive Data Exploration. 

Materials Required: 
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 A computer or laptop with Microsoft Excel 

 A prepared dashboard worksheet containing Pivot Tables and charts 

(based on a dataset like sales, attendance, etc.) 

Procedure: 

1. Open the Dashboard Sheet: Ensure the worksheet contains at least one 

Pivot Table created from the dataset, with charts if available. 

2. Insert a Slicer 

 Click anywhere inside the Pivot Table. 

 Go to Insert tab → Click Slicer. 

 In the dialog box, select the fields you want to filter by (e.g., Month, 

Region, Product). 

 Click OK. 

3. Use the Slicer 

 A slicer box will appear with filter buttons for the selected field. 

 Click any button (e.g., "January") to instantly update the Pivot Table 

and all linked charts. 

 Hold Ctrl to select multiple values at once. 

4. Connect the Slicer to Multiple Pivot Tables (Optional) 

If the dashboard contains more than one Pivot Table: 

 Click on the slicer. 

 Go to Slicer Tools > Report Connections. 

 Tick all Pivot Tables you want the slicer to control. 

 Click OK. 

5. Arrange and Format the Slicer 

 Resize and position the slicer on the dashboard. 

 Customize with colour and style from Slicer Tools > Options. 

6. After completion save the file. 

7. Explain the process to the teacher. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks  

1. A Pivot Table is used to __________ large amounts of data quickly. 

2. The “__________” function in Pivot Table helps us to show only selected 

data. 

3. A __________ is a button-based filter used with Pivot Tables. 
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4. In a Pivot Table, you can group dates into __________ or years. 

5. A __________ field allows you to create a new column using formulas 

inside a Pivot Table. 

B. Multiple Choice Questions  

1. What is the main purpose of a Pivot Table in Excel? 

a)  Drawing pictures 

b)  Summarizing data 

c)  Sending emails 

d)  Formatting text 

2. Which of the following is used as a visual filter in Pivot Tables? 

a)  Calculator 

b)  Graph 

c)  Slicer 

d)  Border 

3. What happens when you drag a field to the “Rows” area in a Pivot Table? 

a)  It creates a graph 

b)  It deletes the data 

c)  It lists the unique values 

d)  It hides the data 

4. Which feature helps in combining similar values like dates or numbers 
into blocks? 

a)  Sorting 

b)  Grouping 

c)  Filtering 

d)  Freezing 

5. If you want to calculate profit as "Total Sales - Cost" inside a Pivot Table, 
which feature will you use? 

a)  Calculated Field 

b)  Insert Row 

c)  Pivot Chart 

d) Merge Cells 

C. State whether the following statements are True or False 

1. Calculated Fields in Pivot Tables allow users to add new fields by 

performing calculations on existing data. 

2. Grouping in Pivot Tables can only be done with numerical data. 

3. A good dashboard should only include visual charts and avoid using 

any slicers or filters. 
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4. One of the key elements of a dashboard is to present data in a 

summarized and easy-to-understand format. 

5. Planning a dashboard layout includes deciding what visuals to use, 

arranging them logically, and considering user needs. 

D. Short Answer Questions  

1. What is a Pivot Table in Excel? 

2. How does a slicer help in data analysis? 

3. Explain what grouping means in Pivot Tables. 

4. Mention any two advantages of using Pivot Tables. 

5. How is filtering different from sorting in Pivot Tables? 

6. What is a nested report in Pivot Tables? 

E. Long Answer Questions  

1. Explain with an example how Pivot Tables can be useful for a small 

business owner. 

2. Describe the key features of a Pivot Table and how each helps in data 

analysis. 

3. How can a bank manager use Pivot Tables to make decisions? Explain 

with 2 examples. 

4. Describe the steps to create a Pivot Table using sample data of monthly 

expenses. 

F. Check Your Performance 

1. A school administrator wants to analyse student performance data to 

prepare a monthly academic dashboard. The dataset contains student 

names, subjects, marks obtained, total marks, and the exam month. 

She wants to:  

 Calculate the percentage marks using a calculated field in a Pivot 

Table. 

 Group the results by exam month to compare overall performance 

month-wise. 

Build a dashboard that includes: 

 KPIs such as highest and average marks, 

 A chart for subject-wise performance, 

 A slicer to filter by class or subject. 

What steps should be followed to design this dashboard using advanced 

Pivot Table features and proper layout planning? Mention any two key 

elements that must be included in the dashboard and explain why they 

are important. 
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SESSION 4: MIS REPORTS AND BASIC DASHBOARDS 

KPIs FOR MONTHLY REPORTS 

In a Management Information System (MIS) report, Key Performance 

Indicators (KPIs) are important numbers that help show how well something 

is working. These could be about a process, a team, or a business. Usually, 

these numbers are checked every month to see how things are going. 

KPIs in MIS reports help managers and decision-makers in the following ways: 

 Monitor performance trends: Helps to track progress over time. E.g. 

Sales went up this month compared to last month. 

 Identify issues and gaps: Shows where something is going wrong. E.g. 

Customer complaints are increasing – why? 

 Take informed decisions: Helps to make better choices using real data. 

E.g. Should we hire more staff or promote a product? 

 Plan for the future: Helps to prepare for next steps. E.g. Plan a sales 

campaign if performance is low. 

KPIs are important in Monthly Reports: 

 They summarize key data in a clear and simple way. 

 They help managers and teams make decisions. 

 They show what is working well and what needs improvement. 

 They help in setting goals for the next month. 

SOME EXAMPLES OF COMMON KPIS IN MONTHLY REPORTS 

1. Sales KPIs 

 Monthly Revenue: Total money earned from sales in the month. 

 Number of New Customers: How many new people bought the product 

or service? 

 Sales Growth Rate:  How much did sales increase or decrease compared 

to last month? 

2. Marketing KPIs 

 Website Visitors: Number of people who visited the website. 

 Conversion Rate: Percentage of people who visited and actually made a 

purchase or filled out a form. 

 Social Media Engagement: Likes, shares and comments on social posts. 

3. Customer Service KPIs 

 Customer Satisfaction Score (CSAT): Rating given by customers after 

receiving support. 
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 Average Response Time: How quickly customer support/care team 

replied to customer queries? 

 Number of Support Tickets Closed: Total problems solved during the 

month. 

4. Operational KPIs 

 Productivity Rate: How much work was completed compared to the 

target. 

 Order Fulfilment Time: Time taken to deliver an order after it was 

placed. 

 Error Rate: Number of mistakes made during operations. 

USING KPIS IN MONTHLY REPORTS 

1. Choose Relevant KPIs: Select key performance indicators that align with 

the main goals of the business or department. For example, if the goal is to 

increase revenue, important KPIs could be total sales, number of new 

customers, or average order value. If the focus is customer service, KPIs 

might include customer satisfaction scores or response times. 

2. Collect Data for Each KPI: Gather accurate data regularly for each 

chosen KPI. This data can come from sales records, customer feedback, 

delivery logs, or other sources related to the business process. 

3. Compare with Previous Months: Review the KPI values month by month 

to identify trends. Are sales increasing, stable, or decreasing? Are customer 

complaints rising or falling? This comparison helps spot patterns and 

understand if performance is improving or declining. 

4. Visualize KPIs Using Charts or Tables: Present KPI data clearly with 

charts like bar graphs, line charts, or tables. Visual tools make it easier to 

grasp trends and differences quickly rather than reading long lists of 

numbers. 

5. Write Simple Observations: Include brief notes or comments on the 

report explaining key findings. For example: “Sales increased by 10% 

compared to last month due to a new marketing campaign,” or “Customer 

complaints rose slightly and need further investigation.” These 

observations highlight what improved and what requires attention. 

KPIs in a monthly report tell the story of progress. They act like a health check 

up for a team or business showing what is going well and what needs 

improvement. For specific industries such as education, logistics, or 

marketing, tailored KPI examples can be provided to suit particular needs. 

KPIS IN DASHBOARDS 

A dashboard in Excel is like a smart control panel that display important 

information quickly using visual tools like charts and tables. KPIs are 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

208 
 

important numbers that tell how well something is going such as sales, 

profits, customer complaints, etc. A dashboard shows these KPIs in a visual 

format so that anyone can easily understand and analyse the data. 

A Dashboard in Excel is a visual tool that shows KPIs using: 

 Pivot Tables: Used to summarize large data sets. 

E.g. Show total sales by region or month. 

 Charts (bar, line, pie, etc.): Turn numbers into visual stories. E.g. A line 

chart showing profit trends over 6 months. 

 Interactive elements like slicers: Let users filter data quickly (e.g., by 

region, month, or product). E.g. Click “North Region” and all charts update 

to show North’s data only. 

Dashboards make it easy to understand the KPIs at a glance, instead of 

reading through rows of data. 

Let’s say an MIS Report tracks the monthly performance of a retail store. 

Raw Data: 

Date Region Sales Orders Returns Customer Rating 

01/06/25 North 5000 25 2 4.5 

02/06/25 South 6500 30 1 4.8 

... ... ... ... ... ... 

KPI Examples in the Report: 

KPI Description 
Example 

Value (June) 

Total Sales Sum of all sales in June ₹ 1,20,000 

Total Orders 
Count of all customer 

orders 
600 

Return Rate (Returns ÷ Orders) × 100 2% 

Average Customer Rating Average of daily ratings 4.6 out of 5 

Visualizing KPIs in Dashboards (in Excel) 

Using Pivot Tables and Charts, a basic dashboard can show: 

 Line Chart: Monthly sales trend 

 Bar Chart: Orders by region 

 Gauge Chart: Target vs Actual Sales 

 Slicers: Select month, region, or category to filter data 

Example KPI Dashboard Output: 

Dashboard Elements: 

 Title: “Monthly Performance Dashboard – June 2025” 
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 KPI Box 1: Total Sales – ₹1,20,000 

 KPI Box 2: Orders – 600 

 KPI Box 3: Avg. Rating – 4.6 

 Bar Chart: Orders by Region 

 Slicer: Choose Month or Region 

This allows management to quickly see: 

 Which region performed best? 

 Whether sales targets were achieved 

 Where customer satisfaction needs improvement 

Benefits of Using KPIs in MIS and Dashboards 

 Easy to summarize complex data 

 Helps in quick decisions 

 Encourages data-driven performance management 

 Makes reports more meaningful and visual 

PIVOT TABLES AND CHARTS FOR MONTHLY ANALYSIS 

Pivot Tables and Charts in Excel are powerful tools used to summarize and 

analyse large datasets, especially for monthly performance tracking. They 

help in organizing data in a meaningful way and provide clear visual 

representations. 

1. Pivot Tables 

A Pivot Table rearranges data to display totals, averages, counts, etc., 

grouped by categories such as month, region, product, or employee. It 

helps quickly answer questions like: 

 What were the total sales each month? 

 How many orders came from each region? 

Example: If a dataset contains sales records by date, product, and 

region, a Pivot Table can show: 

 Monthly total sales per region 

 Monthly average customer ratings 

2. Pivot Charts 

Pivot Charts are visual representations of data based on Pivot Tables. They 

help in quickly understanding the data by turning numbers into visuals 

such as column charts, line charts, bar charts, or pie charts. These charts 

automatically update when the Pivot Table is updated, making them highly 

dynamic and interactive. Pivot Charts make it easier to spot trends, 
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compare values, and highlight performance patterns that helps users 

make faster and more informed decisions. 

Example: 

 A Line Chart can show how sales changed over 6 months. 

A Bar Chart can compare monthly orders across regions. 

Benefits for Monthly Analysis 

 It saves time by automatically summarizing large amounts of data. 

 It reduces manual errors by using built-in Excel functions. 

 It provides clear visual insights through charts and tables. 

 It supports informed decision-making by showing key performance 

trends. 

CREATING BASIC DASHBOARDS USING EXCEL CHARTS AND TABLES, 

ADDING BASIC INTERACTIVE ELEMENTS (SLICERS) 

Creating Basic Dashboards using Excel  

A Dashboard is a collection of charts, tables, and graphs that display key 

business metrics. In Excel, dashboards help summarize large amounts of data 

in a way that is easy to understand. These dashboards can include: 

 Tables to show detailed data. 

 Charts to visualize trends and comparisons. 

 KPIs to track important metrics like sales growth, revenue, or profit 

margin. 

Dashboards are used to make data easily accessible and visually appealing 

so that anyone can understand the business’s performance at a glance. 

Below are the steps to create a basic dashboard in excel: 

Step 1: Prepare the Dataset 

 Organize data in a tabular format with headers (e.g., Date, 

Region, Product, Sales, Orders). 

 Ensure there are no blank rows or columns. 

Step 2: Insert Pivot Table 

 Go to the Insert tab → PivotTable. 

 Select the data range and choose where to place the Pivot Table 

(new sheet or existing). 

Step 3: Summarize the Data 

 Drag relevant fields (e.g., Month to Rows, Sales to Values) to 

create summaries. 

 Create multiple Pivot Tables for different summaries if needed 

(e.g., sales by product, region, or month). 

Step 4: Insert Pivot Charts 
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 Click on a Pivot Table → go to Insert tab → select a chart 

(Column, Line, Pie, etc.). 

 Repeat for other Pivot Tables as needed. 

Step 5: Insert Slicers (Optional for Interactivity) 

 Select a Pivot Table → go to Insert Slicer → choose fields (e.g., 

Month, Region). 

 Slicers allow users to filter the entire dashboard easily. 

Step 6: Format the Dashboard 

 Resize and align the Pivot Tables and Charts neatly. 

 Add titles, labels, or text boxes to explain charts or KPIs. 

 Use cell formatting and colours for a clean and readable layout. 

Step 7: Review and Test 

 Check if slicers filter the visuals correctly. 

 Ensure the dashboard updates when data changes. 

Step 8: Save the File 

 Save the Excel workbook as a template or regular file for future 

use and updates. 

Result: A dynamic dashboard that displays key performance indicators 

visually and interactively, helping in quick decision-making. 

Adding Basic Interactive Elements (Slicers) 

Below are the steps to Add Basic Interactive Elements in Excel Dashboards: 

Step 1: Create Pivot Tables and Charts 

 First, create Pivot Tables and corresponding charts from the 

data. These will form the main parts of the dashboard. 

Step 2: Select a Pivot Table 

 Click anywhere inside the Pivot Table to activate the PivotTable 

Tools on the Ribbon. 

Step 3: Insert a Slicer 

 Go to the PivotTable Analyse tab (or Analyse tab in some Excel 

versions). 

Click Insert Slicer. 

Step 4: Choose Fields for the Slicer 

 In the Insert Slicers dialog box, select the fields (columns) on 

which filtering will be needed, like Month, Region, Product, etc. 

Click OK. 

Step 5: Use the Slicer 
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 The slicer appears as a clickable button box. Clicking any item 

in the slicer instantly filters the linked Pivot Table and charts to 

show only relevant data. 

Step 6: Format the Slicer (Optional) 

 Resize or move the slicer on the dashboard. 

 Use the Slicer Tools tab to change colours, styles, and layout for 

better visuals. 

Step 7: Connect Slicers to Multiple Pivot Tables (Optional) 

If there are multiple Pivot Tables, link slicers to all relevant  

tables: 

 Click on the slicer. 

 Go to Slicer Tools > Report Connections (or PivotTable 

Connections). 

 Check all Pivot Tables that the slicer should control. 

Step 8: Test the Interactivity 

 Click different slicer buttons to check how the dashboard updates 

instantly, making data exploration easier and faster. 

This way, slicers add interactivity to dashboards, helping users quickly filter 

and analyse data without manually adjusting filters. 

Let’s understand with the help of example. 

A national electronics retail chain i.e. Krush Tech, operates across four major 

regions: North, South, East, and West. The store sells products like Laptops, 

Mobiles, and Headphones. Each month, the management reviews 

performance data to understand: 

 Sales trends across regions and products 

 Number of customer orders 

 Return rates and customer satisfaction ratings 

To make this review more efficient, the store manager is asked to create a 

Monthly Performance Dashboard using Excel. 

Date 

(June, 

2025) 

Month Region Product 
Sales 

(₹) 
Orders Returns 

Customer 

Rating 

01 June North Laptop 50000 20 1 4.5 

03 June South Mobile 30000 25 2 4.2 

05 June East Headphones 15000 15 0 4.8 
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08 June West Laptop 40000 18 1 4.4 

12 June North Mobile 35000 22 1 4.6 

16 June South Headphones 10000 10 0 4.9 

20 June East Laptop 55000 23 2 4.3 

24 June West Mobile 25000 19 1 4.7 

Step 1: Prepare the Dataset 

 Open Excel and enter the sample dataset above. 

 Ensure the data has headers and no blank rows or columns. 

Step 2: Create a Pivot Table 

 Select the entire dataset range (e.g., A1:H9). 

 Go to Insert > Pivot Table. 

 Choose to place the Pivot Table on a new worksheet. 

 Click OK. 

Step 3: Set Up the Pivot Table – In the Pivot Table Fields: 

 Drag Month to the Rows area. 

 Drag Sales (₹) or Orders to the Values area. 

 Drag Region or Product to the Columns area (optional for comparison). 

Step 4: Insert Pivot Charts 

 Click inside the Pivot Table. 

 Go to Insert > Recommended Charts or choose Column, Bar, or Line 

Chart 

 A Pivot Chart will appear and automatically update with the Pivot 

Table. 

Step 5: Add Slicers (Interactive Filters) 

 Select the Pivot Table or Pivot Chart. 

 Go to Insert > Slicer. 

 Select one or more fields (e.g., Region, Product). 

 Click OK – slicer buttons will appear. 

 Click buttons to filter data instantly in the Pivot Table and Charts. 

Step 6: Format the Dashboard 

 Resize the chart and slicers neatly on the worksheet. 

 Add chart titles (e.g., “Monthly Sales by Region”). 
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 Format data labels, legends, and slicer styles for clarity and appeal. 

 Rename the sheet to “Dashboard”. 

Result: Fig. 4.4 

An Excel sheet with: 

 A Pivot Table summarizing monthly sales or orders. 

 A Pivot Chart showing trends. 

 Slicers allowing selection of Region or Product. 

 All visuals updating interactively with slicer selections. 

 

Fig. 4.4: Monthly Performance Dashboard using Excel 

PRACTICAL EXERCISE  

Activity 1: Create a Sample Monthly Performance Report Using Pivot Tables 

and Charts. 

Material Required: 

 Computer with Microsoft Excel installed 

 Basic knowledge of Excel interface 

 Sample dataset containing monthly performance data as below: 

Month Region Sales (₹) Orders Returns 
Customer 

Rating 

January North 50,000 200 5 4.5 

January South 45,000 180 3 4.6 

January East 40,000 160 6 4.3 

February North 52,000 210 4 4.7 

February South 48,000 190 5 4.5 

February East 42,000 170 2 4.6 
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March North 55,000 220 3 4.8 

March South 50,000 200 6 4.7 

March East 45,000 180 4 4.4 

April North 58,000 230 2 4.9 

April South 53,000 210 5 4.6 

April East 48,000 190 3 4.5 

Procedure: 

1. Open Microsoft Excel and enter the sample monthly performance data 

exactly as shown. Make sure the data is clean, with no blank rows or 

columns inside the dataset. 

2. Create a Pivot Table 

 Select the entire data range (for example, cells A1:F13, including 

headers). 

 Go to the Insert tab on the Excel ribbon. 

 Click on Pivot Table. 

 Choose to place the Pivot Table in a New Worksheet (recommended for 

clarity). 

 Click OK. 

3. Set Up the Pivot Table 

a) In the Pivot Table Fields panel: 

 Drag Month to the Rows area. 

 Drag Sales (₹) to the Values area — this will automatically calculate 

total sales per month. 

b) Optional: 

 Drag Region to the Columns area if a month-wise region comparison 

is needed. 

 Drag other KPIs (e.g., Orders, Returns) to the Values area for 

additional summaries. 

4. Insert a Pivot Chart 

 Click anywhere inside the Pivot Table to activate it. 

 Go to the Insert tab. 

 Choose a chart type such as Column Chart or Line Chart to visualize 

sales trends. 

 The chart will automatically link to the Pivot Table data and display 

monthly sales visually. 
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5. Format the Chart 

 Add a Chart Title such as “Monthly Sales Performance.” 

 Add Axis Titles (e.g., Months on the X-axis and Sales in ₹ on the Y-axis). 

 Include Data Labels if needed to show exact values on the chart bars or 

lines. 

 Adjust colours or styles for better visual appeal and clarity. 

6. Analyse the Report 

a) Look at the chart and Pivot Table to identify: 

 Which month had the highest sales? 

 Are there any trends or seasonal changes? 

 How do different regions perform (if added)? 

b) Use these insights for decision-making, reporting to management, or 

planning future strategies. 

Activity 2: Building a Basic Dashboard in Excel to Visualize Monthly KPIs. 

Materials Required: 

 Computer or Laptop with Microsoft Excel (2016 or later) 

 Internet access (optional, for design ideas or templates) 

 Pen and notebook (for noting observations or KPI definitions) 

 Sample dataset (sales, region, month, orders, returns, customer rating, 

etc.) 

Month Region Product 
Sales 

(₹) 
Orders Returns 

Customer 

Rating 

June North Laptop 50,000 20 1 4.3 

June South Mobile 65,000 30 0 4.8 

June East Headphones 25,000 40 3 4.1 

June West Laptop 55,000 22 2 4.4 

... ... ... ... ... ... ... 

Procedure: 

1. Open Excel and enter or import the monthly performance data. Ensure the 

data is clean (no blanks, consistent column headers). 

2. Create Pivot Table 

a) Select the full dataset. 

b) Go to the Insert tab → Click PivotTable. 

c) Choose “New Worksheet” → Click OK. 
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d) In PivotTable Fields: 

 Drag Month to Rows 

 Drag Sales or Orders to Values 

 Drag Region or Product to Filters or Columns 

3. Create Pivot Charts 

 Click inside the PivotTable. 

 Go to Insert → Choose Column Chart, Line Chart, or Pie Chart. 

 The chart will be linked to the PivotTable and show summary data. 

4. Create KPI Boxes: Use Excel cells with formulas (like =SUM(...) or 

=AVERAGE(...)) to display KPIs: 

 Total Sales 

 Total Orders 

 Return Rate = Returns ÷ Orders × 100 

 Avg. Rating = AVERAGE of Ratings 

5. Add Slicers (Interactive Filters) 

 Click on the PivotTable. 

 Go to Insert tab → Click Slicer 

 Select fields like Region or Product 

 Place slicers next to charts and tables. 

 Try clicking different slicer buttons (e.g., South Region) to filter the 

entire dashboard instantly. 

6. Format and Finalize the Dashboard 

 Add headings like “Monthly Performance Dashboard – June 2025” 

 Format fonts, colours, and layout for better appearance. 

 Align all charts, slicers, and KPI boxes neatly. 

 Save the file as Monthly_KPI_Dashboard.xlsx 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. A __________ is a one-screen summary of data using tables, charts, and 

KPIs. 

2. In Excel, __________ allow users to filter data using buttons. 

3. __________ is used to combine data into categories like months or years. 

4. Dashboards help in __________ decision-making by showing key data 

clearly. 

5. A __________ is used to highlight important numbers such as total 

students or average marks. 
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B.  Multiple Choice Questions (MCQs) 

1. What is the main purpose of a dashboard? 

a)  To type long reports 

b)  To show all data in text form 

c)  To display important data visually 

d)  To print Excel sheets 

2. Which Excel tool helps you filter Pivot Tables using buttons? 

a)  Grouping 

b)  Slicer 

c)  Formula 

d)  Sorting 

3. What can a KPI in a dashboard show? 

a)  Colours 

b)  A large table 

c)  A detailed report 

d)  A key value like pass percentage 

4. What type of chart is best to compare student performance across 

subjects? 

a)  Pie Chart 

b)  Bar Chart 

c)  Line Chart 

d) Scatter Chart 

5. What does layout in a dashboard refer to? 

a)  Font style 

b)  Chart type 

c)  Arrangement of charts and tables 

d)  Excel version 

C. State whether the following statements are True or False 

1. Dashboards are only used in big companies.  

2. You can use filters and slicers in Excel dashboards.  

3. Dashboards cannot show data using colours or icons.  

4. Bar charts are useful to compare class-wise attendance.  

5. Dashboards make it harder to understand your data.  
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D. Short Answer Questions 

1. What is a dashboard in Excel? 

2. Name any two places where dashboards are commonly used. 

3. What is a KPI? Give one example. 

4. Why is layout important in dashboard design? 

5. How does a slicer help in making a dashboard interactive? 

6. What type of chart can be used to show changes in attendance over 

months? 

E.  Long Answer Questions 

1. Explain what a dashboard is and why it is useful in schools. 

2. Describe the steps to create a simple dashboard in Excel using 

attendance data. 

3. Discuss five key elements that should be included in a well-designed 

dashboard. 

4. Give a real-life example of how a dashboard can help a school principal 

make better decisions. 

F. Check Your Performance 

1. How should the sales manager create a monthly dashboard in Excel to 

display key performance indicators (KPIs) using Pivot Tables, Charts, and 

Slicers? 

List the steps involved and explain how these tools help in analysing 

monthly performance effectively. 
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MODULE 5: AUTOMATION AND PRESENTATION OF 

REPORTS 

In today’s business environment, organizations rely heavily on reports and 

presentations to make informed decisions. With increasing volumes of data, 

manual preparation of reports is time-consuming and prone to errors. This is 

where automation tools and effective presentation techniques play a key role. 

Automation, especially within Microsoft Excel, helps save time by performing 

repetitive tasks, updating reports, and ensuring consistency. Similarly, 

presenting reports clearly using tools like slide decks allows organizations to 

communicate data-driven insights effectively to stakeholders. 

This module focuses on building essential skills for automating reports and 

presenting them in a professional format. It introduces students to the use of 

Macros and Visual Basic for Applications (VBA) in Excel for automating 

routine tasks. The module also covers techniques for automating report 

generation, integrating visuals into documents, and delivering effective 

presentations. 

Further this module is divided in to 4 sessions. Session 1 deals with 

understanding Macros, recording them, and exploring the basics of VBA for 

task automation. Session 2 focuses on applying these skills to automate 

reports and dashboards, saving time on repetitive tasks. Session 3 

emphasizes how to prepare structured, analytical reports using Excel 

outputs. Finally, Session 4 develops learners’ ability to present data analysis 

effectively using professional slide presentations. 
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SESSION 1: MACROS AND VBA IN EXCEL 

MACROS IN EXCEL 

A macro in Microsoft Excel is a set of programmed instructions that 

automates repetitive tasks, allowing users to perform complex or routine 

operations quickly and efficiently. Macros are created using Visual Basic for 

Applications (VBA), Excel’s built-in programming language. 

Prerequisites for Using Excel Macros 

Before learning how to create macros in Excel, it is necessary to turn on the 

developer mode in Excel. Follow below steps: 

Step 1: Open MS Excel – Navigate to the MS Excel icon and give it a click to 

open it. 

Step 2: Right-click on the Ribbon – Go to the menu and perform a right-

click on the ribbon, select Customize the ribbon (Fig. 5.1). 

 

Fig. 5.1: Customize the Ribbon 

Step 3: Check the Developer box and click on “OK” – Navigate to 

Customize the ribbon and place a check on the Developer Checkbox 

(Fig. 5.2). 

 

Fig. 5.2: Developer 
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Procedure to Enable Excel Macros 

Follow the below steps to enable macros in Microsoft Excel: 

1. Open the Excel File: Open the Excel workbook that contains the macros 

you want to enable. 

2. Access the Trust Center:  

 Click on the File tab in the top-left corner of the screen. 

 Select Options at the bottom of the left-hand menu. 

 In the Excel Options window, select Trust Center from the left-hand 

pane (Fig. 5.3). 

 Click on the Trust Center Settings button on the right side. 

 

Fig. 5.3: Trust Center 

3. Navigate to Macro Settings: In the Trust Centre window, click on Macro 

Settings on the left. 

4. Choose the Appropriate Option: Select one of the following options 

based on security requirements: 

 Disable all macros without notification: Disables all macros silently. 

 Disable all macros with notification: Disables macros but shows a 

warning when a macro-enabled file is opened. 

 Disable all macros except digitally signed macros: Enables only macros 

signed by a trusted publisher. 
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 Enable all macros (not recommended): Enables all macros without 

restrictions and may pose a security risk. 

5. Save Your Settings: 

 Click OK to close the Trust Center window. 

 Click OK again to close the Excel Options window. 

6. Enable Macros for a Specific Workbook (If prompted): When a macro-

enabled workbook is opened, a yellow Security Warning bar may appear 

below the ribbon. Click Enable Content to allow the macros to run. 

RECORDING A MACRO  

Recording a macro in Excel allows tasks to be automated by capturing a 

sequence of actions. Follow these steps to record a macro: 
Step 1: Click on the Developer Tab – Go to the Developer tab located 

at the ribbon. 

 

Fig. 5.4: Developer Tab 

Step 2: Click on the Record Macro – In the Code Group, the 

tool Record Macros is located, to excel macros record you have 

to click on it. 

 

Fig. 5.5: Record Macro 

Step 3: Fill the Record Macro Dialog Box – As macros are selected, a 

dialog box is opened which contains the following options to fill 

(Fig. 5.6). 
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Fig. 5.6: Dialog Box 

In the dialog box, enter the name of the Excel macro in the Macro name. 

However, space cannot be used in the Macro name to separate the 

words, underscore (_) can be used for this purpose. Example: Macro name. 

There are some other options also in the dialog box, i.e., where to store the 

macro, the shortcut key which can be used to activate the macro, and the 

description for the macro created. They can be filled accordingly.  

 After filling in the dialog box, click on OK. 

 As soon as OK is clicked, Excel Macro records the set of operations the 

user is practicing. 

 Once, the work is done, in the Developer Tab, an option “Stop 

Recording” can be seen. Clicking on which the recording gets stopped and 

the created macro is saved (Fig. 5.7) 

 

Fig. 5.7: Developer Tab 

VBA EDITOR INTERFACE IN EXCEL 

Visual Basic for Applications (VBA) in Excel is a language that allows users to 

automate repetitive tasks and enhance Excel’s functionality far beyond its 

standard features. 

The VBA interface is a User-friendly interface with various components that 

helps you to work with VBA code efficiently. Below are some elements: 
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Toolbar and Menu Bar: VBA Editor consists of a standard toolbar as well as 

a Menu bar same as other Windows applications. The toolbar provides quick 

access to common actions, such as running or stopping the code from being 

executed (Fig. 5.8). 

 

Fig. 5.8: Tool Bar and Menu 

Project Explorer: It is located in the left pane of the VBA Editor. It shows a 

tree-like (hierarchical) view of all open workbooks, along with their 

components such as worksheets, modules, and user forms. This helps in 

navigating and managing different parts of the project during macro 

development (Fig. 5.9). 

 

Fig. 5.9: Project Explore 

Code Window: It is the main area of the VBA Editor where VBA code is 

written, viewed, and edited. It is linked to the selected object or module in the 

Project Explorer, and displays the code specific to that module or worksheet 

(Fig. 5.10). 

 

Fig. 5.10: Code Window 
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VISUAL BASIC FOR APPLICATIONS (VBA)  

Visual Basic for Applications (VBA) is a simple programming language used 

within Microsoft Office applications like Excel to automate tasks and create 

custom solutions. Learning VBA helps users perform complex operations 

quickly and efficiently without repeating manual steps. 

Variables in VBA 

In VBA, variables are used to store information that can be used and changed 

throughout a program. Just like in mathematics where letters can represent 

numbers, in VBA, variables can hold numbers, text, dates, or other types of 

data. 

Variables are named storage locations in memory that hold data values which 

can change during the execution of a program. 

Declaring Variables 

In VBA, variables must be declared before use, specifying their data type to 

allocate appropriate memory (Fig. 5.11). 

 

Fig. 5.11:  Example of Declaring Variables 

In this example: 

 Dim is a keyword used to declare (introduce) a variable. 

 Student Name is the name of the variable. 

 As String tells VBA that the variable will store text. 

 “Aamir” is the text assigned to the variable. 

Common Data Types: 

 Integer: Whole numbers (e.g., 10, -5) 

 Double: Decimal numbers (e.g., 3.14, -0.001) 

 String: Text (e.g., "Hello World") 
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 Boolean: True or False values 

Example of Variable Declaration: 

 

 

 

 

 

PRACTICAL EXERCISES 

Activity 1: Record and run a simple Macro to format a table in Excel 

automatically. 

Material Required: 

 Computers with MS Excel installed 

 Sample data table 

Procedure: 

1. Open Excel and load the sample data. 

2. Go to the “View” tab and select “Record Macro”. 

3. Name your Macro and assign a shortcut key (optional). 

4. Perform basic formatting steps like changing font size, adding borders, 

and applying colour. 

5. Stop recording. 

6. Run the recorded Macro using the assigned shortcut or from the Macro 

list. 

7. Observe how the steps are automatically repeated. 

8. Show to the teacher. 

Activity 2: Exploring the VBA Editor Interface: Open the VBA editor and 

locate the recorded Macro. 

Material Required: 

 Computers with MS Excel 

 A pre-recorded Macro 

Procedure: 

1. Open Excel and press Alt + F11 to open the VBA editor. 

2. Navigate the interface to find the recorded Macro under "Modules." 

Dim age As Integer 

Dim price As Double 

Dim name As String 

Dim is Available As Boolean 
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3. Double-click the module to view the code. 

4. Briefly explore the toolbar and code window. 

5. Close the editor after familiarization. 

Activity 3: Making Minor Modifications to Recorded Macros. 

Material Required: 

 Computers with MS Excel 

 Previously recorded Macro 

Procedure: 

1. Open Excel and go to the VBA editor (Alt + F11). 

2. Locate the recorded Macro. 

3. Find the line in the code where font colour is defined. 

4. Change the colour code (e.g., from black to blue). 

5. Save and close the editor. 

6. Run the Macro to see the changes in action. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks  

1. A __________ is a set of instructions that can be recorded to automate 

tasks in Excel. 

2. The shortcut key to open the VBA Editor in Excel is __________. 

3. The place where recorded Macros and VBA codes are stored is called 

the __________. 

4. In VBA, __________ are used to store data values that can change 

during program execution. 

5. The process of saving a sequence of tasks in Excel for automatic 

repetition is called __________. 

B. Multiple Choice Questions  

1. What does VBA stand for? 

a) Visual Basic for Analysis 

b) Visual Basic for Applications 

c) Virtual Basic Assistant 

d) Visual Basic Automation 

2. Which tab is commonly used to record a Macro in Excel? 
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a)  Insert 

b)  View 

c)  Data 

d)  File 

3. Which shortcut is used to open the VBA Editor? 

a)  Ctrl + F12 

b)  Alt + F11 

c)  Ctrl + Alt + V 

d)  Shift + F5 

4. In VBA, what is a Variable? 

a)  A permanent value 

b)  A storage location for data 

c)  A type of Excel worksheet 

d)  A shortcut key 

5. Which of the following is a correct basic VBA syntax? 

a)  Add Row 

b)  Range("A1"). Select 

c)  Insert = Cell 

d)  Go to Cell 

C.  Match the Columns 

 

Column A: Concept Column B: Description 

1. Macros 
A.  

Shortcut to open VBA editor 

2. VBA 
B.  

Stores recorded Macros and code 

3. VBA Editor 
C.  

Visual Basic for Applications 

4. Variables 
D.  

A recorded sequence of actions 

5. Alt + F11 
E.  

Used to store changing data 

D. Short Answer Questions  

1. What is a Macro in Excel? 

2. Why do we use Macros in Excel? 
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3. What is the purpose of the VBA Editor? 

4. Define a variable in VBA. 

5. Write an example of a basic VBA syntax. 

E. Long Answer Questions  

1. Explain the process of recording and running a basic Macro in Excel 

with an example. 

2. Describe the VBA Editor interface and its main components. 

3. Discuss the importance of using VBA for automating repetitive tasks. 

4. Explain in detail what variables are in VBA, and why they are 

important in programming. 

5. Write a simple VBA code that selects a cell, changes its font color to 

red, and explain each step. 

F. Check Your Performance 

1. Critically evaluate the benefits and limitations of using recorded Macros 

versus writing custom VBA code for automating repetitive tasks in Excel. 

Provide suitable business examples to support your answer. 

2. Examine the role of variables and syntax accuracy in VBA programming. 

How do errors in variable declaration and syntax affect the execution and 

outcome of a Macro? Justify your answer with examples. 

3. Design and develop a basic automated Excel report that includes 

formatting, chart updates, and data insertion using recorded Macros and 

minor VBA modifications. Explain the steps involved in your design. 

4. Create a scenario where a business process can be fully automated using 

Macros and VBA. Develop a step-by-step plan, including how Macros 

would be recorded, edited, and executed to solve the identified problem. 
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SESSION 2: AUTOMATING REPORTS AND DASHBOARDS 

ASSIGNING MACROS TO BUTTONS 

Assigning macros to buttons and keyboard shortcuts allows users to run 

automated tasks quickly and easily, improving efficiency and reducing 

manual errors. 

Following are the steps followed to assign a Macro to a Button in Excel: 

Step 1: Enable the Developer Tab 

 Go to File → Options → Customize Ribbon. 

 Check the Developer checkbox and click OK. 

Step 2: Insert a Button 

 On the Developer Tab, click Insert. 

 Under Form Controls, select the Button (Form Control). 

Step 3: Draw the Button 

 Click and drag on the worksheet to draw the button where you 

want it to appear. 

Step 4: Assign the Macro 

 After drawing the button, Excel automatically opens the 

Assign Macro window. 

 Select the desired macro from the list. 

 Click OK to confirm. 

Step 5: Rename the Button (Optional) 

 Right-click the button and select Edit Text. 

 Type a meaningful name for the button (Example: “Generate 

Report”). 

Step 6: Test the Button 

 Click the created button. 

 The assigned Macro will run automatically. 

ASSIGN KEYBOARD SHORTCUTS TO MACROS 

A keyboard shortcut allows a macro to be run quickly using a specific key 

combination. Use the Macro Options window in Excel to assign or remove a 

shortcut key. Follow the steps below: 
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1. Go to the Developer tab and click the Macros button. (If the Developer tab 

is not visible on the ribbon, it must be enabled from Excel Options.) (Fig. 

5.12). 

 
Fig. 5.12: Developer Tab and Macro Button 

 

2. In the Macro dialog box, select the macro to which the shortcut key will be 

assigned, and click the Options button (Fig. 5.13). 

 
Fig. 5.13: Macro Dialog Box 

 

3. In the Macro Options window, enter a letter, number, or symbol to create 

the shortcut key. To avoid conflicts with commonly used shortcuts (e.g., 

Ctrl+C for Copy), include Shift in the shortcut (e.g., Ctrl+Shift+C). (Fig. 

5.14) 

 
Fig. 5.14: Macro Options 
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4. To delete an existing shortcut key, open the Macro Options window again 

and remove the character from the shortcut field. Click OK to save changes 

(Fig. 5.15).   

 

Fig. 5.15: Macro Options 

AUTOMATE REPETITIVE TASKS IN EXCEL 

The Macro Recorder allows recording and creation of repetitive macros for 

tasks that involve multiple steps to complete. In cases where operations are 

time-consuming due to the number of actions required, the use of automation 

through the Macro Recorder is recommended to improve efficiency. 

Following are the steps to automate repetitive Tasks: 

Step 1: Identify Repetitive Tasks 

Start by pinpointing the tasks you frequently perform in Excel. Common 

examples include data entry, formatting, calculations, and report generation. 

Step 2: Macro Recording 

Each stage will be captured using the Macro Recorder. 

Step 3: Macro Editing (Optional) 

When necessary, the View > Macros > View Macros > Edit will be used to refine 

the macro. (Fig. 5.16) 

 

Fig. 5.16: Macro Editing  
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Fig. 5.16 displays several panels that appear based on the selected settings 

when the editor is opened. The panel on the right is introduced first, which 

displays the VBA code for the macro. Different panels are explained below: 

 Each macro begins with a Sub reference followed by the assigned macro 

name. This represents a Subroutine or sub procedure. 

 A series of green lines starting with an apostrophe (') are included. These 

are comments used to explain the macro. 

 Additional comments can be added by starting a line with an apostrophe 

('). Adding comments is useful when modifying a macro or for 

documentation purposes. 

 The black-coloured lines represent the macro’s actual code, including 

references to actions, properties, and objects. This section is effective for 

instructional purposes, as it shows how recorded steps are translated into 

code. In the earlier tutorial, specific columns such as A, D, J, K, L, and N 

were deleted using these code references. 

 The Explorer panel, though potentially overwhelming, is essential. Macro 

code is typically displayed in items labelled as Module. 

Steps to Automating Formatting Using Macros 

1. Go to the Developer Tab and click Record Macro. 

2. Give a name to your Macro (Example: “Format Report”). 

3. Select where to store the Macro (This Workbook is recommended). 

4. Click OK to start recording. 

5. Apply the formatting you need: 

 Change font size or style 

 Apply bold or italics 

 Set cell colours 

 Adjust borders 

6. When finished, click Stop Recording on the Developer Tab. 

7. Run the Macro anytime to apply the same formatting automatically. 

Steps to Automating Printing Using Macros 

1. Go to the Developer Tab and click Record Macro. 

2. Name the Macro (Example: “Quick Print”). 

3. Click OK to start recording. 

4. Go to File → Print and set the print settings (such as selected area, 

number of copies, page layout). 
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5. Print the document. 

6. Click Stop Recording. 

7. Run the Macro anytime to automatically print with the saved settings. 

Steps to Automating Chart Updates Using Macros 

1. Go to the Developer Tab and click Record Macro. 

2. Name the Macro (Example: “Update Chart”). 

3. Click OK to start recording. 

4. Select the chart and update: 

 The data range. 

 Chart type (if needed). 

 Chart title or labels. 

5. Click Stop Recording. 

6. Run the Macro anytime to automatically update the chart as per the 

recorded step 

SCHEDULING BASIC MACRO EXECUTION 

Microsoft Excel does not provide a built-in scheduling feature for Macros. 

However, Macro execution can be scheduled using Windows Task Scheduler 

by linking it to a workbook containing an Auto-Run Macro. Follow the steps 

below: 

Step 1: Create an Auto-Run Macro 

1. Open Excel workbook. 

2. Press Alt + F11 to open the VBA Editor. 

3. In the left panel, double-click This Workbook. 

4. Type the following code to automatically run a Macro when the 

workbook opens: 

Private Sub Workbook_Open () 

          Call YourMacroName 

End Sub 

5. Replace Your Macro Name with the name of your Macro. 

6. Save the workbook as Excel Macro-Enabled Workbook (*.xlsm). 

 

Step 2: Use Windows Task Scheduler 

1. Open Task Scheduler on your computer. 

2. Click Create Basic Task. 

3. Give the task a Name and Description. 
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4. Choose when you want the Macro to run (Daily, Weekly, On Start-

up, etc.). 

5. In the Action step, select Start a Program. 

6. Browse and select Excel.exe from your system (Ex:  C:\Program 

Files\Microsoft Office\root\OfficeXX\EXCEL.EXE). 

7. In the Add Arguments (optional) field, enter the full file path of your 

Macro workbook in double quotes, like this: 

“C:\Users\YourName\Documents\MacroWorkbook.xlsm” 

8. Click Finish to schedule the Macro. 

PRACTICAL EXERCISES 

Activity 1: Assigning Macros to Buttons and Shortcuts. 

Situation: You frequently apply the same formatting style to a set of reports. 

Instead of manually applying the formatting each time, you want to create a 

macro and assign it to a button and a keyboard shortcut to speed up the 

process. 

Task: Create a macro that formats a report table (sets font size, bolds headers, 

applies borders), assign it to a button on the sheet, and link it to a custom 

keyboard shortcut. 

Material Required: 

 Excel with Developer tab enabled 

 Basic knowledge of recording macros 

 Understanding of button insertion and macro assignment 

Procedure: 

1. Open Excel and enable the Developer tab. 

2. Create a sample report table. 

3. Start recording a macro named “Format Report”. 

4. Apply the following formatting while recording: 

 Bold and centre-align headers 

 Set font size to 12 

 Apply borders to all cells 

5. Stop recording the macro. 

6. Insert a button from the Developer tab. 

7. Assign the “Format Report” macro to the button. 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

237 
 

8. Test the button functionality. 

9. Go to Options > Customize Ribbon > Keyboard Shortcuts. 

10. Assign a shortcut key (e.g., Ctrl + Shift + F) to the “Format Report” macro. 

11. Test the keyboard shortcut. 

Activity 2: Automating Repetitive Tasks (Formatting, Printing, Updating 

Charts). 

Situation: Your team prepares weekly sales reports with the same formatting, 

printing, and chart updates. Manually completing these tasks is time-

consuming. 

Task: Create a macro that: 

 Formats the sales report table 

 Updates the sales chart 

 Prints the report automatically 

Material Required: 

 Sample sales report data and chart 

 Familiarity with recording macros 

 Knowledge of printing setup in Excel 

Procedure: 

1. Prepare a sample sales data table and insert a corresponding chart. 

2. Start recording a macro named “Weekly Report”. 

3. Apply desired formatting to the table (font style, colours, borders). 

4. Refresh or update the chart to reflect any changes. 

5. Set up the print area and printing preferences. 

6. Print the sheet (this will be recorded in the macro). 

7. Stop recording the macro. 

8. Assign this macro to a custom button or shortcut key for easy execution. 

9. Test the macro by running it on a new set of data. 

Activity 3: Scheduling Basic Macro Execution. 

Situation: You want to ensure a report is automatically updated and printed 

every Friday at 4 PM without manual intervention. 

Task: Schedule a macro to automatically update and print the report on a 

specific day and time. 

Material Required: 
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 Excel 

 Windows Task Scheduler (if using personal systems) 

 Basic VBA knowledge (if needed to write a refresh-print macro) 

Procedure: 

1. Record or write a macro named “Auto Weekly Report” that updates the 

report and prints it. 

2. Save the Excel file as a Macro-Enabled Workbook (.xlsm). 

3. Create a Windows Task Scheduler task: 

 Open Task Scheduler and create a new task. 

 Set the trigger to Weekly on Fridays at 4 PM. 

 Set the action to open the specific Excel file. 

4. In the Excel file, set up a Workbook Open event in VBA: 

Private Sub Workbook Open () 

          Call Auto Weekly Report 

End Sub 

5. Save and close the workbook. 

6. Test the scheduled task by manually running it from the Task Scheduler. 

7. Verify that the macro automatically updates and prints the report when 

the file opens. 

CHECK YOUR PROGRES 

A. Fill in the Blanks 

1. The __________ tab in Excel allows you to access Macro recording and 

assignment options. 

2. A macro can be assigned to a __________ to enable quick execution with 

a single click. 

3. The __________ key combination is commonly used to assign shortcuts 

to macros. 

4. Automating __________ tasks like formatting, printing, and chart 

updating saves time and reduces manual errors. 

5. To schedule macro execution automatically on a specific day and time, 

__________ __________ is used in Windows. 

B. Multiple Choice Questions  

1. Which of the following is required to record a macro in Excel? 

a)  Enabling the Developer tab 

b)  Inserting a chart 
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c)  Creating a pivot table 

d)  Using Conditional Formatting 

2. What type of file must you save your workbook as to store macros? 

a)  .xlsx 

b)  .xlsm 

c)  .csv 

d)  .txt 

3. Which tool allows you to automate the opening of Excel files and trigger 

macros at specific times? 

a)  Excel Scheduler 

b)  Windows Task Scheduler 

c)  Excel Timer 

d)  Macro Launcher 

4. Which shortcut key is commonly used for assigning macro shortcuts? 

a)  Alt + F4 

b)  Ctrl + Shift + (Key) 

c)  Ctrl + P 

d)  F12 

5. What happens when you assign a macro to a button in Excel? 

a)  The macro is permanently deleted 

b)  The macro is copied to another file 

c)  The macro runs when the button is clicked 

d)  The button automatically prints the sheet 

C. Match the Columns 

Column A Column B 

1. Developer Tab A. Schedule automatic macro execution 

2. 
Assign Macro to 

Button 
B. Enables macro recording 

3. Ctrl + Shift + Key C. Quick macro execution 

4. 
Windows Task 

Scheduler 
D. Run macro by clicking 

5. Automating Tasks E. Reduces manual effort 

D. Short Answer Questions 

1. What are the benefits of assigning macros to buttons in Excel? 
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2. Explain how keyboard shortcuts can improve the efficiency of macro 

execution. 

3. List two repetitive tasks that can be automated using Excel macros. 

4. What is the role of Windows Task Scheduler in macro automation? 

5. What file format is required to store and run macros in Excel? 

E. Long Answer Questions 

1. Explain in detail the process of assigning a macro to a button and a 

keyboard shortcut in Excel. Provide step-by-step instructions. 

2. Describe how you can automate repetitive tasks such as formatting, 

printing, and updating charts using macros. Support your answer with 

practical examples. 

3. Discuss the steps involved in scheduling a macro to run automatically 

using Windows Task Scheduler. Why is this feature useful in an 

organization? 

4. How can automating repetitive tasks in Excel improve productivity in 

large-scale reporting processes? Provide real-world scenarios to support 

your answer. 

5. Compare and contrast the manual execution of tasks versus macro-

based automation in Excel. Highlight the advantages and potential 

risks of using macros. 

F. Check Your Performance  

1. Evaluate a scenario where a company relies on manual report 

formatting and printing. Discuss how macro automation can improve 

the process and what risks need to be managed. 

2. Create a detailed plan for developing, testing, and scheduling a macro 

that automates the following: 

 Formatting a weekly report 

 Updating sales charts 

 Printing the report 

 Automatically triggering the macro every Monday at 9 AM 

3. Develop a solution to automate end-of-day reporting in Excel, including 

macro design, button placement, shortcut assignment, and scheduling 

using external tools. 

4. Assess the effectiveness of using Windows Task Scheduler for 

automating Excel macros. What improvements can be made to ensure 

smooth and error-free execution? 

  



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

241 
 

SESSION 3: ANALYTICAL REPORTS 

An analytical report is a written business document that companies of all 

sizes use to explore business opportunities, solve problems, and make more 

intelligent decisions. This report includes both quantitative and qualitative 

data to present a complete analysis of the problem. 

When preparing analytical reports, the format chosen affects how well the 

information is communicated and understood. Below are the common types 

of analytical report formats: (Fig. 5.17) 

 

Fig. 5.17: Analytical Report Format 

1. Tabular Format 

The tabular format is a method of presenting information using tables 

organized into rows and columns. This structured layout allows data to be 

arranged systematically, making it easy to locate, compare, and interpret 

specific pieces of information. 

Data is divided into categories or fields (represented as column headers). 

Each row typically represents a record, entry, or unit of analysis. Tables 

can be sorted, filtered, and used for quick analysis of patterns and trends. 

Often used with large volumes of data because it minimizes clutter and 

maximizes clarity. 

Advantages: 

 Easy to read and understand for users familiar with numbers. 

 Supports sorting, filtering, and basic calculations. 

 Efficient for showing structured and standardized data. 

Limitations: 

 Lacks context and storytelling: It only presents raw data without 

explanation. 

 Not visually engaging: Especially for senior management who may 

prefer charts or narratives. 

 Can be overwhelming if the dataset is too large without summarization. 
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2. Narrative Formats 

The narrative format is a style of presenting analytical reports where the 

focus is on explanation, interpretation, and storytelling using descriptive 

text. Instead of just presenting raw data, the narrative format walks the 

reader through the meaning behind the data, providing context, causes, 

and actionable recommendations. 

Advantages of Narrative Format: 

 Provides Context: The narrative format goes beyond numbers and 

explains the background, reasons, and impact of the data. It helps 

readers understand not just what happened but why it happened. 

 Supports Decision-Making: Narrative reports usually include 

recommendations and strategic insights that guide managers and 

executives in making informed decisions. 

STRUCTURE OF ANALYTICAL REPORTS 

An analytical report follows a systematic structure to ensure that data, 

analysis, and conclusions are presented in a clear, logical, and actionable 

manner.  

1. Title Page: Report title, author’s name, date of submission, and 

sometimes the name of the organization. Clearly identifies the topic and 

scope of the report. 

2. Table of Contents: It includes List of sections and page numbers. 

Provides quick navigation through the report. 

3. Executive Summary: Brief summary of the purpose, key findings, 

conclusions, and recommendations. Gives busy decision-makers a quick 

overview without reading the entire report. 

4. Objectives / Purpose of the Report: It Includes Clear statement of what 

the report aims to analyse or solve. Sets the focus and direction for the 

analysis. 

5. Methods / Methodology: Description of how data was collected, 

analysed, and tools used (surveys, Excel analysis, financial models, etc.). 

Ensures the analysis is reliable and can be replicated if needed. 

6. Data Analysis / Findings: Provides evidence and explains trends, 

comparisons, and patterns found in the data. It Includes Presentation of 

data through: 

 Tables 

 Charts 

 Graphs 

 Text-based analysis (if using narrative format) 
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7. Discussion / Interpretation: It Includes In-depth explanation of the 

results, reasons for the findings, and the potential impact. Adds meaning 

to the data and connects it to the business or research objectives. 

8. Conclusions: Summarizes the key points and answers the report’s 

original objectives and Provides closure and highlights what was learned 

from the analysis. 

9. Recommendations: It Includes Actionable steps or strategies based on 

the findings. Guides the reader on what to do next. 

10. Appendices (If needed): It Includes Supporting documents, raw data, 

detailed calculations, or additional charts. Keeps the main report clean 

while providing additional details if required. 

        Summary of the Sections of the Analytical Report 

Section Purpose 

Title Page Identifies the report 

Table of Contents Helps navigation 

Executive Summary Quick overview for decision-makers 

Objectives States the report’s objectives/ purpose 

Methods Explains how data was gathered/analysed 

Data Analysis Presents evidence and findings 

Discussion Explains the significance of the results 

Conclusions Summarizes the key takeaways 

Recommendations Suggests actionable steps 

Appendices Provides detailed supporting information 

STRUCTURE OF ANALYTICAL REPORTS IN THE CONTEXT OF 

FINANCIAL SERVICES 

In the financial services sector, Management Information System (MIS) 

reports help monitor and evaluate different business functions such as sales, 

branch performance, and risks. These reports assist managers in making 

decisions based on data trends and operational performance. 

A. Monthly Sales Report 

The Monthly Sales Report is a critical business document that provides a 

snapshot of sales performance over a specific month. It helps decision-
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makers track progress, identify trends, and make informed strategic 

choices. 

A Monthly Sales Report provides a structured, data-driven summary of 

sales activities and outcomes over a specific month. It helps businesses 

track performance, analyse trends, and make informed decisions. 

COMPONENTS OF MONTHLY SALES REPORT 

Main Parts of a Monthly Sales Report: 

1. Title: Clearly shows the reporting month. 

Example: “Monthly Sales Report – March 2025” 

2. Objective: Tells why the report is made. 

Example: To check how much was sold and compare it with 

targets. 

3. Data Sources: Where the sales data comes from. 

Example: Billing system, sales records, or Excel sheets. 

4. Methods: Explains how the data is grouped or calculated. 

Example: Total sales, sales by product, or by region using Excel 

or PivotTables. 

5. Analysis: Looks deeper into the data. 

Examples: 

 Actual vs Target → Did we meet our goals? 

 Growth → Is this month better than last month? 

 Top Performers → Which product or branch sold the most? 

6. Visuals: Charts or tables that show data clearly. 

Examples: Bar charts, line graphs, and summary tables. 

7. Conclusion: A short summary of the report’s findings. 

Example: Sales improved by 6%, but one region missed its 

target. 

8. Recommendations: Suggestions based on the report. 

Example: Promote the best-selling product or improve support 

in low-performing areas. 

B. Branch Performance Report: 

A Branch Performance Report is a comprehensive tool used by 

organizations, especially banks and retail businesses, to evaluate and 

monitor the performance of their individual branches. These reports help 
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identify best practices, areas needing improvement, and align branch 

activities with overall strategic goals. 

Key Components of a Branch Performance Report 

1. Performance Metrics and KPIs: Branch performance reports highlight 

important measures called Key Performance Indicators (KPIs). These 

include data like revenue, expenses, profits, and customer satisfaction. 

Comparing KPIs across different branches helps identify which 

branches are doing well and which need improvement. It supports 

better decision-making and targeted support. 

2. Financial Analysis: The report shows detailed financial information 

for each branch, such as how much money is earned and spent. It may 

also include analysis by product line or customer type. Using methods 

like activity-based costing, the report ensures that costs are shared 

properly among branches, helping to understand how profitable each 

one truly is. 

3. Customer and Market Insights: This section includes information 

about the type of customers each branch serves and which products 

are popular. It also looks at the local market, such as population, 

income levels, and job availability. These insights help branches 

understand their surroundings and how to better serve customers or 

expand business. 

4. Operational and Staff Planning: Reports may also track how 

efficiently branches are working like how many transactions are 

completed, how productive staff are, and how many employees are 

needed. This helps in planning staff levels, improving operations, and 

using resources wisely to meet the branch’s goals. 

5. Reporting and Visualization Tools: To make the data easy to 

understand, the report often includes dashboards, charts, and tables. 

Users can filter information, save different views, and share reports 

easily. These visual tools make it simpler for managers to spot trends, 

compare branches, and take quick action when needed. 

Benefits and Uses 

 Strategic Alignment: Ensures branches align with corporate objectives 

such as revenue growth, customer retention, and cost control. 

 Performance Monitoring: Enables branch managers and higher-level 

executives to track progress against targets and benchmarks regularly. 

 Decision Support: Combines internal performance data with external 

market factors to inform branch expansion, marketing campaigns, and 

product development. 
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 Efficiency Improvements: Identifies operational inefficiencies and 

supports staff planning to optimize branch productivity. 

 Enhanced Reporting: Automated and integrated reporting tools reduce 

manual effort and data redundancy, improving accuracy and timeliness 

of performance insights. 

Example: Solutions and Tools 

 Calxa: Offers branch KPI comparison reports and visual breakdowns of 

income and expenses by business unit. 

 Phrazor: Provides automated branch performance reports that eliminate 

manual data consolidation and improve reporting efficiency. 

 IBM Cognos Branch Performance Blueprint: A sophisticated solution 

combining internal data and external market analysis for detailed 

profitability planning, forecasting, and real-time monitoring. 

 Branch Dashboard: Provides campaign performance reports with 

customizable filters and trend graphs to analyse marketing impact across 

branches. 

C. Risk Analysis Report 

A Risk Analysis Report is a structured document that identifies, assesses, 

and provides strategies to manage potential risks that an organization or 

project may face. It is essential for understanding uncertainties, 

minimizing losses, and supporting informed decision-making. 

Key Elements of a Risk Analysis Report 

1. Risk Identification: This involves listing potential risks that could 

impact the organization or project. These risks can be commercial, 

financial, operational, environmental, reputational, compliance-related, 

health and safety, strategic, or workforce-related. 

2. Risk Assessment: This step evaluates the likelihood (probability) and 

impact (severity) of each identified risk. Tools such as risk matrices, 

decision trees, Failure Mode and Effects Analysis (FMEA), and bowtie 

models are commonly used to quantify and prioritize risks. 

3. Risk Characterization and Analysis: The report characterizes risks 

by estimating their consequences and how serious they could be. It also 

may include root cause analysis to understand underlying issues and 

failure mode analysis to identify potential process failures. 

4. Risk Management and Mitigation Plans: The report outlines risk 

management strategies and control measures to mitigate or eliminate 

risks. This includes a risk corrective action plan detailing how to 

respond if a risk materializes. 
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5. Risk Communication: Effective communication of risk findings to 

stakeholders is vital. The report should present risks clearly, often 

using dashboards, heat maps, and visual analytics to ensure 

understanding and facilitate decision-making. 

6. Supporting Data and Documentation: A risk report often includes a 

risk register (listing risks, their owners, rankings, and responses), 

performance data reviews, project schedules, and status updates to 

provide context and track risk management progress. 

Types of Risk Analysis Included 

 Risk-Benefit and Cost-Benefit Analysis: Weigh advantages and 

disadvantages or costs against benefits to guide decisions. 

 Needs Assessment: Identifies gaps in resources or capabilities critical 

to success. 

 Business Impact Analysis: Evaluates the effect of disruptions and 

helps prioritize recovery efforts. 

 Failure Mode and Effects Analysis (FMEA): Identifies potential failure 

points to improve reliability and reduce costs. 

 Root Cause Analysis: Investigates fundamental causes of problems to 

prevent recurrence. 

Benefits of a Risk Analysis Report 

 Minimizes losses by anticipating adverse events and planning 

responses. 

 Strengthens security and operational resilience. 

 Improves resource allocation by focusing efforts where risks are 

highest. 

 Enhances compliance with regulatory requirements. 

 Supports strategic decision-making by balancing risks and benefits. 

Tools and Software for Risk Analysis Reporting 

Several software platforms facilitate risk analysis reporting by integrating 

data, automating workflows, and providing advanced analytics and 

visualization: 

 Risk connect: Offers customizable dashboards, heat maps, predictive 

and prescriptive analytics, and easy report building for decision-ready 

insights. 

 IBM OpenPages: A governance, risk, and compliance (GRC) platform 

with workflow automation and reporting capabilities. 
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 Service Now GRC: Cloud-based platform with incident management, 

risk assessment, mitigation planning, and continuous surveillance. 

 Risk Optics: Provides operational risk management with customizable 

risk calculations and compliance management. 

Perform Risk Analysis (Summary Steps) 

1. Identify hazards and risks relevant to the organization or project. 

2. Evaluate risks by assessing their likelihood and potential impact using 

appropriate tools. 

3. Decide on and implement control measures to mitigate risks. 

4. Document findings thoroughly to maintain records and support 

transparency. 

5. Review and update the risk analysis regularly to reflect changes in 

conditions or new information. 

EXCEL OUTPUT IN REPORTS 

When using Excel output in reports, especially visuals like charts or pivot 

tables, it is important to consider how to export, clean, format, and embed 

these visuals effectively. Below is a detailed overview covering exporting 

visuals, cleaning and formatting them, and the pros and cons of using 

screenshots versus linked objects. 

1. Exporting Excel Visuals for Reports 

 Exporting Data with Live Connection: When Excel visuals are 

connected to dynamic data sources such as Power BI, export options 

allow maintaining a live connection. This enables the Excel workbook 

to refresh data directly from Power BI visuals, ensuring real-time 

accuracy in reporting. 

 Exporting Pivot Tables and Charts: The “Copy as Picture” feature in 

Excel can be used to export pivot tables or charts as images while 

retaining their visual layout and formatting. This is especially useful for 

inserting visuals into documents or presentations. 

 Export to PDF: Exporting Excel reports or charts as PDFs ensures 

consistent formatting and layout across devices and platforms. This 

reduces the risk of misinterpretation and preserves the visual integrity 

of the report. 

2. Cleaning and Formatting Excel Visuals 

 Data Cleaning: Prior to creating visuals, data should be cleaned by 

removing duplicates, correcting spelling errors, standardizing text case, 
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and eliminating blank rows or columns. Use Excel formulas to process 

the data, and replace formulas with values to stabilize the dataset. 

 Formatting Charts: Select appropriate chart types that suit the data 

and intended message. Avoid unnecessary clutter, apply consistent 

colour schemes to emphasize key points, and customize labels and 

titles for clarity. Use legible fonts and minimize excess gridlines and 

labels to maintain chart readability. 

 Consistent Formatting: Apply templates and uniform styling across 

all reports to ensure a professional appearance and enhance 

stakeholder engagement. 

3. Screenshot vs. Linked Object 

Aspect Screenshot (Static Image) 
Linked Object (Dynamic 

Link) 

Data Update 

Does not update if source 

data changes; static 
snapshot 

Updates automatically when 

source Excel file changes 

File Size 
Typically, smaller, as it’s 

just an image 
Can increase file size due to 

embedded data 

Interactivity No interactivity; fixed image 
Can be edited or interacted 
with by opening in Excel 

Ease of Use 
Simple to insert and 

position anywhere 

Requires source file access 
and can be more complex to 

manage 

Reliability 
Always displays exactly as 
captured, no broken links 

Risks broken links if source 
file is moved or renamed 

Collaboration 
Good for sharing finalized 

reports without source 

dependencies 

Better for ongoing reports 
needing live data updates 

ADDING TABLES AND VISUALS  

1. Choosing the Right Chart 

Selecting the appropriate chart type depends on the nature of the data and 

the message to be conveyed: 

 Use Bar or Column Charts to compare quantities across categories. 

 Use Line Charts to show trends over time. 

 Use Pie Charts to show percentage distribution. 
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 Use Scatter Charts to show relationships or patterns between two 

numeric variables. 

2. Table formatting 

Effective tables should be easy to read and facilitate comparison: 

i) Layout and Arrangement: 

 Arrange numerical data in columns for easier vertical 

comparison. 

 Place time-series categories across columns. 

 Calculated values should be to the right of the source data 

columns. 

 Indent subentries or use separate columns instead of cut-in rows 

for hierarchical data. 

ii) Alignment: 

 Left-align text (especially in stub columns) for readability. 

 Right-align numbers and ensure consistent decimal places for 

easier comparison. 

iii) Visual Design: 

 Use thin, light lines sparingly—preferably only to separate 

headers and footers. Avoid heavy grids that clutter the table. 

 Employ white space generously to improve readability; a row 

height roughly doubles the font size is recommended. 

 Use subtle shading or zebra striping for alternate rows to guide 

the eye, especially in wide tables. 

 Highlight important data with noticeable but not overwhelming 

colours. 

 Remove duplicates and unnecessary 

iv) Sorting and Grouping: 

 Sort data by rank or time when applicable. 

 Group related data logically (e.g., sales by country). 

v) Text Orientation: Use horizontal text orientation for all table text 

to maintain readability. 

vi) Font: Use a legible, consistent font throughout the table. 

3. Enhancing Visuals in Reports 
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The following are to be followed to make visuals more effective and 

engaging: 

 Purpose and Clarity: Ensure each visual has a clear purpose and is 

tailored to the audience. Avoid adding visuals that do not contribute to 

the main message. 

 Simplicity: Keep visuals simple; remove unnecessary elements like 

excessive gridlines, labels, or colours that distract from the data. 

 Use Colour Strategically: Use colour to highlight key data points or 

differentiate categories. Stick to a cohesive colour palette aligned with 

your brand or report theme. 

 Labels and Annotations: Use clear labels and brief annotations to 

explain what the visual shows, making it easier to interpret. 

 Interactive Elements: When possible, incorporate interactive visuals 

(e.g., dashboards) to allow users to explore data dynamically. 

 Contextualization: Provide context around visuals to help readers 

understand the significance of trends or outliers. 

 Accessibility: Use high-contrast colours and ensure visuals are 

accessible to all users, including those with colour vision deficiencies. 

PRACTICAL EXERCISES 

Activity 1: Developing a Sample Analytical Report using Excel (Sales Report 

for Q1). 

Situation: A company wants to track and evaluate its sales performance for 

the first quarter (Q1) of the year. As a data analyst, you need to develop an 

analytical report using Excel. 

Task: Prepare a Quarterly Sales Report for Q1 using Excel. The report should 

summarize sales by product, region, and month, and include visual elements 

like charts. 

Material Required: 

 Excel software 

 Sales data (sample data provided or created by students) 

 Basic Excel skills: charts, tables, formulas 

Procedure: 

1. Gather or create sample sales data for Q1 (January, February, March) for 

multiple products and regions. 

2. Use Excel to: 
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 Calculate total sales per month. 

 Summarize sales by product and region using PivotTables or summary 

tables. 

3. Create visualizations: 

 Bar charts for product-wise sales. 

 Line charts for monthly trends. 

4. Format tables and charts for clarity and presentation. 

5. Prepare an Excel report file showing both raw data and summarized 

analysis. 

Activity 2: Integrating Excel Elements into a Word Document with 

Descriptions. 

Situation: Manager requires the Excel analysis to be presented in a 

professional Word document for client review. 

Task: Create a Word document report by embedding Excel tables and charts. 

Provide clear descriptions and interpretations for each visual. 

Material Required: 

 Microsoft Word and Excel 

 Completed Excel sales report from Activity 1 

 Writing skills for report description 

Procedure: 

1. Open a new Word document and insert the title: Quarterly Sales Report – 

Q1 2025. 

2. Write an introduction summarizing the report’s objectives. 

3. Embed formatted Excel tables (copy as linked objects or embedded 

content). 

4. Insert Excel charts with appropriate headings. 

5. For each table or chart: 

 Write a short description explaining what the data shows. 

 Provide brief interpretations (e.g., top-selling product, regional 

performance). 

6. Summarize findings and add conclusions at the end of the report. 

7. Save the document as Draft Report – Q1 2025. 

Activity 3: Presenting Draft Reports in Small Groups. 
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Situation: You will present your draft report to your classmates in a small 

group to receive peer feedback and improve your final report. 

Task: Present your draft analytical report and explain the key findings using 

your Word and Excel documents. 

Material Required: 

 Draft analytical report (Word file) 

 Excel analysis file 

 Presentation preparation (5-7 minutes) 

Procedure: 

1. Prepare a short oral presentation covering: 

 Purpose of the report. 

 Key sales trends and findings. 

 How the tables and visuals support your analysis. 

2. Share your Word and Excel files with your group. 

3. Present your draft report to your classmates in a small group. 

4. Receive feedback on: 

 Clarity of visuals. 

 Quality of analysis. 

 Report structure and formatting. 

5. Take notes on suggested improvements. 

6. Use the feedback to revise your final report. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks 

1. In a __________ format, data is presented in structured tables for quick 

reference and numerical analysis. 

2. The __________ section of a business report typically summarizes key 

findings and provides actionable insights. 

3. A __________ object in Excel updates automatically when the source 

data changes, while a screenshot remains static. 

4. A __________ chart is most appropriate for showing trends over time. 

5. Cleaning and __________ visuals in Excel ensure that charts and tables 

are clear, readable, and professionally presented. 

B. Multiple Choice Questions 
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1. Which of the following is an advantage of the narrative format in 

analytical reports? 

a) Easy to scan numerical data 

b) Supports decision-making with explanations 

c) Best for periodic summaries 

d) Requires minimal reading time 

2. What is NOT a typical component of a business analytical report? 

a) Title 

b)  Fictional Story 

c)  Methods 

d)  Conclusion 

3. Which type of visual in Excel is best for comparing categories? 

a) Line Chart 

b) Pie Chart 

c) Bar Chart 

d) Scatter Plot 

4. Which of the following is a disadvantage of using screenshots in 

reports? 

a) They update automatically 

b)  They are easy to paste 

c)  They remain static even if data changes 

d) They can be resized 

5. Which report is commonly used to evaluate operational and financial 

outcomes of individual branches? 

a) Risk Analysis Report 

b) Branch Performance Report 

c) Monthly Sales Report  

d) Marketing Plan Report 

C. Match the columns 

Column A Column B 

1. Tabular Format A. Decision support with explanations 

2. Narrative Format B. Tracks monthly sales performance 

3. Monthly Sales Report C. Static image, not auto-updating 

4. Linked Object (Excel) D. Quick reference of numerical data 

5. Screenshot E. Updates automatically with source 
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D. Short Answer Questions 

1. What is the key difference between a tabular format and a narrative 

format in analytical reports? 

2. Why is it important to clean and format visuals before inserting them 

into a report? 

3. List two advantages of using linked Excel objects instead of screenshots 

in business reports. 

4. Name three key components of a business analytical report. 

5. What is the purpose of a Risk Analysis Report in financial services? 

E. Long Answer Questions 

1. Explain the structure of a business analytical report. Describe the 

purpose of each section (Title, Objectives, Methods, Analysis, 

Conclusion). 

2. Compare the advantages and disadvantages of using screenshots vs. 

linked objects when adding Excel outputs to reports. Provide examples. 

3. Discuss the differences between tabular and narrative analytical report 

formats. When would each format be most appropriate? Provide 

examples from financial services. 

4. Describe the steps and considerations involved in adding tables and 

visuals to a report. How can selecting the right chart type enhance 

understanding? 

5. Write a detailed explanation of how a Monthly Sales Report is prepared, 

including data sources, analysis methods, visual representations, 

conclusions, and recommendations. 

F. Check Your Performance 

1. Analyse the advantages and potential limitations of using visuals like 

bar charts and line graphs in a Monthly Sales Report. When might 

visuals mislead decision-makers? 

2. Design a Monthly Sales Report template that includes tabular data, 

narrative summaries, and appropriate Excel visuals. Explain your 

design choices and how they improve report clarity. 

3. Develop a strategy to automate the process of exporting, cleaning, and 

integrating Excel visuals into analytical reports. Your strategy should 

ensure the reports remain accurate and easy to update. 
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SESSION 4: PROFESSIONAL PRESENTATIONS 

DESIGN PRINCIPLES FOR SLIDE DECKS 

The core design principles for creating engaging slide decks are centered 

around clarity, visual impact, and audience engagement. Based on expert 

recommendations and best practices, these principles include: 

1. Storytelling Structure 

 Design the slide deck like a story with a clear beginning, middle, and 

end to guide the audience smoothly through your message. 

 Use intentional narrative gaps, questions, or hints to engage curiosity 

and keep the audience eager to follow along. 

2. Simplicity and Focus 

 Stick to one main idea per slide to avoid overwhelming viewers. 

 Minimize text and bullet points; use concise, clear language. 

 Avoid clutter by removing unnecessary elements and focusing on key 

messages. 

3. Consistency 

 Maintain a uniform look and feel throughout the deck using consistent 

fonts, colours, layouts, and styles. 

 This cohesion helps the audience focus on content rather than 

distracting design changes. 

4. Visual Hierarchy and Readability 

 Use size, contrast, and positioning to guide the viewer’s eye to the most 

important information first. 

 Make slide titles larger and bolder than supporting text. 

 Employ whitespace generously to avoid crowding and improve 

comprehension. 

5. Use of Strong Visuals 

 Replace or complement text with relevant, original visuals such as 

images, charts, graphs, and icons to make data and concepts more 

memorable. 

 High-quality visuals should support the message without distracting 

from it. 

6. Audience-Centered Design 
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 Tailor content and visuals to the audience’s knowledge, interests, and 

needs. 

 Design slides to help the audience succeed in understanding, not just 

to support the speaker’s script. 

7. Clear Typography and Colour Use 

 Choose easy-to-read fonts and ensure text size is legible from a 

distance. 

 Use a limited number of fonts and consistent color schemes with high 

contrast for accessibility. 

8. Minimal and Effective Use of Multimedia: Incorporate multimedia 

elements like videos or animations sparingly to enhance engagement 

without overwhelming the audience 

EXCEL CHART INTEGRATION IN SLIDE DECKS 

Integrating Excel charts into slide decks, particularly PowerPoint 

presentations, can be done in several ways depending on whether static 

visuals or dynamic, updateable links are required. The following are the core 

methods and best practices for integrating the excel charts in slide Docks. 

1. Copy and Paste Excel Charts into PowerPoint 

i) Simple Copy-Paste: Select the chart in Excel, copy it (Ctrl+C), then 

paste it into PowerPoint (Ctrl+V). This creates a static image of the chart 

by default. 

ii) Paste Options: After pasting, different paste options can be selected; 

 Use Destination Styles: Formats the chart to match PowerPoint’s 

style but is not linked to Excel data. 

 Keep Source Formatting: Maintains Excel’s look but remains static. 

 Embed: Embeds the Excel chart as an object, allowing editing within 

PowerPoint but increases file size. 

 Picture: Pastes as an image, no editing or updates possible. 

2. Linking Excel Charts for Dynamic Updates 

 Paste Special with Paste Link: Use PowerPoint’s Paste 

Special feature and select Paste Link to create a live connection 

between the Excel chart and the PowerPoint slide. 

 Benefits: 

i. The chart in PowerPoint updates automatically when the Excel 

data changes. 
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ii. Ensures data consistency and saves time on manual updates. 

 Requirements: 

i. Both Excel and PowerPoint files must be saved and accessible, 

preferably in the same folder to avoid broken links. 

ii. Need to manually update links in PowerPoint or set automatic 

update options. 

3. Embedding Excel Objects 

 Entire Excel worksheets or selected ranges can be embedded into 

PowerPoint slides as objects. 

 Embedded objects can be edited within PowerPoint by double-clicking, 

opening an Excel interface inside the slide. 

Best Practices for Excel Chart Integration 

 Simplify and Clean Charts in Excel: Remove unnecessary gridlines, 

labels, and colours before copying to improve clarity and visual consistency 

in the presentation. 

 Match Design: Adjust chart colours and fonts to match the theme of the 

slide deck. 

 Manage File Locations: Keep linked Excel and PowerPoint files together 

to prevent broken links. 

 Test Updates: Before presenting, verify that linked charts update correctly 

and that embedded objects open without issues. 

 Use Embedded Charts for Static Data: When data won’t change, 

embedding or pasting as pictures reduces dependency on external files. 

 Use Linked Charts for Dynamic Data: When data changes frequently, 

linking ensures that the presentation always reflects the latest figures. 

PRESENTATION SKILLS   

Good presentation skills enhance the effectiveness of a slide deck and help 

communicate ideas clearly and confidently. While slides provide structure and 

visual support, the speaker's delivery plays a key role in engaging the 

audience. The following skills are essential to complement any slide 

presentation: 

1. Clear and Confident Speaking: Presenting with clarity and confidence 

ensures that the message is understood by the audience. Speaking at a 

moderate pace with proper pronunciation allows the listener to follow along 

easily. Confidence in tone helps build credibility, while pauses can be used 
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effectively to emphasize key points or allow time for the audience to absorb 

information. 

2. Body Language and Eye Contact: Non-verbal cues such as posture, facial 

expressions, and gestures play a significant role in communication. 

Maintaining eye contact builds trust and keeps the audience engaged. 

Using natural body language and avoiding nervous habits can make the 

speaker appear more assured and connected with the audience, enhancing 

the delivery of the message. 

3. Voice Modulation: Varying pitch, tone, and volume helps to maintain 

audience interest and avoids a monotonous delivery. Emphasizing 

important words or phrases through voice modulation can draw attention 

to critical information. A lively and expressive tone also adds energy to the 

presentation, making it more impactful and easier to follow. 

4. Effective Use of Slides: Slides are visual aids meant to support the 

presentation, not replace the speaker. Instead of reading directly from the 

slides, the presenter should explain the content, add context, or share 

examples. Smooth transitions between slides and alignment of spoken 

content with visuals help maintain flow and reinforce the message. 

5. Time Management: Good time management is essential to ensure that all 

important points are covered without rushing or exceeding the allotted 

time. Practicing the presentation beforehand helps with pacing and allows 

adjustments if necessary. Prioritizing key information ensures that the 

core message is delivered even if time becomes limited. 

6. Audience Engagement: An engaging presentation encourages interaction 

and keeps the audience involved. Asking questions, using relatable 

examples, or including simple activities can make the session more 

interactive. Observing audience reactions and adjusting tone or pace 

accordingly also contributes to a more responsive and dynamic 

presentation. 

7. Handling Questions: Responding to questions with patience and clarity 

demonstrates subject knowledge and openness. Listening carefully and 

answering directly builds trust with the audience. If a question cannot be 

answered immediately, offering to follow up later shows professionalism 

and a willingness to help. 

Strong presentation skills turn a simple slide deck into an impactful 

communication tool. These skills not only enhance clarity but also build 

confidence, helping to deliver a memorable and professional presentation. 

PRACTICAL EXERCISES 

Activity 1: Creating a Slide Presentation from an Analytical Report. 

Situation: You have completed an analytical report (e.g., Monthly Sales 

Report, Branch Performance Report, or Risk Analysis Report). Your manager 



MIS DATA ANALYST – FINANCIAL SERVICES                                          GRADE-XI                                                                 

260 
 

now requires you to present the key findings to the management team using 

a professional slide deck. 

Task: Create a slide presentation that summarizes your analytical report, 

integrates Excel visuals, and highlights key insights. The presentation should 

effectively communicate the report’s purpose, analysis, and 

recommendations. 

Material Required: 

 Completed analytical report (Excel and Word document) 

 Presentation software (PowerPoint, Google Slides, etc.) 

 Key Excel charts and tables to integrate 

 Understanding of slide design principles 

 Basic presentation skills 

Procedure: 

1. Planning the Slide Deck 

a) Review your completed analytical report and identify: 

 The report’s objective 

 Key data points and conclusions 

 Important visuals (charts, tables) 

b) Outline your slide flow: 

 Title Slide 

 Report Objective Slide 

 Key Data Findings Slides 

 Visuals/Charts Slides 

 Summary and Recommendations Slide 

2. Slide Creation 

a) Open your presentation software and start a new slide deck. 

b) Design each slide using proper formatting: 

 Use minimal text and bullet points. 

 Apply consistent fonts, colours, and styles. 

 Ensure charts are properly formatted and readable. 

c) Embed or link Excel charts and tables as needed. 

d) Add short descriptions and insights for each visual to guide the 

audience. 

3. Finalizing the Slide Deck 

a) Review for: 
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 Clarity 

 Consistency 

 Proper sequencing of slides 

b) Rehearse the presentation: 

 Focus on explaining visuals and key findings. 

 Prepare to answer questions from the audience. 

4. Present your slide deck to classmates in small groups. 

5. Receive feedback on slide design, content clarity, and presentation style. 

6. Note down improvement / suggestions for your final submission. 

7. Revise as per the suggestion. 

8. Show to the teacher. 

CHECK YOUR PROGRESS 

A. Fill in the Blanks  

1. A good slide design should follow the principle of __________ to maintain 

visual consistency throughout the presentation. 

2. Excel charts should always be __________ before inserting them into 

slides to improve clarity and visual impact. 

3. One key advantage of using __________ Excel objects in slides is that 

they automatically update when the Excel file changes.  

4. A well-designed slide deck should avoid __________ visuals that distract 

from the key message. 

5. Good presenters maintain __________ contact with their audience to 

build connection and trust. 

B. Multiple Choice Questions  

1. Which of the following is NOT a recommended slide design principle? 

a)  Simplicity 

b)  Consistency 

c)  Cluttered layout 

d)  Visual hierarchy 

2. What is the benefit of embedding a linked Excel chart in a slide? 

a)  It cannot be edited 

b)  It updates automatically if the Excel data changes 

c)  It improves slide background 

d)  It increases file size unnecessarily 

3. Which chart is most appropriate to show trends over time? 

a)  Pie chart 

b)  Bar chart 

c)  Line chart 

d)  Scatter chart 

4. Which of the following is an essential presentation skill? 

a)  Reading slides word-for-word 
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b)  Speaking clearly and confidently 

c)  Avoiding eye contact 

d)  Ignoring audience questions 

5. The best way to handle feedback during a presentation is to: 

a)  Argue with the audience 

b)  Politely accept and address questions 

c)  Avoid responding 

d)  Read directly from the slides 

C. Match the Columns 

Column A Column B 

1. 
Simplicity A.  

Use high-contrast colours 

2. 
Linked Excel Chart B.  

Keeps slides clean 

3. 
Contrast C.  

Updates with source data 

4. 
Visual Hierarchy D.  

Connects with audience 

5. 
Eye Contact E.  

Guides audience attention 

D. Short Answer Questions  

1. What is the importance of consistency in slide deck design? 

2. Why should Excel charts be cleaned and formatted before inserting into 

a presentation? 

3. What are the benefits of using visual hierarchy in a slide deck? 

4. List two advantages of maintaining eye contact during a presentation. 

5. What is the difference between embedding and linking an Excel chart 

in a slide? 

E. Long Answer Questions. 

1. Explain the key design principles that should be followed when creating 

a professional slide deck. 

2. Describe the step-by-step process of integrating an Excel chart into a 

slide. Mention the pros and cons of using screenshots versus linked 

charts. 

3. Discuss the importance of presentation skills in effectively delivering a 

report. Provide examples of good and poor presentation practices. 

4. How can visuals such as charts and tables improve the impact of a 

presentation? Explain with examples. 

5. Explain the best practices for engaging an audience during a 

presentation. How can a presenter ensure audience participation? 

F. Check your Performance 

1. Evaluate the pros and cons of using a linked Excel chart versus a static 

screenshot in a business presentation. 
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2. Justify the importance of visual hierarchy when designing slides for a 

sales presentation. 

3. Assess how poor presentation skills can reduce the effectiveness of even 

well-designed slide decks. 

4. Design a 5-slide deck to summarize an analytical report using proper 

slide design principles and Excel visuals. Explain your design choices. 

5. Develop a presentation plan that integrates Excel charts and includes 

techniques to engage the audience throughout the session. 
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ANSWER KEY 

MODULE 1: BANKING SECTOR AND ROLE OF MIS DATA ANALYST 

SESSION 1: OVERVIEW OF THE BFSI SECTOR 

A. Fill in the Blanks 

1. Banking 

2. Reserve Bank of India (RBI) 

3. Commercial 

4. Central 

5. NBFCs (Non-Banking Financial Companies) 

B. Multiple Choice Questions 

1. b) Banking, Financial Services, and Insurance 

2. c) RBI 

3. c) Providing financial services without being a bank 

4. c) Digital banking 

5. c) Offer protection against risk 

C. State whether the following statements are True or False 

1. True 

2. False 

3. True 

4. False 

5. False 

D. Match the Columns 

1 – B 

2 – E 

3 – D 

4 – A 

5 – C 

SESSION 2: MIS IN BFSI 

A. Fill in the Blanks 

1. Operational 

2. Database 

3. Businesses 

4. Regulations 

5. Management 

B. Multiple Choice Questions 

1) C) Decision-making and operations 
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2) B) Retail Banking 

3) D) Processing Unit 

4) B) Hierarchy 

5) B) Credit Risk 

C. State whether the following statements are True or False 

1) False 

2) True 

3) False 

4) True 

5) True 

D. Match the Columns 

1) 1 - D 

2) 2 - B 

3) 3 - E 

4) 4 – A 

5) 5 - C 

SESSION 3: MIS DATA ANALYST IN FINANCIAL SERVICES 

A. Fill-in-the-Blanks 

1. Data  

2. KPIs 

3. Excel 

4. Marketing  

5. Tables  

B. Multiple Choice Questions 

1. b) Management Information System 

2. b) Excel 

3. b) Analysing market trends 

4. c) Net Interest Margin 

5. b) Data and performance metrics 

C. State whether the following statements are True or False 

1. False 

2. True 

3. False 

4. True 

5. True 
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D. Match the Columns 

1 – C 

2 – D 

3 – A 

4 – B 

5 – E 

SESSION 4: ETHICS, DATA PRIVACY, AND REGULATORY ENVIRONMENT 

A. Fill in the Blanks 

1. Confidentiality  

2. Consent  

3. Transparency  

4. Digital Personal Data Protection  

5. Unethical  

B. Multiple Choice Questions 

1. c) To protect individuals 

2. c) Selling user data without informing them 

3. b) Know Your Customer 

4. c) To follow legal rules and protect customers 

5. d) Gaining informed consent from the customer 

C. State whether the following statements are True or False 

1. False 

2. True 

3. True 

4. False  

5. True 

D. Match the Columns 

1 – D 

2 – C 

3 – A 

4 – B 

5 – E 

MODULE 2: EXCEL FOR FINANCIAL DATA MANAGEMENT 

SESSION 01: EXCEL INTERFACE AND BASIC OPERATIONS 

A. Fill in the Blanks 

1. Letter, number  
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2. Page 

3. Ribbon 

4. Number, text, dates and logical values 

5. 1048576, 16,384 

B. Multiple Choice Questions 

1. b) It allows access to Excel's features and commands 

2. c) General 

3. a) Formula Bar 

4. b) Use the Center button in the Alignment group 

5. b) It locates and selects specific data 

C. State whether the following statements are True or False 

1. False 

2. True 

3. False  

4. True 

5. True 

SESSION 2: BASIC FORMULAS AND FUNCTIONS IN EXCEL 

A. Fill in the Blanks 

1. = 

2. addition 

3. AVERAGE  

4. MAX 

5. multiplication  

B. Multiple Choice Questions 

1. b) SUM 

2. b) 100 

3. d) / 

4. a) MIN 

5. b) COUNT 

C. State whether the following statements are True or False 

1. True 

2. False  

3. True 

4. False  

5. False  

SESSION 3: DATA PRESENTATION AND BASIC CHARTS IN EXCEL 

A. Fill in the Blanks 

1. formatting  
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2. Column 

3. portion  

4. Conditional  

5. Conditional Formatting 

B. Multiple Choice Questions 

1. b) Line Chart 

2. c) Identify the highest or lowest values in a range  

3. b) Data Bars 

4. c) Column Chart  

5. c) Pie Chart 

C. State whether the following statements are True or False 

1. False  

2. True 

3. False  

4. False  

5. True 

SESSION 4: LOOKUP AND LOGICAL FUNCTIONS 

A. Fill in the Blanks 

1. formatting  

2. Column 

3. portion  

4. Conditional  

5. Conditional Formatting 

B. Multiple Choice Questions 

1. b) To search for a value vertically in a table and return a corresponding 

value 

2. d) It checks if a condition is true or false and returns one value if true, 

another if false 

3. b) AND () 

4. a) The row index number from which the corresponding value will be 

returned 

5. d) HLOOKUP 

C. State whether the following statements are True or False 

1. False  

2. False  

3. False  

4. True 

5. True 
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MODULE 3: DATA ORGANIZATION AND MIS REPORT 

SESSION 1: DATA ORGANIZATION AND VALIDATION 

A. Fill in the Blanks 

1.  structured, analyse 

2. Data Validation 

3. Insert 

4. Structure 

5. Organization 

B. Multiple Choice Questions 

1. b) Clarity 

2. b) Automatically expands when new data is added 

3. d) Graphic 

4. a) Automatically calculates sums and averages 

5. c) Date 

C. State whether the following statements are True or False 

1. False  

2. True 

3. True 

4. False  

5. False  

SESSION 2: AGGREGATE ANALYSIS 

A. Fill in the Blanks 

1. single 

2. multiple 

3. a specific 

4. multiple 

5. multiple 

B. Multiple Choice Questions 

1. c) Sums values based on a single condition  

2. b) SUMIFS can handle multiple criteria, while SUMIF can only handle 

one 

3. b) AVERAGEIF 

4. c) It can count cells based on multiple conditions 

5. b) An average_range and its criteria 

C. State whether the following statements are True or False 

1. True 

2. False  

3. False  
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4. True 

5. False  

SESSION 3: CREATING MIS REPORTS 

A. Fill in the Blanks 

1. informed 

2. tables 

3. daily 

4. weekly 

5. summary 

B. Multiple Choice Questions 

1. b) To summarize data and help in decision-making  

2. d) Year-over-year change  

3. b) Monthly report 

4. c) Detailed company policies 

5. c) To assess short-term progress and trends 

C. State whether the following statements are True or False 

1. True 

2. False  

3. False  

4. True 

5. False  

SESSION 4: DATA VISUALISATION AND PIVOT TABLES 

A. Fill in the Blanks 

1. summarize 

2. Pivot Table 

3. Filters 

4. Pivot 

5. Values 

B. Multiple Choice Questions 

1. b) To summarize and analyse large datasets 

2. d) Performing data entry tasks 

3. b) By summarizing key metrics and trends for decision-making 

4. b) Column chart 

5. b) Selecting the data range 

C. State whether the following statements are True or False 

1. True 

2. False  

3. True 
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4. False  

5. False  

MODULE 4: ADVANCED EXCEL FOR ANALYSIS AND DASHBOARDS 

SESSION 1: ADVANCED LOOKUP AND DYNAMIC FUNCTIONS 

A. Fill in the Blanks 

1. VLOOKUP 

2. row_num 

3. HLOOKUP 

4. MATCH 

5. range_lookup 

B. Multiple Choice Questions 

1. c) MATCH  

2. b) Performs an approximate match 

3. a) INDEX 

4. b) HLOOKUP 

5. b) They allow more flexibility than VLOOKUP or HLOOKUP 

C. State whether the following statements are True or False 

1. True 

2. False  

3. True 

4. False  

5. False  

SESSION 2: MIS REPORTS USING EXCEL 

A. Fill in the Blanks 

1. Key Performance Indicators (KPIs) 

2. PivotTable 

3. =(Current Week Sales - Previous Week Sales)/Previous Week Sales 

4. Column 

5. Daily 

B. Multiple Choice Questions 

1. a) Total Sales   

2. b) Line Chart 

3. d) All of the above 

4. b) Use bold font and shaded background 

5. a) AVERAGE 

C. State whether the following statements are True or False 

1. True 

2. False  
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3. False  

4. True 

5. True 

SESSION 3: PIVOT TABLES AND DASHBOARDS 

A. Fill in the Blanks 

1. summarize 

2. Filter 

3. Slicer 

4. months 

5. calculated 

B. Multiple Choice Questions 

1. b) Summarizing data 

2. c) Slicer 

3. c) It lists the unique values 

4. b) Grouping 

5. a) Calculated Field 

C. State whether the following statements are True or False 

1. True 

2. False  

3. False  

4. True 

5. True 

SESSION 4: MIS REPORTS AND BASIC DASHBOARDS 

A. Fill in the Blanks 

1. Dashboard 

2. Slicers 

3. Grouping 

4. informed 

5. KPI box 

B. Multiple Choice Questions 

1. c) To display important data visually 

2. b) Slicer 

3. d) A key value like pass percentage 

4. b) Bar Chart 

5. c) Arrangement of charts and tables 

C. State whether the following statements are True or False 

1. False  

2. True 
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3. False  

4. True  

5. False  

MODULE 5: AUTOMATION AND PRESENTATION OF REPORTS 

SESSION 1: MACROS AND VBA IN EXCEL 

A. Fill in the Blanks 

1. Macro 

2. Alt + F11 

3. VBA Editor 

4. Variables 

5. Recording a Macro 

B. Multiple Choice Questions 

1. b) Visual Basic for Applications 

2. b) View 

3. b) Alt + F11 

4. b) A storage location for data 

5. b) Range(“A1”).Select 

C. Match the Columns 

1 → D 

2 → C 

3 → B 

4 → E 

5 → A 

SESSION 2: AUTOMATING REPORTS AND DASHBOARDS 

A. Fill in the blanks  

1. Developer 

2.  button 

3. Ctrl + Shift 

4. repetitive 

5. Windows Task Scheduler 

B. Multiple Choice Questions  
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1. a) Enabling the Developer tab 

2. b) .xlsm 

3. b) Windows Task Scheduler 

4. b) Ctrl + Shift + (Key) 

5. c) The macro runs when the button is clicked 

C. Match the Columns 

1 – B  

2 – D  

3 – C  

4 – A  

5 – E  

SESSION 3: ANALYTICAL REPORTS  

A. Fill in the Blanks  

1. Tabular 

2. Conclusion 

3. Linked 

4. Line 

5. Formatting 

B. Multiple Choice Questions 

1. b) Supports decision-making with explanations 

2. b) Fictional Story 

3. c) Bar Chart 

4. c) They remain static even if data changes 

5. b) Branch Performance Report 

C. Match the Columns 

1 – D 

2 – A  

3 – B 

4 – E  

5 – C  

SESSION 4: PROFESSIONAL PRESENTATIONS 

A. Fill in the blanks  

1. Consistency 

2. Cleaned and formatted 

3. Linked 

4. Decorative 
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5. Eye 

B. Multiple Choice Questions (MCQs) 

1. c) Cluttered layout 

2. b) It updates automatically if the Excel data changes 

3. c) Line chart 

4. b) Speaking clearly and confidently 

5. b) Politely accept and address questions 

C. Match the Columns 

1 – B 

2 – C  

3 – A 

4 – E  

5 – D  


